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Important Precautions

TTRANSLATION POLICY

WARNING

This Service Manual is available in English only.

English

™
2
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L ]

e Ifa customer’sservice providerrequires alanguage otherthan English, it
is the customer’s responsibility to provide translation services.

Do not attempt to service the equipment unless this Service Manual has
been consulted andis understood.
Failure to heed this Warning may result in injury to the service provider,

operatoror patient from electric shock, mechanical or otherhazards.

AVERTISSEMENT

Ce manuel de maintenance est disponible en anglais uniquement.

ADVERTENCIA

Este Manual de servicio esta disponible en idioma inglés unicamente.

# Siunclient de la personne responsable de lamaintenance demande une E * Sjun proveedorde servicio del cliente requiere unidioma distinto, es
langue autre que |'anglals, il estde la responsabilité du client de fournirles ‘% responsabilidad delcliente ofrecer servicios de traduccion.
services de traduction. o * Nointente repararel equipo a menos que haya consultado y comprendido

* N'essayezpasd'effectuervous-méme lamaintenance de I'équipement Lﬂ este Manual de servicio.
avant d'avoir préalablement lu et compris le manuel de maintenance. * Sino prestaatencidn a esta Advertencia, se pueden ocasionar lesiones al

* Le non-respectcet avertissement peut entrainer des blessures duesaun (Es) proveedor de servicio, al operador o al paciente por descarga eléctrica,
choc électrique, une défaillance mécanique ou a d'autres éléments por riesgos mecanicos o de otra indole.
dangereux chezlapersonne en charge de la maintenance, l'opérateur ou
le patient.

WARNUNG AVVERTENZA
Dieses Wartungshandbuch ist nur auf Englisch verfigbar. Il presente Manuale diassistenza & disponibile solo in inglese.
¢ Wennder Kundendiensttechniker eines Kunden eine andere Sprache als 5 ¢ Seil fornitore di servizidi un cliente ne richiede una copia in una lingua
5 Englisch bendtigt, unterliegt es der Verantwortung des Kunden eine c diversadallinglese, & responsabilita del cliente fornire il servizio di
0 Ubersetzung anfertigen zulassen. g traduzione.
a * Warten Sie das Gerat nur, wenn Sie dieses Wartungshandbuch gelesen © » Nontentare diriparare 'apparecchio se questo Manuale di assistenzanon
0O undverstanden haben. = & statoletto e compreso.

* Die Nichtbeachtung dieses Warnhinweises kann zu Verletzungen des (™ » Il mancato rispetto di questaavvertenza pud compaortare il rischio di
Kundendiensttechnikers, Anwenders oder Patienten durch Stromschlage, lesioni al fornitore di servizi, alloperatore o al paziente causate da scosse
mechanische oderandere Gefahren fihren. elettriche o da pericoli di origine meccanica o dialtro tipo.

WAARSCHUWING ADVERTENCIA
Deze servicehandleiding is alleen beschikbaar in hetEngels. Este Manual de Manutengio esta disponivel apenas em Inglés.

wn * Als de serviceleveranciervan eenklantvraagt om een andere taaldan n * Casoum prestador de servicos do cliente solicite o manual emidioma

'E Engels, is het de verantwoordelijkheid van de klant om een vertaalde g diferente do inglés, & de responsabilidade do cliente o fornecimento de
© versie te bieden. o servicos de tradugdo.

E * Probeergeenonderhoud aan de apparatuur uit te voeren tenzijdeze é * Niotenterealizara manutengdo do equipamento antesde lere

k= servicehandleiding is geraadpleegd en begrepen. =} compreender este Manual de manutengio.

% * Het niet opvolgen van deze waarschuwing kan bij de serviceleverancier,de o * O ndo cumprimento desta adverténcia pode resultar em danos por choque
NU operator of de patiént leiden tot letsel door elektrische schokken, (PT-BR) elétrico e riscos mecanicos para o prestador de servigos, operadorou

mechanische of andere gevaren. paciente.
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OPOZORILO

Ta servisni priroénik je na voljo samov angleséini.

+ e ponudnik servisnih storitev za stranko potrebuje navodilav drugem
jeziku, morastranka sama poskrbetiza prevajanje.

+* Ne poskuiajte servisiratiopreme, ne da bi prej prebrali in razumeli servisni
priroénik.

« Cetega opozorila ne upostevate, obstaja nevarnost elektricnega udara,
mehanskih ali drugih nevarnostiin posledi¢nih po3kodb ponudnika
servisnih storitev, uporabnika opreme ali pacienta.
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NPEAYNPEXAEHME

[aHHOE PYHOBOACTBO NO 06CAYHUBAHMID AOCTYNHO TONLKO HA AHTAMACKOM
A3bIKE.
*  ECAVW CNeuManiicTy No TEXHUYECKOMY oBCnyMuBaHMio KnneHTaTpebyetca

AOKYMEHTALMA Ha KAKOM-NMBO APYrOM A3bIKE, OTBETCTBEHHOCTL 33
BbINDNHEHWE NepeB0aa BO3NaraeTcA Ha KnneHTa.

* MpucTynaite K 06CnywuBaHW0 060pYA0BaHWA TONBKO NOCNE TOTO, KaK

M3Y4MTE JaHHOR PYKOBOACTBO N0 OBCAYKUBAHMIO U NONHOCTBIO NOAMETE
erocofgpsanHue.

* HecofnoaeHWe JaHHOTO Tpe GoBaHWMA MOMET N PHMBECTH K TPABMUPOBAHMIO

CNeLManucTa No TEXHUYECKOMY 0BCNYHMBAHWIO, NONBIOBATENA UK
NaLMeHTa BCNEACTBME NOPAKE HUA 318 KTPUUE CKUM TOKOM, MEXAHWUECKMX
M NPOUMX NOBPEMOEHUA,

VAROVANIE

Tato servisnd prirucka je dostupna iba v anglickom jazyku.

* AkposkytovatelsluZieb zakaznikom vyZaduje iny jazyk ako anglicky jazyk,
jeho povinnostou je zabezpeéit prekladatelské sluZby.

* Zariadenie nepouiivajte bez preéitaniaa porozumenia tejto servisnej
prirucky.

* Nedodrianie tejtovystrahy méZe viestk zraneniu poskytovatelasluieb,
operatora alebo pacienta sposobeného elektrickym Sokom, mechanickym
aleboinym nebezpedenstvom.
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VARNING

Den hér servicehandboken finns endast pa engelska.

*  Om en kunds servicetekniker krdver ett annat sprik &n engelska ar det
kundens ansvar att tillhandahalla en dversattversion.

* Férsokinte att utforaservice pa utrustningen omdu inte har last
igenom och farstitt den hir servicehandboken.

* Omduinte tar hansyntill den hér varningen kan serviceteknikern,
operattren eller patienten utsattas for elektriska stotar eller
mekaniska eller andra faror, vilket kan leda till personskador.
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OSTRZEZENIE

Niniejszy podrecznik serwisowy jest dostepny wylacznie w jezyku angielskim.

* Jezelidostawcaustugklienta postuguje sie jezykiem innym niz angielski, za
zapewnienie ustug ttumaczeniowych odpowiada klient.

* Przed przystapieniem do czynnosciserwisowych nalezy zapoznacsie z
informacjamizawartymi w niniejszym podreczniku serwisowymije
zrozumiec.

* W przeciwnym wypadku dostawca ustug, operator lub pacjent moga
odnies¢ obratenia spowodowane porateniem pradem elektrycznym,
dziataniem elementéw mechanicznych lub innymi zagrozeniami.

FIGYELMEZTETES

A szervizkézikonyv kizardlag angol nyelven érhetd el

* Amennyiben az dgyfélszolgaltatéjanak nemfelel megaz angol nyelvi
dokumentécid, gy a forditasrdl az igyfélnek kell gondoskodnia.

®  Kizérolag ugy lasson hozzd a berendezés karbantartasahoz, hogy elolvasta
ésmegértette aszervizkézikdnyvben foglaltakat.

+ Ezenfigyelmeztetés figyelmen kiviil hagydsa esetén aszolgéltato, a kezeld
vagy a paciens dramiitést, mechanikus sérillést vagy mas veszély sltal
okozottszemelyiseériilest szenvedhet.
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VYSTRAHA

Tato servisnipfirutka je k dispozici pouze v anglicting.

* Pokud poskytovatelsluzby zakaznikovi poZaduje jiny jazyk neZ anglictinu,
je odpovédnosti zakaznika poskytnout sluZby prekiadu.

*  Nepokousejte se provadét servis zafizeni, dokud sineprostudujete a
neporozumite servisnipfirucce.

*  Nevénovéni pozornostitéto vystraze mlie zplsobit poskytovatelisluieb,
obsluze nebo pacientoviuraz elektrickym proudem, mechanicka nebo jind
nebezpedi.

ADVARSEL

Denne servicehandboken er bare tilgjengelig pa engelsk.

*  Hvis en kundes tjenestetilbyder krever et annet sprak enn engelsk, erdet
kundens ansvar a tilby oversettelsestjenester.

* Ikke forsek 3 utfere service pd utstyret fer denne servicehandboken erlest
og forstatt.
Dersom detikke tas hensyn til denne advarselen, kan det fere til skader pd
tjenestetilbyderen, operatgren eller pasienten fra elektrisk stot,
mekaniske eller andre farer.

VAKAVA VAROITUS

Tama huolto-opas on saatavana vain englanniksi.

* Josasiakkaan palveluntarjoajatarvitsee oppaan jollain muulla kielells,
kaanndspalveluiden hankkiminen on asiakkaan vastuulla.

* Laitetta ei saa huoltaa ellei huolto-oppaaseen ole sitd ennen tutustuttu
huolellisesti.

* Jostata varoitusta ei noudateta, palveluntarjoaja, kayttsja tai potilas
saattaa saada sahkoiskun, ja saattaa aiheutua mekaanisia tai muita
vaurioita.

ISPEJIMAS

Sis priedidiros vadovas galimas tik angly kalba.

* Jeikliento paslaugy teikéjas reikalauja kitos kalbos nei angly, klientas
atsako uZ vertimo paslaugos teikima.

* Atlikite jrangos priefilra tik gerai susipaZine su priefiGros vadovu ir jj
suprate.

* Nesilaikant Sio jspejimo galimas paslaugos teikéjo, operatoriausar
paciento suZeidimas del elektros Soko, mechaninio ar kito pavojaus.

UPOZORENIJE

Ovaj prirutnik za servisiranje dostupan je samo na engleskom jeziku.

* Akoklijentov serviser zahteva jezik koji nije engleski, odgovornost je na
klijentuda pruZi usluge prevodenja.

* Nemojte da pokusavate da servisirate opremu ako prethodno niste
proéitali i razumeli ovaj priruénik.

* Akone poitujete ovo upozorenje, moie docido povredivanjaservisera,
operateraili pacijenta uzrokovanog elektricnim udarom, mehanickimi
drugim opasnostima.

Latviski Romaéana Dansk

< Portugués
(Portugal)

=
©
=

UYARI

Servis Kilavuzu yalnizca ingilizce olarak mevcuttur,

*  Misterinin servis saglayicist igin kilavuzun ingilizee diginda bagka bir dile
cevrilmesigerekiyorsa geviri hizmetisaglamak misterinin sorumiulugudur.

*  Bu Servis Kilavuzu'na bakip talimatlar anlamadan ekipmanikullanmaya
calgmaymn.

* Bu Uyannin goz ardi edilmesiservis saglayicisinin, operatoriinveya
hastanin, elektrik carpmasi, mekanik aniza ya da diger tehlikeler nedeniyle
yaralanmasina neden olabilir.

ADVARSEL

Denne servicemanual fas kun pa engelsk.

* Hvis en kundestjenesteudbyder kraeveretandet sprog end engelsk, er det
kundens ansvar at sorge for oversattelsesydelserne.

* Forsegikke at udfore service pd udstyret, medmindre denne
servicemanualer laest og forstdet.

* Manglende overholdelse af denne advarsel kan medfore skade pd
serviceudbyderen, operateren eller patienten som folge af elektrisk stod,
mekaniske eller andre farer.

AVERTISMENT

Acest manual de service este disponibil doar in engleza.

* Daca furnizorul de servicii al unui client solicitd alta limba decitengleza,
este responsabilitatea clientuluisa ofere servicii de traducere.

* Nuincercati s3 efectuatilucrari de service asupra echipamentului, in afard
de cazul cind ati consultat acest manual de service 5i l-ati inteles.

* Nerespectareaacestuiavertisment poate aveacarezultat rinirea
furnizorului de servicii, a operatoruluisau a pacientuluica urmare a
electrocutarii, pericolelor mecanice sau a altor pericole.

BRIDINAJUMS

&1 apkalpes rokasgramata ir pieejama tikai anglu valoda.

* Jaklienta pakalpojumu sniedzéjam ir nepieciesama cita valoda, kas nav
anglu valoda, klienta pienakums ir nodrosinat tulkojumu.

. éginiet apkalpot aprikoj , jaapkalpes rokasgramata nav izlasita un
izprasta.

* Ja3is bridindjums netiek ievérots, pakalpojumu sniedz&js, operators vai
pacients var gut traumas no elektro3oka vaivar rasties mehanisks vai cita
veidaapdraudéjums.

AVISO

Este manual de assisténcia estadisponivelapenas em inglés.

* Seo prestadorde servigos de assisténcia do cliente necessitar do manual
noutro idioma, a disponibilizagio dos servigos de tradugdo é da
responsabilidade do cliente.

* N3otente reparar o equipamento se ndo tiver consultado e compreendido
este manual de assisténcia.

* 0 ndo cumprimento das instrugdes constantes neste aviso pode resultar
em ferimentos no prestador de servigos de assisténcia, no operadorou no
paciente devido a choques eléctricos, perigos mecanicos ou outros
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NONEPEAMEHHA PERINGATAN

Lie# NociGHMK i3 TeXHIYHOro 06CNYroBYBaHHA AOCTYNHMA NULIE GHINIACEKOKD Panduan Servisini hanya tersedia dalam Bahasa Inggris.

MOBOI. @ * lika penyedialayanan pelanggan memerlukan bahasa di luar Bahasa

*  AKWO NOCTa4aNnBHUKY NOCAYT i3 TexHiYHoro oBcnyrosyeaHHA NoTpiGHa © % Inggris, maka pelanggan bertanggung jawab untuk memberikan layanan
g iH$pOpMaLA MOBOID, BIAMIHHOK BiA aHINIACHKOI, BIANOBIaNbHICTL 33 g C tersebut.
6 HaJaHHA NoCAYr Nepexnany Hece KOPWCTyBaY, B o _g + Jangan mencobamenyervis peralatan ini, kecuali Panduan Servis ini telah
= *  TexHiuHe oBcnyrosyeaHHA 061aAHaHHA MOMHE BUKOHYBATH NMLLE NiCAA g i dijadikan rujukan dan dipahami dengan baik.
g O3HAMOMARHHA 3 NOCIGHMKOM i3 TeXHIYHOro 0BCAYroByBaHHATA (D Kelalaian memperhatikan Peringatan ini dapat menyebabkan cedera
= YCBIAOMARHHA HOTD 3MICTY. terhadap penyedia layanan, operator, atau pasien akibat bahaya kejutan
{?K] *  HeAOTPMMAaHHA LbOTO NONEPE MKEHHA MOME NPUIBECTH A0 TPABM listrik, mekanik, dan bahayalainnya.

NOCTa4anbHWKa NOCAYT, onepaTopa abo NauieHTa, CNpUYMHEHMK SiE0
ENEKTPUUHOTO CTPYMY, MEXAHIUHMX 260 IHLWMX NOWKOLHEHD.

- 3 o
nuaou CANH BAO
5 ; Huwdng din sir dung dich vy nay chi sin ding bingtiéng Anh.
AUDFDNU MM D NG WY & *  NE&unha cungcdp dich vy cla khidch hangyéu ciu ngdn ngir khac ngoai
. oy 2 = - ti€ng Anh, thi khach hang phai cé trach nhiém cung cip cac dich vu dich
o1 ¢ wnglimssasgnmdaimsaiunnauienimiieanmnaingy s e ' g phel SR Ep e e o
= anArAauiludivansaulunsiniaaagiadaniigaatunla _E +  Khéngduoc tim céch sira chira thiét bi trir khi d3 tham khao va higur
o Tusnadrdaanirpaunsailnglifinm wasianadrlagiadaaniinil = Hudngdan stedyng cich wyindy.. : ; &
{TH) oy " * * (V1) *  BO qua & canh bdo nay co thé gdy thuongtich cho nha cung cip dich vy,
o winlaidpdamarndauiatadaraligiusnns dliigunanl nhanvién van hanh hodc bénh nhan do séc dién, nhitng nguy hiém v& méy
wiadlhglasuumaduaanivihian dunsigainnalnrasginsni mochodeyeu th khac,
WiaauAsEaL 9
ECKEPTY BABALA
Ocbl KbI3MET KEPCETY HYCKAYNbIFbl TEK aFblLWbIH TINIHAE KONMKeTIMA). Available lamang sa Ingles ang Manwal ng Serbisyongito.
% *  Erep TyTbiHYLWbINADAbIH KbI3METTE P MeTKizywicl aFbinwwbiH TiniHeH Backa * Kungang kailangan lamang ng tagabigay ng serbisyo ng kustomerng wika
£ Tingi Tanan eTce, ay4apy Kbi3METTEDIMEH KAMTAMACHI3 ETY TYTHIHYLILIHGIH, an maliban sa Ingles, responsibilidad ng kustomer na magbigay ng serbisyo sa
= wayankepwiniride Kipegj. o pagsasalin wika nito.
X & Ochl KBIIMET HEPCETY HYCKAYABIFBIH TYCIHIN, 0N TYpansi KeHeC anmaiibiHwa ©  * Huwagsubukannaiserbisyoang mga kasangkapan maliban kung
§ #aBABIKKA KBIZMET KEPCETYre ThiPbiCNaHbI3. ﬁ nakonsuita ang nauunawaan itong Manwal ng Serbisyo.
5% e Ocbl ecKepTyAl OPbIHAMAY 3NEKTP TOTbIHBIH COFYbI, MEXaHMKANbIK Hemece m * Angpagkabigong maunawaan ang Babalang ito ay maaring maging resulta
(KK) BacKa Aa KayinTep canaapbiHaH Kbi3METTE P HETRIZYWICIHIH, onepaTopapiy ng pinsala sa tagabigay ng serbisyo, nagpapagana o pasyente mulasa
HeMeCce eMARNYLIHIH MAPAKATTaHybIHa 3NbiIN KeAYi MYMKIH, pagkakakoryente, mekanikal o iba pang peligro.
HOIATUS! NPOEIAONOIHZIH
Service Manual (Hooldusjuhend) on saadaval ainult ingliskeelsena. To napov Eyyswpibio oéppg SuariBetar povo ota Ayyhikd.
*  Kuikliendi teenusepakkuja ndue on, etjuhend oleks ménes muus keeles, h=] * Edvond O Tou MENGTN anaitel yAbooa eXTOG Twv AyyAxkwv,
i pakkuja ] v poxocoeppig n ¥ S Yy n
7] korraldab juhenditdikimise klient. = napoyr pETadpacTikuy UTNpEoww anotedel euBivn Tou nehdTn.
@ e Tutvuge enne seadme hooldustdéde tegemist kindlasti juhendiga Service c *  Mnveny OETE VA EMLOKEUACETE Tov eEomALopO edv mpuwTa Sev
w B g nv EMLELD nip
Manual (Hooldusjuhend). ﬁ oupPoulsuteite kankatavoioets To mapdv Eyxepibio ofppuc,
¢ Selle ndude eiramise korral vdi ja, kasutajaviip saada *  Iemepintwon un tipnongng napoloagnpoebonoinong, evbéyetalva
(ET) selle ndude eiramise korral v8ib teenindaja, kasutaja vBi patsient saad w Ze mepi f i wSomol 5¢
elektrilbdgi, samuti viivad kaasneda muud ohud. (EU npokhnBel tpavpaTiopos otov ndpoxo ofpPig, To EwPLoTA i Tov aoBevr
efartiagnhextpomhndiac kaBuws kot pnyavikwy r GAAwv kS ivwy,
NPEAYMPEXAEHUE UPOZORENJE
HacToAwoTo CepemaHo PHKOBO/ACTEO CB NPEANETa CAMO Ha BHINKIACKH e3MK. Ovaj servisnipriruénik dostupan je samo na engleskom jeziku.
®  AKOADCTEBYWKBT HE CEPBMIHM YCAYTM Ha KAMEHTE MICKBA PHHOBOACTED = * Akoklijentov serviser zahtijeva jezik koji nije engleski, odgovornost klijenta
g Ha E3MK, KOWTO Ce Pa3NMYaBa OT SHIMMACKMA, KAMEHTHT MMa OTFOBOPHOCT [ je prutiti usluge prijevoda.
a A3 OCUIYpY aAeKBaTeH Npesos, © * Nemojte pokuiavatiservisiratiopremu ako niste proditali i razumjeli
£ . he npaeeTe onuTH 3a cepeua Ha obopyasaneTo, Gesaa nposepuTe U da c servisni p’“’“‘vf“ik' )
5 pa3bepeTe cuBeTUTE B CEPBMIHOTO PHKOBOACTED. I * Akone pOg.t_l.I]etﬁ OVO Upozo rer":je, mo!e_ d_otrdo ozljede se fvisera, )
1] *  Hecna3ssaHeTo Ha TOBA NPeAynpesaeHIe MoKe 43 40BEde A0 (HR) ope raterai ili pacijenta prouzroéene strujnim udarom, mehanickim i drugim
(BG) apaHABaHe Ha AocT Ha cep YCAYTW, ONepaTopa uam opasnostima.

NauneHTa BCNeACTBME HA TOKOB Y A3D, MEXAHWWHAE MAW ADYIH ONAcHOCTH.
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DAMAGE IN TRANSPORTATION

All packages should be closely examined at time of delivery. If damage is apparent write “Damage In
Shipment” on ALL copies of the freight or express bill BEFORE delivery is accepted or “signed for” by
a GE representative or hospital receiving agent. Whether noted or concealed, damage MUST be
reported to the carrier immediately upon discovery, or in any event, within 14 days after receipt, and the
contents and containers held for inspection by the carrier. A transportation company will not pay a claim
for damage if an inspection is not requested within this 14 day period.

CERTIFIED ELECTRICAL CONTRACTOR STATEMENT - FOR USA ONLY

All electrical Installations that are preliminary to positioning of the equipment at the site prepared for the
equipment shall be performed by licensed electrical contractors. Other connections between pieces of
electrical equipment, calibrations and testing shall be performed by qualified GE personnel. In
performing all electrical work on these products, GE will use its own specially trained field engineers. All
of GE’s electrical work on these products will comply with the requirements of the applicable electrical
codes.

The purchaser of GE equipment shall only utilize qualified personnel (i.e., GE’s field engineers,
personnel of third-party service companies with equivalent training, or licensed electricians) to perform
electrical servicing on the equipment.

OMISSIONS & ERRORS

If there are any omissions, errors or suggestions for improving this documentation, please contact the
GE Global Ultrasound Documentation Group with specific information listing the system type, manual
title, part number, revision number, page number and suggestion details.

Mail the information to:

Service Documentation
9900 Innovation Drive (RP-2156)
Wauwatosa, Wl 53226, USA.

GE employees should use Post-market Quality Management (PQM) to report service documentation
issues. These issues will then be in the internal problem reporting tool and communicated to the writer.

SERVICE SAFETY CONSIDERATIONS

/A DANGER DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, ARE PRESENT IN
THIS EQUIPMENT. USE EXTREME CAUTION WHEN HANDLING, TESTING AND
ADJUSTING.

& WARNING Use all Personal Protection Equipment (PPE) such as gloves, safety shoes, safety
glasses, and kneeling pad, to reduce the risk of injury.

For a complete review of all safety requirements, see the Chapter 1, Safety Considerations section in
the Service Manual.
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LEGAL NOTES

The contents of this publication may not be copied or duplicated in any form, in whole or in part, without
prior written permission of GE.

GE may revise this publication from time to time without written notice.

PROPRIETARY TO GE

Permission to use this Advanced Service Software and related documentation (herein called the
Material) by persons other than GE employees is provided only under an Advanced Service Package
License relating specifically to this Proprietary Material. This is a different agreement from the one under
which operating and basic service software is licensed. A license to use operating or basic service
software does not extend to or cover this software or related documentation.

If you are a GE employee or a customer who has entered into such a license agreement with GE to use
this proprietary software, you are authorized to use this Material according to the conditions stated in
your license agreement.

However, you do not have the permission of GE to alter, decompose or reverse-assemble the software,
and unless you are a GE employee, you may not copy the Material. The Material is protected by
Copyright and Trade Secret laws; the violation of which can result in civil damages and criminal
prosecution.

If you are not party to such a license agreement or a GE Employee, you must exit this Material now.

TRADEMARKS

All products and their name brands are trademarks of their respective holders.

COPYRIGHTS

© 2021 by General Electric Company Inc. All Rights Reserved.

DECLARATION OF CONFORMITY

The radio equipment used in the LOGIQ Fortis (if present) conforms to the Radio Equipment
Directive 2014/53/EU (RED). The declaration of conformity can be found at the following link:

https://www.intel.com/content/dam/support/us/en/documents/network-and-i-o/wireless-networking/
9260NGW-EU-RED-DoC.pdf

Search under Current or Legacy Adapters for: Intel® 9260
Figure WLAN Label for Intel 9260 Module
THIS SYSTEM COMTAING THE

FOLLAYING WIRELESS
EOAULE | INTEL 9260M0LW
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Chapter 1
Introduction

Section 1-1
Overview

1-1-1 Purpose of this chapter

This chapter describes important issues related to safely servicing the LOGIQ Fortis. The service
provider must read and understand all the information presented here before installing or servicing the
LOGIQ Fortis.

NOTE: The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

1-1-2 Contents in this chapter

1-1 OVEIVIBW. .« . 1-1

1-2 Service Manual OVerview. . . ... .. 1-2

1-3 Important Conventions . . . . ... ... 1-11
1-4 Labels/lcons onthe system . .. ... ... .. .. 1-14
1-5 Safety Considerations . .. ...... ... . 1-15
1-6 Dangerous Procedure Warnings . ... ... ...t 1-24
1-7 Lockout/Tagout (LOTO) . . ..ot e e e 1-25
1-8 Returning/Shipping Probes and RepairParts. . . .. ... .. ... ... ... .. ... ..., 1-29
1-9 Electromagnetic Compatibility (EMC). .. ... ... .. . . 1-30
1-10 Customer ASSiStance . . . ... ... 1-32
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Section 1-2
Service Manual Overview

1-2-1

Contents in this section

1-2-1 At ENtioN . ... e 1-2
1-2-2 Contents inthis service manual ........... .. ... . . . . . . . . . . . . . ... 1-3
1-2-3 Typical users of LOGIQ Fortis documentation ............. ... ... ... .......... 1-4
1-2-4 LOGIQ Fortis models covered inthismanual . . . .............................. 1-4
1-2-5 Product description . . .. ... 1-10
Attention

This manual provides installation and service information for the LOGIQ Fortis. Advanced equipment
training may be provided by factory trained Field Service trainers for the agreed-upon time period.

Section 1-2 - Service Manual Overview



Direction 5874372, Rev. 3

GE CONFIDENTIAL

LOGIQ Fortis Proprietary Service Manual

1-2-2

Contents in this service manual

The service manual is divided into ten chapters.

In the beginning of the manual, before Chapter 1, you will find the revision overview, the important
precautions including translation policy, damage in transportation, certified electrical contractor
statement, omission & errors, service safety considerations and legal notes, and the Table of
Contents (TOC).

An index has been included after Chapter 10.

Table 11 Contents in this Service Manual
CHAPTER
NUMBER CHAPTER TITLE DESCRIPTION

1 Introduction Contains a content summary and warnings.

2 Site Preparations Contains pre-setup requirements for the LOGIQ Fortis.

3 LOGIQ Fortis Setup Contains setup procedure with procedure checklist.

4 Functional Checks Qontaing functional chgcks thgt must be performed as pgrt of the
installation, or as required during servicing, care and maintenance.

5 Components and Functions (Theory) Contain§ block diagrams and functional explanations of the
electronics.

6 Service Adjustments Contains instrugtions on how to make any available adjustments to
the LOGIQ Fortis.

7 Diagnostics/Troubleshooting Provides prgcedures for running diagnostic or related routines for the
LOGIQ Fortis.
Provides disassembly procedures and reassembly procedures for all

8 Replacement Procedures changeable FRUs, available option installation instructions, and
upgrade installation instructions.

9 Renewal Parts Contains a complete list of replacement parts for the LOGIQ Fortis.

10 Care & Maintenance Provides care and maintenance procedures for the LOGIQ Fortis.

N/A Index Provides a quick way to find a topic.

Chapter 1 Introduction 1-3
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1-2-3 Typical users of LOGIQ Fortis documentation

The information needed to service the LOGIQ Fortis is collected in the Service Manual.

NOTE: Dates on screenshots are represented in MM/DD/YYYY format throughout the manual.
Information on how to change the LOGIQ Fortis’s date can be found in Chapter 10, Customizing
Your System, of the LOGIQ Fortis User Manual.

Typical users of the Basic Service Manual

» Service personnel (setup, maintenance, etc.)

* Hospital’s service personnel

» Architectural planners/installation planners (some parts of Chapter 2 - Site Preparations)
Typical users of the Proprietary Service Manual

*  GE Service personnel (setup, maintenance, etc.)
*  GE Online Center personnel

» Licensed hospital's service providers

* GE Repair Center Personnel

1-2-4 LOGIQ Fortis models covered in this manual

Table 1-2 LOGIQ Fortis Software Configuration and Hardware

Destination N"fj?w[;i"R DESCRIPTION S\‘/’E;‘Q:gﬁ'i
GLOBAL 6601000 LOGIQ Fortis LCD monitor, 100-240 VAC R3.x.
(except China) 6602000 LOGIQ Fortis HDU Display, 100-240 VAC R3.X.X
5876352 LOGIQ Fortis HDU Display console R3.x.x
5876353 LOGIQ Fortis Pro HDU Display R3.x.x
5876354 LOGIQ Fortis Express HDU Display R3.x.x
CHINA Only 5876355 LOGIQ Fortis Super HDU Display R3.X.X
5876356 LOGIQ Fortis Expert LCD Monitor R3.x.x
5876357 LOGIQ Fortis Plus LCD Monitor R3.x.X
5876358 LOGIQ Fortis Power LCDMonitor R3.X.X

1-4 Section 1-2 - Service Manual Overview



Direction 5874372, Rev. 3

GE CONFIDENTIAL

LOGIQ Fortis Proprietary Service Manual

1-2-4-1

LOGIQ Fortis Standards/Options

LOGIQ Fortis Global Configuration

‘Description

|Adv. Security
|Coded Contrast
|Parametric Imaging
|Cardiac AFI
|Report Writer

Stress Echo

Tricefy

LOGIQ Apps

[KOIOS sW

'LOGIQ Exx KOIOS Thyroid
'Scan Assistant

/Advanced Probes

|AUTO IMT

B Steer+

BFLOW
Compare Assistant

DICOM

[FLOW QA

SOFTWARE
OPTIONS

Measure Assist Breast

Measure Assist OB

ELASTOGRAPHY

[ELASTO QA
|SRI HD Type2

Shear Wave Elastgraphy

\UGAP
Hepatic Assistant - SWE-UGAP

SonoNT SonolT

|LOGIQ Exx DVR

LOGIQ Exx SRI HD Type 2

ILOGIQ Exx VNAV Image
[EZImaging

|Omni View

'sTIC

TUI

\VCl-Static
VOCAL_II

Thyroid Productivity

\Breast Productivity
VITA on Demand

CW Doppler Option Collector Swallow

|Realtime 4D

ECG

\Gel Warmer
Scan on battery Option kit T1.

HARDWARE
OPTIONS

Power Assistant Option kit T1

'Volume Navigation for V-Nav Inside Fortis

\Volume Navigation
|Wireless

S-Video

|Pencil CW HW Kit Swallow
|DVD Drive

|Standard(s)/Option(0)
HDU console | LCD console
(o] o

U\OU:OOOO:OU\O o000 000000 |w O 0000|000 OOOOOUOOOG'OOOU:OOOOfOOO

w o000 000|w0O O0C0O00000|0|wO 0000 000 0O0C0O0OC0O0OCODOO0O0ODOO0O00ODO
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1-2-4

1

_Description

|USB FOOTSWITCH 3 BUTTON
|SONY UPD25MD COLOR PRINTER
Powervar144k120v MG UPS

230V UPS

|BW Printer

PERIPHERAL |
OPTIONS

LOGIQ Exx Protective Cover

|LOGIQ Exx Inkjet Printer

Barcode Reader USBee1000A
Magnetic Card Reader
High Cabinet installation kit

\Low Cabinet installation kit
|Side Cabinet Installation kit
'Option Sinch bay installation kit
\Alpha numeric board assembly
\GERMAN AN Key board Assy

KEYBOARD
OPTIONS

[FRENCH AN Key board Assy
\GREEK AN Key board Assy

\NORWEGIAN AN Key board Assy

RUSSIAN AN Key board Assy

' SWEDISH AN Key board Assy

FC389,ECG CABLE SET

\VNav Stand (Offboard)

\VNav NEEDLE TRACKING

VNav VirtuTRAX Starter Kit

|[ECG Cables IEC Style

\VNav Virtual Tracker

\VMav Active Tracker kit

'VNav Needle Tracking storage insert

\VNav Needle Tracking Kit - 18/20g or less |

ACCESSORIES |

VMav ETRAX 12 14G ST KT
VMav ETRAX 14 16G ST KT
Mav Probe sensors

VNav MR Active Tracker

LOGIQ E10 KOIOS INSTALL
\KOIOS Thyroid INSTALL

|Small Probe Holder

\VERTICAL TV PROBE HOLDER

TVTR Probe Holder

PROBE CABLE HANGER
|Ethernet Protection Cable

OPTION TRAY BOX

OPTION TRAY Bracket

Option Tray

LOGIQ Fortis Standards/Options (cont’d)

HDU console | LCD console

o
o

oo OCODQOODCODCOOICDODODO0OOODOICQI0OC|O|0|O0|0|C|O|C
oojojojojoojojooojojojojojoOODOC0OCDODOODIOODOOODIOICOIDI0O|DO|0|O|O|O|O|OQ
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LOGIQ Fortis Global Configuration

PROBES

TEE PROBE
ITEMS

Description

IC5-9-D Probe
MLB-15-D Probe
L8-18I-D Probe
C2-9-D Probe
C1-6-D Probe
C1-8VN-D Probe
C2-9VN-D Probe
C3-10-D Probe
M5Sc-D Probe
L2-9-D Probe
L2-9VN-D Probe
6Tc-RS Probe
TEE RS-DLP Adapter
C2-7-D Probe
C2-7VN-D Probe
C2-7D-LC Probe
P2D Probe
RIC5-9-D 4D Probe
RAB6-D Probe
PED Probe
BE9SCS-D Probe
L3-12-D Probe

|6S-D Probe

KZ200687 BITE GUARD

\KZ693 BITE GUARD OPR.CLIP ON
KZ808 TEE SCANH. PROTECT.COVER
|086A0016 BITE GUARD AD.16"27MM
|KZ800,BITE HOLE INDICATOR

\TEE STORAGE RACK

LOGIQ Fortis Standards/Options (cont’d)

|Standard(s)/Option(0)
HDU console LCD console
o] o

OO'OOO_OOODOOOOOOOEOOO_OUOOOOOOO

ooolojojcjojoiojoDjOD|OODOCOQO|0OCIO|O O |O|O|O
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1-2-4-2

LOGIQ Fortis China Configuration

LOGIQ Fortis China Configuration

Standard(S)/Option(O)/Not applicable(NA)

Description

Fortis

Fortis
Pro

Fortis
Express

Fortis
Super

Fortis
Expert

Fortis
Plus

Fortis
Power

SOFTWARE
OPTIONS

Adv. Security

(o)

[0)

o

(o]

Coded Contrast

Parametric Imaging

Cardiac AFI

Report Writer

Stress Echo

Tricefy

LOGIQ Apps

Scan Assistant

Advanced Probes

AUTO IMT

B Steer+

B-FLOW

Compare Assistant

DICOM

FLOW QA

Measure Assist Breast

Measure Assist OB

ELASTOGRAPHY

ELASTO QA

Shear Wave Elastgraphy

Qv v O0jvIOLIO|Lu|nw|0O|0O|0O|0O|nw|0|0|0

O|0|0Ojnw|O|0O|O|O|O|O|O|O|O|O|O O |O|O|O

Oo|0O|0O|0O|0O|0|O|O|O|O|O|O|O|O|O|O|nn (OO |0

UGAP

2
>

z
>

Hepatic Assistant - SWE-UGAP

p=4
>

z
>

SonoNT SonolT

LOGIQ Exx DVR

O |0

O |0

LOGIQ Exx SRIHD Type 2

(@]

(@]

LOGIQ Exx VNAV Image

=2
>

2
>

EZ Imaging

Omni View

STIC

TUI

VCI-Static

VOCAL_I

Thyroid Productivity

Breast Productivity

VITA on Demand

HARDWARE
OPTIONS

CW Doppler Option Collector Swallow

Realtime 4D

ECG

Gel Warmer

Scan on battery Option kit T1

Power Assistant Option kit T1

Volume Navigation for V-Nav Inside Fortis

O|0O|O|nw|O |O|0O|0O|O0|0O|O|0|0O|O|0|w»n

O|0|O|nw|O |O|0O|0O|0O|0O|O|0O|0O|O |0 |w»n

Ol0O|0O|»w|O |O|O|O|O|O|O|O|O|O|O|wn

Volume Navigation

2
>

2
>

=4
>

Wireless

S-Video

Pencil CW HW Kit Swallow

DVD Drive

PERIPHERAL
OPTIONS

USB FOOTSWITCH 3 BUTTON

BW Printer

LOGIQ Exx Protective Cover

High Cabinet installation kit

Option 5inch bay installation kit

KEYBOARD
OPTIONS

Alpha numeric board assembly

O |0O0O/0O|0|0 |[»w|lO|O|O|O|O|O|O|ww|O |O|O|O|O|O|O|O|O|O|O||O|O|O|0O0O|0|I0|V|VLIVIOO|VIO|LO|LILIOIOIOIO|Vw|O|O|O (O

O |0O0O/0O|0|0 [»w|O|O|O|O|O|O|O|nw|O |O|O|O|O|O|O|O|O|O|O|nW|O|O|O|O|O|O|O|O|O|O|O|O|W|O|O|O|O|WO|O|O|O|w|O|O|O |O

O |0O0/0O|0|0 [»w|O|O|O|O|O|O|O|w|O |O|O|O|O|O|O|O|O|O|O|W|O|O|O|O|O|O|O|O|O|O|O|0O|W|VWIOOWOO|IO|O|O|n|O|O|0O

O |0O|l0O|0|0|0 [w|O|O|O|O|O|O|O|w|O |O|O|O|O|O|O|O|O|O|O|0w|O|O|O|O|O|O|O|O|O|O|O|O|nw|O|O|O|O|O|O|O|O|O|nn|O|O|0O

O |[0O|O|O|O|O0 |»w|O|0O |0

O |[0O|O|O|O|O0 |»w|O|0O |0

O |0j0|0|0|0 |»w|O|0O |0
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1-2-4-2 LOGIQ Fortis China Configuration (cont’d)
LOGIQ Fortis China Configuration Standard(S)/Option(0)/Not applicable(NA)
Fortis Fortis Fortis Fortis Fortis Fortis Fortis
Description Pro Express Super Expert Plus Power
FC389,ECG CABLE SET o 0 [s] 0 0 [s] 0
VNav Stand (Offboard) o 0 o ) NA NA NA
VNav NEEDLE TRACKING 6] 0 o 0 NA NA NA
VNav VirtuTRAX Starter Kit [o] 0 o} [o] NA NA NA
ECG Cables IEC Style o 0 o 0 0 o 0
VNav Virtual Tracker [o] 0 (e} [o] NA NA NA
VNav Active Tracker kit [o] 0 0 [o] NA NA NA
VNav Needle Tracking storage insert o o o 0 NA NA NA
VNav Needle Tracking Kit - 18/20g or less [o] 0 o} [o] NA NA NA
VNav ETRAX 12 14G ST KT o 0 [¢] 0 NA NA NA
ACCESSORIES |\/Nav ETRAX 14 16G ST KT 0 0 o 0 NA NA NA
VNav Probe sensors (o] 0 e} [o] NA NA NA
VNav MR Active Tracker o 0 o] o] NA NA NA
Small Probe Holder [o] 0 e} [o] 0 [o} [o]
VERTICAL TV PROBE HOLDER 0 0 o 0 0 o 0
TVTR Probe Holder o 0 o 0 0 o 0
PROBE CABLE HANGER 0 0 o] 0 0 [s] 0
OPTION TRAY BOX o 0 o o o o 0
OPTION TRAY Bracket o] 0 [s] 0 0 [s] 0
Option Tray [o] 0 [o} o] 0 [o]} 0
IC5-9-D Probe 0 0 [s] 0 0 [¢] 0
ML6-15-D Probe o 0 [¢] 0 0 [¢] 0
L8-18I-D Probe o | 0 [¢] c | o | o | o
C2-9-D Probe (o] 0 o} [o] o] [e} 0
C1-6-D Probe o 0 o] 0 0 8] 0
C1-6VN-D Probe 0 0 [s] 0 NA NA NA
C2-9VN-D Probe (8] 8] o 8] NA NA NA
C3-10-D Probe (o] 0 0 o] o] [o} [o]
M5Sc-D Probe [o] 0 e} o] 0 (o} [o]
L2-9-D Probe [o] 0 e} [o] 0 o} 0
L2-9VN-D Probe o 8] o 8] MNA NA MNA
PROBES  |6Tc-RS Probe o 0 o] 0 o] o] 0
TEE RS-DLP Adapter [o] 0 e} [o] 0 [e} 0
C2-7-D Probe [o] 0 (e} o] 0 e} [o]
C2-7VN-D Probe. o o o o NA NA NA
C2-7D-LC Probe NA MNA NA NA NA NA NA
P2D Probe o 0 [s] 0 0 o 0
RIC5-9-D 4D Probe o 0 o] 0 0 [¢] 0
RABE-D Probe [o] 0 o} [e] o] o} 0
PED Probe 0 ) 0 0 ) 0 0
BE9CS-D Probe o 0 o] 0 0 o] 0
L3-12-D Probe o] 0 e} [o] 0 [o} [o]
6S-D Probe 0 0 o 0 0 o 0
KZ200687 BITE GUARD ¢] 0 [¢] 0 0 [¢] 8]
KZ693 BITE GUARD OPR.CLIP ON 0 0 [o] 0 0 [¢] o]
TEE PROBE KZ808 TEE SCANH. PROTECT.COVER o 0 [¢] 0 0 [¢] 0
ITEMS 086A0016 BITE GUARD AD.16*27MM 0 0 [s] 0 0 [¢] 0
KZ800,BITE HOLE INDICATOR 0 0 [¢] 0 o] [¢] 0
TEE STORAGE RACK ¢] 0 [¢] 0 0 [e] 0
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1-2-5

1-2-5-1

1-2-5-2

1-2-5-3

Product description
Overview
The LOGIQ Fortis is a high performance digital ultrasound imaging system with total data management.

The fully digital architecture of the LOGIQ Fortis allows optimal usage of all scanning modes and probe
types throughout the full spectrum of operating frequencies.

The LOGIQ Fortis is a digital beamforming Ultrasound system. The Ultrasound signal flows from the
probe through the Ultrasound system where it is processed and finally displayed as a diagnostic image
on the monitor. Images and patient data can be sent to peripheral devices to be stored, printed, or
displayed.

System configuration is stored on the internal drive.
All necessary software is loaded from the internal drive on power up.
For more information on:

» Installed software versions, see "Software Status" on page 7-19

» Installed hardware, see Section 7-4 "Service Desktop" on page 7-11

+ Connected probes, see Section 7-4 "Service Desktop" on page 7-11

+ Compatible software, hardware, peripherals, and probes, see "Software" on page 9-4

FRUs for the ultrasound system
Refer to Chapter 9 in this manual.

Purpose of the user manual
The user manual should be fully read and understood before operating the LOGIQ Fortis.

The online versions of the user manual is available through the Help function on the LOGIQ Fortis’s
operator panel.

User manual documentation is provided through electronic Instructions For Use (elFU).

Section 1-2 - Service Manual Overview
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& CAUTION
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Conventions used in book

Model designations

This manual covers the LOGIQ Fortis models listed in 7-2-4 "LOGIQ Fortis models covered in this
manual” on page 1-4.

Icons

Pictures, or icons, are used wherever they will reinforce the printed message. The icons, labels, and
conventions used on the product and in the service information are described in this chapter.

Safety precaution messages

Various levels of safety precaution messages may be found on the equipment and in the service
information. The different levels of concern are identified by a flag word that precedes the precautionary
message. Known or potential hazards to personnel are labeled in one of three ways:

+  DANGER
+  WARNING
+ CAUTION

When a hazard is present that can cause property damage, but has absolutely no personal injury risk,
a NOTICE is used.

DANGER IS USED TO INDICATE THAT A SPECIFIC HAZARD IS KNOWN TO
EXIST WHICH, THROUGH INAPPROPRIATE CONDITIONS OR ACTIONS, WILL
CAUSE SEVERE OR FATAL PERSONAL INJURY.

WARNING IS USED TO INDICATE THAT A SPECIFIC HAZARD IS KNOWN TO EXIST
WHICH, THROUGH INAPPROPRIATE CONDITIONS OR ACTIONS, MAY CAUSE MINOR
PERSONAL INJURY AND/OR SUBSTANTIAL PROPERTY DAMAGE.

CAUTION IS USED TO INDICATE THAT A POTENTIAL HAZARD MAY EXIST WHICH, THROUGH
INAPPROPRIATE CONDITIONS OR ACTIONS, WILL OR CAN CAUSE PROPERTY DAMAGE.

Notice is used when a hazard is present that can cause property damage but has absolutely no
personal injury risk.

Notice Example: Disk drive may crash.
Notes are used to provide important information about an item or a procedure.

Be sure to read the notes; the information contained in a note can often save you time or effort.
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1-3-2

Standard hazard icons

Important information will always be preceded by the exclamation point & contained within a triangle,
as seen throughout this chapter. In addition to text, several different graphical icons (symbols) may be
used to make you aware of specific types of hazards that could possibly cause harm. Even if a symbol
is not used in this manual, it may be included for your reference.

Table 1-3 Standard Hazard Icons

Icon Meaning Icon Meaning

Biological Hazard Explosion Hazard

Describes precautions necessary to prevent the risk Describes precautions necessary to prevent

of disease transmission or infections. the risk of injury through explosion hazard!

« Patient/user infection due to contaminated * Risk of explosion if used in the presence of
equipment. flammable anesthetics.

Electrical Hazard Fire and Smoke Hazard

Describes precautions necessary to prevent the risk + Patient/user injury or adverse reaction from

of injury through electric hazards. * fire or smoke.

« Electrical micro-shock to patient, e.g., ventricular « Patient/user injury from explosion and fire.

Moving Hazard
Describes precautions necessary to prevent the risk
of injury through moving or tipping hazard!
» Console, accessories or optional storage devices Caution: HOT
that can fall on patient, user, or others. Be careful not to burn yourself
» Collision with persons or objects may result in injury
while maneuvering or during system transport.
* Injury to user from moving the console.

.;(\(R((..ns

Pinch point
Watch your fingers. This symbol indicates that serious
injury to the hand may occur.

Pinch point
Watch your fingers
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1-3-2 Standard hazard icons (cont’d)

Other icons make you aware of specific procedures or requirements that should be followed.

Table 1-4 Standard Icons for Specific Procedures or Requirements

Icon Meaning

AVOID STATIC ELECTRICITY
Use grounding devices.

WEAR HAND PROTECTION to WEAR FOOT PROTECTION to
protect from electrical dangers, cuts, prqtect from.electn.cal hazards,

. falling or rolling objects or from
punctures, fractures and amputations, f . .
otc crushing or penetrating materials,

LOCKOUT/TAGOUT (LOTO)
before performing the procedure

etc.

WEAR EYE PROTECTION to protect
eye from dust, liquid, piece of metal,
etc.
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Contents in this section

1-4-1 Label Location. . . .. ... . 1-14
1-4-2 LOGIQ Fortis used in a veterinary environment . . .. ......... .. ... .. .. . 1-14
1-4-1 Label Location
For information on label locations, refer to the appropriate version of the Basic User Manual or the latest
version of the Release Notes.
Table 1-5 Basic User Manual and Release Notes for the LOGIQ Fortis
ENGLISH BASIC ENGLISH
MODEL USER MANUAL RELEASE NOTES
NUMBER DIRECTION NUMBER DIRECTION NUMBER
Running R3.x.x 5855997-1EN 58707681EN
software
1-4-2 LOGIQ Fortis used in a veterinary environment

There are different handling instructions for a LOGIQ Fortis used in a veterinary environment.

This table lists the labels (and locations) required on the LOGIQ Fortis when it is used in a veterinary
environment.

For specific information about label placement, see Table 8-34 "LOGIQ Fortis used in a Veterinary
Environment Label Placement" on page 8-69.
Table 1-6

Product Labels on the LOGIQ Fortis in a Veterinary Environment
Label

Location

b e

@@

& @ Probe cable(s) near the

connector

\
GRS

NN
\\\\\\\\\\\
O

Side covers

4

Monitor arm

or

A® @
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Section 1-5
Safety Considerations

1-5-1

1-5-2

& DANGER

A\

& DANGER

A\

A DANGER

A DANGER

Contents in this section
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Introduction

The following safety precautions must be observed during all phases of operation, service, and repair
of this equipment. Failure to comply with these precautions or with specific warnings elsewhere in this
manual violates safety standards of design, manufacture, and intended use of the equipment.

Human safety

*  Operating personnel must not remove the Ultrasound system covers.
Servicing should be performed by authorized personnel only.

Only personnel who have participated in a LOGIQ Fortis Training Seminar are authorized to service the
equipment.

DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, ARE PRESENT IN
THIS EQUIPMENT. USE EXTREME CAUTION WHEN HANDLING, TESTING AND
ADJUSTING.

WITH THE POWER ASSISTANT OPTION, DANGEROUS VOLTAGES, CAPABLE
OF CAUSING DEATH, ARE PRESENT IN THIS EQUIPMENT. DO NOT REMOVE
THE COVER.

TILTING THE LOGIQ Fortis REQUIRES TWO PEOPLE IN ORDER TO AVOID
INJURY TO SERVICE PERSONNEL AND DAMAGE TO THE EQUIPMENT.

USE EXTREME CAUTION AS LONG AS THE LOGIQ Fortis IS UN-STABLE,
NOT RESTING ON ALL FOUR CASTERS.
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1-5-2 Human safety (cont’d)

& DANGER DO NOT USE UNAPPROVED DEVICES.

IF DEVICES ARE CONNECTED WITHOUT THE APPROVAL OF GE, THE WARRANTY WILL BE
INVALID.

ANY DEVICE CONNECTED TO THE ULTRASOUND SYSTEM MUST CONFORM TO ONE OR
MORE OF THE REQUIREMENTS LISTED BELOW:

- IEC standard or equivalent standards appropriate to devices.
- The devices shall be connected to protective earth (ground).

A DANGER RISK OF ELECTRICAL SHOCK, THE LOGIQ Fortis MUST BE TURNED OFF AND
DISCONNECTED FROM POWER SOURCE. CORD MUST BE CONTROLLED AT ALL TIMES.

ﬁ DISCONNECT THE BATTERIES FROM THE BACKPLANE.

BEWARE THAT THE MAIN POWER SUPPLY, THE POWER ASSIST BATTERIES OR POWER
MODULE AND BEPS MAY BE ENERGIZED EVEN IF THE POWER IS TURNED OFF IF THE
CORD IS STILL PLUGGED INTO THE AC OUTLET.

& DANGER Be sure to have read and understood control explanations for each mode used before
attempting to adjust the Acoustic Output control or any control that can affect Acoustic
Output. During a screening and diagnostic ultrasound examination, high frequency sound
penetrates and interacts with tissue in and around the area of anatomy to be imaged. Only a
small portion of this sound energy is reflected back to the transducer for use in constructing
the image, while the remainder is dissipated within the tissue. The interaction of sound
energy with tissue at sufficiently high levels can produce biological effects (aka bioeffects)
of either a mechanical or thermal nature. Although the generation of bioeffect is intentional
with therapeutic ultrasound, it is generally undesired in screening and diagnostic
applications and may be harmful in some conditions.

Use the minimum necessary acoustic output (the principle of ALARA (As Low As Reasonably
Achievable)) to get the best diagnostic image or measurement during an examination. Begin
the exam with the probe that provides an optimum focal depth and penetration.

| =»
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1-5-2 Human safety (cont’d)

/\ WARNING IF THE COVERS ARE REMOVED FROM AN OPERATING LOGIQ Fortis, SOME METAL
SURFACES MAY BE WARM ENOUGH TO POSE A POTENTIAL HEAT HAZARD IF
TOUCHED, EVEN WHILE IN SHUTDOWN MODE.

/\\ WARNING USE ALL PERSONAL PROTECTION EQUIPMENT (PPE) SUCH AS GLOVES, SAFETY
SHOES, SAFETY GLASSES, AND KNEELING PADS TO REDUCE THE RISK OF INJURY.

A WARNING EXPLOSION WARNING

DO NOT OPERATE THE EQUIPMENT IN AN EXPLOSIVE ATMOSPHERE.
OPERATION OF ANY ELECTRICAL EQUIPMENT IN SUCH AN ENVIRONMENT
CONSTITUTES A DEFINITE SAFETY HAZARD.

& WARNING For console Ultrasound systems and Ultrasound systems mounted on a cart, when
the top console is in its locked position, the gas shock is compressed and stores
mechanical energy. During normal operation the top console, the weight of the main
monitor and the mechanical force of the gas shock are in balance. Take care if/when
you activate this gas shock. Personal injury can occur after the panel is removed and
the shock pressure is released. Take care when you repair the elevation assembly.

/\ WARNING BEWARE OF POSSIBLE SHARP EDGES ON ALL MECHANICAL PARTS. IF SHARP
EDGES ARE ENCOUNTERED, THE APPROPRIATE PPE SHOULD BE USED TO
REDUCE THE RISK OF INJURY.
THE APPROPRIATE PPE IS REQUIRED PER EHS POLICIES AND SRAS.

/\ WARNING WEAR ALL PPE INCLUDING GLOVES AS INDICATED IN THE CHEMICAL SDS.

& WARNING HAVE TWO PEOPLE AVAILABLE TO DELIVER AND UNPACK THE LOGIQ FORTIS.
ATTEMPTS TO MOVE THE LOGIQ FORTIS CONSIDERABLE DISTANCES OR ON AN
INCLINE BY ONE PERSON COULD RESULT IN INJURY OR DAMAGE OR BOTH.
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1-5-2 Human safety (cont’d)

& CAUTION BECAUSE OF THE LIMITED ACCESS TO CABINETS AND EQUIPMENT IN THE FIELD, PLACING
PEOPLE IN AWKWARD POSITIONS, GE HAS LIMITED THE LIFTING WEIGHT FOR ONE PERSON
IN THE FIELD TO 16 KG (35 LBS). ANYTHING OVER 16 KG (35 LBS) REQUIRES 2 PEOPLE.

& CAUTION DO NOT SUBSTITUTE PARTS OR MODIFY EQUIPMENT

BECAUSE OF THE DANGER OF INTRODUCING ADDITIONAL HAZARDS, DO NOT INSTALL

SUBSTITUTE PARTS OR PERFORM ANY UNAUTHORIZED MODIFICATION OF THE
EQUIPMENT.
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1-5-3 Mechanical safety

/\ DANGER ULTRASOUND PROBES ARE HIGHLY SENSITIVE MEDICAL INSTRUMENTS
THAT CAN EASILY BE DAMAGED BY IMPROPER HANDLING. USE CARE WHEN
HANDLING AND PROTECT FROM DAMAGE WHEN NOT IN USE. DO NOT USE A
DAMAGED OR DEFECTIVE PROBE. FAILURE TO FOLLOW THESE
PRECAUTIONS CAN RESULT IN SERIOUS INJURY AND EQUIPMENT DAMAGE.

A\ DPANGER WHEN THE LOGIQ FORTIS IS RAISED FOR A REPAIR OR MOVED ALONG ANY
INCLINE, USE EXTREME CAUTION SINCE IT MAY BECOME UNSTABLE AND
TIP OVER.

A\ DANGER THE LOGIQ FORTIS WEIGHS 85KG (178 LBS) AND UP TO 95 KG (209 LBS),
DEPENDING ON INSTALLED PERIPHERALS. USE CARE WHEN MOVING
IT OR REPLACING ITS PARTS. FAILURE TO FOLLOW THE PRECAUTIONS
LISTED BELOW COULD RESULT IN INJURY, UNCONTROLLED MOTION,
AND COSTLY DAMAGE. ALWAYS:

- BE SURE THE PATHWAY IS CLEAR.
- USE SLOW, CAREFUL MOTIONS.

- USE TWO PEOPLE WHEN MOVING ON INCLINES OR LIFTING MORE
THAN 16 KG (35 LBS).

/\ WARNING WHILE THE SOFTWARE INSTALL PROCEDURE IS DESIGNED TO PRESERVE DATA,
YOU SHOULD SAVE ANY PATIENT DATA, IMAGES, AND SYSTEM SETUPS TO A
MEDIA OR HARDCOPY BEFORE DOING A SOFTWARE UPGRADE. FAILURE TO
FOLLOW INSTRUCTIONS COULD RESULT IN LOSS OF PATIENT DATA.

/\ WARNING NEVER USE A PROBE THAT HAS FALLEN TO THE FLOOR. EVEN IF IT LOOKS OK, IT
MAY BE DAMAGED.

/\ WARNING TO AVOID INJURY WHEN YOU MOVE THE MAIN MONITOR AND THE MONITOR ARM,
DO NOT PUT YOUR FINGER, HAND, OR OBJECT IN THE JOINT OF THE MAIN MONITOR
OR THE MONITOR ARM.

/\ WARNING TO AVOID INJURY OR DAMAGE TO THE MAIN MONITOR, MAKE SURE THERE IS
NOTHING WITHIN RANGE OF THE MAIN MONITOR BEFORE MOVING THE MAIN
MONITOR AND MONITOR ARM. THIS INCLUDES PEOPLE AND OTHER OBJECTS.

& CAUTION THE LOGIQ FORTIS SHOULD NOT BE MOVED WITH THE OPERATOR PANEL EXTENDED.
MOVE THE OPERATOR PANEL TO ITS CENTERED AND LOCKED POSITION. LOWER THE
OPERATOR PANEL AS MUCH AS POSSIBLE BEFORE MOVING THE LOGIQ FORTIS.
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1-5-3

A

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

Mechanical safety (cont’d)

TO PREVENT SYSTEM DAMAGE WHILE NOT IN USE AND/OR BEFORE MOVING THE SYSTEM,
FLIP DOWN THE MONITOR AND LOCK THE MONITOR ARM AND OPERATOR PANEL FIRMLY
IN PLACE.

TO AVOID INJURY WHEN YOU MOVE THE MAIN MONITOR AND THE MONITOR ARM, DO NOT
PUT YOUR FINGER, HAND, OR OBJECT ON THE JOINT OF THE MAIN MONITOR OR THE
MONITOR ARM.

IF THE FRONT CASTER SWIVEL LOCK IS ENGAGED FOR TRANSPORTATION, PRESSING THE
RELEASE PEDAL ONCE DISENGAGES THE SWIVEL LOCK. YOU MUST DEPRESS THE
RELEASE PEDAL A SECOND TIME TO ENGAGE THE BRAKE.

PRIOR TO ELEVATING THE LOGIQ FORTIS, VERIFY THE FOLLOWING:

- KEYBOARD IS LOCKED IN ITS LOWEST POSITION

- FRONT BRAKE IS LOCKED SO THE LOGIQ FORTIS IS UNABLE TO SWIVEL
- REAR BRAKES ARE IN THE LOCKED POSITION

BEFORE YOU MOVE OR TRANSPORT THE LOGIQ FORTIS, MAKE SURE TO FIRMLY LOCK THE
MONITOR ARM AND FLIP DOWN THE MAIN MONITOR TO PREVENT DAMAGE TO THE LOGIQ
FORTIS.

DO NOT MOVE THE ULTRASOUND SYSTEM IF THE OPERATING PANEL IS IN THE UNLOCKED
POSITION.

DO NOT TRANSPORT LOGIQ FORTIS IN A VEHICLE WITHOUT LOCKING THE CASTERS
(WHEELS) AND SECURING IT AS DESCRIBED IN CHAPTER 4.

USE PROTECTIVE GLASSES DURING DRILLING, FILING, AND DURING ALL
OTHER WORK WHERE EYES PROTECTION IS NEEDED.

USE SAFETY SHOES WHEN DOING WORK WHERE THERE IS ANY CHANCE OF
FOOT DAMAGE.

USE PROTECTIVE GLOVES WHEN DRILLING, CUTTING, AND WHEN REACHING
INTO CONFINED OR BLIND SPACES.

Section 1-5 - Safety Considerations
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1-5-3 Mechanical safety (cont’d)
NOTE: Special care should be taken when transporting the Ultrasound system in a vehicle:

» Before transporting, place the Ultrasound system in its special storage case.
» Ensure that the Ultrasound system is firmly secured while inside the vehicle.
+  Secure Ultrasound system with straps or as directed otherwise to prevent motion during transport.

* Prevent vibration damage by driving cautiously. Avoid unpaved roads, excessive speeds, and
erratic stops or starts.

& CAUTION BE CAREFUL NOT TO PINCH ANY OF THE CABLES.
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1-5-4

& CAUTION

& CAUTION

Electrical safety

Safe practices

RISK OF DAMAGE TO EQUIPMENT

CONNECTING THE LOGIQ FORTIS TO THE WRONG VOLTAGE LEVEL WILL MOST LIKELY
DESTROY IT.

RISK OF DAMAGE TO EQUIPMENT

USE THE POWER CORD EXCLUSIVELY ON THE LOGIQ FORTIS. DO NOT USE THE POWER
CORD TO MAKE ANY OTHER ELECTRICAL CONNECTIONS.

Follow these guidelines to minimize shock hazards whenever you are using the LOGIQ Fortis:

+ To minimize shock hazard, the equipment chassis must be connected to an electrical ground.

* The LOGIQ Fortis is equipped with a three-conductor AC power cable. This must be plugged into
an approved electrical outlet with safety ground. A separate power outlet with a 20 amp circuit
breaker for 120 VAC for 120V area, 7.5 amp circuit breaker for 220-240 VAC for 220/240V area or
15 amp circuit breaker for 100 VAC for Japan.

+ The power outlet used for this equipment should not be shared with other types of equipment.

+ Both the LOGIQ Fortis power cable and the power connector must meet international electrical
standards.

Probes
Follow these guidelines before connecting a probe to the LOGIQ Fortis:

* Inspect the probe prior to each use for damage or degradation to the:
- housing
- cable strain relief
- lens
- seal
- connectors
- locking mechanism
» Do not use a damaged or defective probe.
* Never immerse the probe connector or adapter into any liquid.

+ The LOGIQ Fortis has more than one type of probe port. Use the appropriate probe port designed
for the probe you are connecting.

Peripherals

» Refer to the “Peripherals used in the patient environment” in Chapter 2 of the User Manual for
peripheral isolation information.
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1-5-5

NOTE:

Battery safety
The LOGIQ Fortis is supplied with lithium ion batteries.

The lithium ion technology is significantly less hazardous to the environment than the lithium metal
technology used in some other batteries (such as watch batteries). Used batteries should not be placed
with common household waste products. Contact local authorities for the location of a chemical waste
collection program nearest you.

Regulations vary for different countries. Dispose of used batteries in accordance with local
regulations.

/\ WARNING THE LOGIQ Fortis BATTERIES HAVE A SAFETY DEVICE.

A CAUTION

A CAUTION

NOTE:

DO NOT ATTEMPT TO DIS-ASSEMBLE OR ALTER THE BATTERIES!
ALWAYS OBSERVE THE FOLLOWING PRECAUTIONS:

+ DO NOT short-circuit the batteries by directly connecting the negative terminals with metal objects.
+ DO NOT heat batteries or discard them into a fire.

DO NOT expose batteries to temperatures over 50 °C. Keep batteries away from fire and other heat
sources.

+ DO NOT charge batteries near a heat source, such as, a fire or heater.
+ DO NOT leave batteries in direct sunlight.

+ DO NOT pierce batteries with a sharp object, hit it, or step on it.
DO NOT use damaged batteries.

+ DO NOT apply solder to batteries.

+ DO NOT connect batteries to an electrical power outlet.

+ DO NOT immerse batteries in water or allow them to get wet.

USE ONLY BATTERIES APPROVED BY GE AS SUITABLE FOR USE WITH THE LOGIQ Fortis
ULTRASOUND SYSTEM.

TO PREVENT BATTERIES FROM BURSTING OR IGNITING, OR FUMES FROM THE BATTERIES
CAUSING EQUIPMENT DAMAGE, ALWAYS OBSERVE THE FOLLOWING PRECAUTIONS:

DO NOT place batteries into a microwave oven or pressurized container.
+ If a battery leaks or emits an odor, remove it from all possible flammable sources.

» If a battery emits an odor or heat, is deformed or discolored, or in a way appears abnormal during
use, recharging or storage, immediately remove it and stop using it.

If you have any questions about the batteries, consult your local GE representative.

+  Store the battery pack between -10 °C (14 °F) and 50 °C (122 °F).

When charging batteries for the first time after long-term storage, recover the battery pack to original
performance through repeating several cycles of full charging and discharging.
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Section 1-6
Dangerous Procedure Warnings

Warnings, such as the example below, precede potentially dangerous procedures throughout this
manual. Instructions contained in the warnings must be followed.

/A DANGER DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, ARE PRESENT IN
THIS EQUIPMENT. USE EXTREME CAUTION WHEN HANDLING, TESTING AND

CE ADJUSTING.

/\ WARNING IF THE COVERS ARE REMOVED FROM AN OPERATING LOGIQ Fortis, SOME METAL
SURFACES MAY BE WARM ENOUGH TO POSE A POTENTIAL HEAT HAZARD IF
TOUCHED, EVEN WHILE IN SHUT DOWN MODE.

A WARNING EXPLOSION WARNING

DO NOT OPERATE THE EQUIPMENT IN AN EXPLOSIVE ATMOSPHERE. OPERATION
OF ANY ELECTRICAL EQUIPMENT IN SUCH AN ENVIRONMENT CONSTITUTES A
DEFINITE SAFETY HAZARD.

/\ WARNING DO NOT SUBSTITUTE PARTS OR MODIFY EQUIPMENT.

BECAUSE OF THE DANGER OF INTRODUCING ADDITIONAL HAZARDS, DO NOT
INSTALL SUBSTITUTE PARTS OR PERFORM ANY UNAUTHORIZED MODIFICATION
OF THE EQUIPMENT.

1-24 Section 1-6 - Dangerous Procedure Warnings



GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

Section 1-7
Lockout/Tagout (LOTO)

1-71

Contents in this section
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Lockout/tagout requirements

Read and understand the lockout/tagout (LOTO) requirements before performing any replacement
procedures. Keep these instructions for future reference. Follow all of the safety measures and
procedures listed in this service manual.

Lockout/tagout requirements ensure you are in total control of the AC power plug at all times during the
service process.

Table 1-7 Preparations

Preparations - you must perform the following steps

& DANGER

Risk of dangerous voltage within the LOGIQ Fortis.

Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.

Follow Lockout/Tagout requirements by ensuring you are in total control of the AC power plug at all times
during the service process.

¢ Plan and prepare for shutdown.

Completely power down the LOGIQ Fortis.

Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
Isolate the equipment.

Remove/disconnect the battery, if present.

Apply lockout/tagout devices to maintain exclusive control of the power cable.
Control all stored and residual energy.

Verify isolation.

All potentially hazardous stored or residual energy is relieved.

For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:

e 1-7-2-1"Power down the LOGIQ Fortis" on page 1-26.

e 1-7-2-2 "Disconnect Power to the LOGIQ Fortis" on page 1-27.

¢ "Disconnect battery power" on page 1-28.

P>

/\ DANGER Risk of electrical shock, system must be turned off.
Avoid all contact with electrical contacts, conductors and components. Always use non-conductive han-
dles designed for the removal and replacement of ESD sensitive parts. All parts that have the potential for
f storing energy must be discharged or isolated before making contact.
/\ DANGER Risk of damage to equipment.
DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE NECESSARY ESD PRECAU-

TIONS:

1. ALWAYS CONNECT YOURSELF. THE ESD WRIST STRAP SHOULD BE CONNECTED TO ONE OF THE TWO
RECEPTICALS INTEGRATED ON THE FRAME, SPECIFICALLY FOR THAT PURPOSE.

2. FOLLOW GENERAL GUIDELINES FOR HANDLING OF ELECTROSTATIC SENSITIVE EQUIPMENT.

Chapter 1 Introduction 1-25




GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

1-7-2 Lockout/tagout procedure

1-7-2-1 Power down the LOGIQ Fortis
Apply lockout and tagout (LOTO) before servicing the Ultrasound system. Applying LOTO ensures a
safe environment when working on the LOGIQ Fortis. Follow all recommended safety procedures when
servicing and working near energy sources. Follow LOTO requirements by ensuring you are in total
control of the AC power plug at all times during the service process.

Table 1-8 Power Down the LOGIQ Fortis

Step Corresponding Graphic

1. |Set the caster brake.
Use the operator panel movement controls to set the panel height as required for this procedure.
Lock the panel in place.

2.
To completely power down the LOGIQ Fortis:
Lightly press the ON/OFF button on the operator
panel to display the System - Exit menu.

3.

SYSTEM - EXIT

Change Password

Select Shutdown to completely power down the
LOGIQ Fortis.

Shutdown Cancel

4. |wait for the ON/OFF button to turn from blue to white.
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1-7-2-2

Table 1-9

Disconnect Power to the LOGIQ Fortis

Disconnect Power to the LOGIQ Fortis

Step

Corresponding Graphic

A DANGER

Dangerous voltages exist within the LOGIQ Fortis.

Hazardous voltages, greater than 30 volts, exist in the LOGIQ Fortis.

Always disconnect the power cable from the wall before disconnecting it from the LOGIQ Fortis.

To remove the energy supply from the
LOGIQ Fortis, do the following:

1. Turn off the breaker on the back of the LOGIQ
Fortis.

2. From the wall outlet, disconnect the power
cable.

3. Disconnect the power cable from the LOGIQ
Fortis.

4. To prevent unexpected re-energization,

maintain exclusive control over the power cable.

5. Confirm that the ON/OFF button turns OFF.

Disconnect and store any probes attached to the LOGIQ Fortis.

Disconnect any external I/0O cabling.
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1-7-2 Lockout/tagout procedure (cont’d)

Disconnect battery power

Table 1-10 Disconnect Battery Power

Step Corresponding Graphic

A DANGER

Dangerous voltages exist within the LOGIQ Fortis.
There are no test points to verify isolation.
If the power cable is plugged into an AC outlet, be aware that the main power supply, batteries, power module may be

energized even if power is turned OFF.
Ty
o @

DR DL wet
Cre

1. Remove 5 screws and rear cover.

AN
an a.t‘-‘.‘:«:iu

Remove BBG2 Signal Cable and BBG2 Power Cable
and 1 screw.

3. |Confirm that all of these steps have been completed to verify isolation.
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Section 1-8
Returning/Shipping Probes and Repair Parts

NOTE:

NOTE:

NOTE:

Equipment being returned must be clean and free of blood and other infectious substances.

GE policy states that body fluids must be properly removed from any part or equipment prior to
shipment. GE employees, as well as customers, are responsible for ensuring that parts/equipment have
been properly decontaminated prior to shipment. Under no circumstance should a part or equipment
with visible body fluids be taken or shipped from a clinic or site (for example, body coils or an ultrasound
probe).

The purpose of the regulation is to protect employees in the transportation industry, as well as the
people who will receive or open this package.

The US Department of Transportation (DOT) has ruled that “items that were saturated and/or
dripping with human blood that are now caked with dried blood; or which were used or intended
for use in patient care” are “regulated medical waste” for transportation purposes and must be
transported as a hazardous material.

For a LOGIQ Fortis used in a veterinary environment the same restrictions apply.

Return used/unused spare parts from a veterinary environment with the purple recycling label
(regardless of its actual condition) and add a description on the label stating that the items were
removed from a LOGIQ Fortis Vet in a veterinary environment. This applies for probes and
covers labeled as Vet used.

The USER/SERVICE staff should dispose of all the waste properly, per federal, state, and local
waste disposal regulations.

If the purple recycling label is not used in your region, use the local recycling label.

The LOGIQ Fortis is not meant to be used for long-term storage of patient data or images. The user is
responsible for the data on the LOGIQ Fortis and a regular backup is highly recommended.

If the LOGIQ Fortis is sent for repair, please ensure that any patient information is backed up and erased
from the LOGIQ Fortis before shipping. It is always possible during system failure and repair to lose
patient data. GE is not responsible for the loss of this data.

If PHI (Patient Healthcare Information) data needs to be sent to GE employees for service purposes,
GE will ascertain agreement from the customer. Patient information shall only be transferred by
approved service processes, tools and devices restricting access, protecting or encrypting data where
required, and providing traceability in the form of paper or electronic documents at each stage of the
procedure while maintaining compliance with cross-border restrictions of patient information transfers.
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Section 1-9
Electromagnetic Compatibility (EMC)

Contents in this section

1-9-1 Whatis EMC 2 . . ... 1-30
1-9-2 ComplianCe . . . ... 1-30
1-9-3 Electrostatic discharge (ESD) prevention. . .............. . .. 1-31
1-9-1 What is EMC?
Electromagnetic compatibility describes a level of performance of a device within its electromagnetic
environment. This environment consists of the device itself and its surroundings including other
equipment, power sources and persons with which the device must interface. Inadequate compatibility
results when a susceptible device fails to perform as intended due interference from its environment or
when the device produces unacceptable levels of emission to its environment. This interference is often
referred to as radio—frequency or electromagnetic interference (RFI/EMI) and can be radiated through
space or conducted over interconnecting power of signal cables. In addition to electromagnetic energy,
EMC also includes possible effects from electrical fields, magnetic fields, electrostatic discharge and
disturbances in the electrical power supply.
For more information, refer to the appropriate version of the LOGIQ Fortis Basic User Manual Chapter
2, or the appropriate LOGIQ Fortis Release Notes.
1-9-2 Compliance
LOGIQ Fortis conforms to all applicable conducted and radiated emission limits and to immunity from
electrostatic discharge, radiated and conducted RF fields, magnetic fields and power line transient
requirements.
Applicable standards are: IEC60601-1-2:2014 (Ed.4).
NOTE: For CE Compliance, it is critical that all covers, screws, shielding, gaskets, mesh, and clamps
are in good condition and installed tightly without skew or stress. Proper installation following
all comments noted in this service manual is required in order to achieve full EMC performance.
1-30 Section 1-9 - Electromagnetic Compatibility (EMC)
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1-9-3 Electrostatic discharge (ESD) prevention

/\ DANGER DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE
NECESSARY ESD PRECAUTIONS:
1. ALWAYS CONNECT YOURSELF. THE ESD WRIST STRAP SHOULD BE CONNECTED
TO ONE OF THE TWO RECEPTICALS INTEGRATED ON THE FRAME, SPECIFICALLY
FOR THAT PURPOSE.
2. FOLLOW GENERAL GUIDELINES FOR HANDLING OF ELECTROSTATIC SENSITIVE
EQUIPMENT.

A\ DANGER RISK OF ELECTRICAL SHOCK. THE LOGIQ FORTIS MUST BE TURNED OFF.
AVOID ALL CONTACT WITH ELECTRICAL CONTACTS, CONDUCTORS AND
COMPONENTS. ALWAYS USE NON-CONDUCTIVE HANDLES DESIGNED FOR
THE REMOVAL AND REPLACEMENT OF ESD SENSITIVE PARTS. ALL PARTS
THAT HAVE THE POTENTIAL FOR STORING ENERGY MUST BE DISCHARGED
OR ISOLATED BEFORE MAKING CONTACT.

/\ WARNING RISK OF HEAT HAZARD. IF THE COVERS ARE REMOVED FROM AN OPERATING
LOGIQ FORTIS SOME METAL SURFACES (FOR EXAMPLE, THE GPU HEAT SINK ON
THE BEPS) MAY BE WARM ENOUGH TO POSE A POTENTIAL HEAT HAZARD EVEN
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Section 1-10
Customer Assistance

1-10-1

NOTE:

Contact information

If this equipment does not work as indicated in this service manual or in the user manual, or if you
require additional assistance, please contact the local distributor or appropriate support resource as
listed in Table 1-11.

Before you call, identify the following information, and acquire an image (Alt+D) to send to the Customer
Care team:

1.) Ultrasound system ID serial number

2.) Software version

3.) Date and time of occurrence

4.) Sequence of events leading to issue

5.) Whether the issue is repeatable

6.) Imaging mode, probe, preset/application

7.) Media brand, speed, capacity, type

8.) Save secondary image capture, cine loop, 4D multi-volume loop
9.) Detailed description of any problem encountered

10.)Where applicable, save the appropriate log files. Remember to save the log files for each day on a
separate media with labels.

Restart the application before resuming clinical scanning.
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1-10-1

1-10-2

Contact information (cont’d)

Table 1-11

Phone Numbers for Customer Assistance

LOCATION

NUMBER

USA

GE Healthcare

Ultrasound Service Engineering
9900 Innovation Drive (RP-2156)
Wauwatosa, WI 53226

Service

TEL: 1-800-437-1171

Service Parts

TEL: 1-800-558-2040

Online Center

TEL: 1-800-321-7937

Application Support

TEL: 1-800-682-5327

TEL: 1-262-524-5698

Canada

Service

TEL: 1-800-668-0732

Application Support

TEL: 1-262-524-5698

Latin America

Service

TEL: 1-262-524-5300

Application Support

TEL:1-262-524-5698

Europe TEL: +49 (0) 212-2802-652
GE Ultraschall Deutschland GmbH
Beethovenstrasse 239 Support
Postfach 11 05 60, D-42655 Solingen FAX: +49 (0) 212-2802-431
Germany

Algeria TEL: 213-2179-1212

Egypt Service Center TEL: 0020-2322-1252
EAGM

Saudi Service Center

TEL: +(966) 800 429 2222

UAE Service Center

TEL: 0097-1800-3646

Asia (Singapore)

GE Ultrasound Asia

Service Department - Ultrasound
298 Tiong Bahru Road #15-01/06
Central Placa

Singapore 168730

Service Department

TEL:+65 6291-8528

FAX: +65 6291-7006

TEL: +81 42-846-9011

New Zealand

Japan Online Center
FAX: +81 42-648-2905
. ) TEL: +86 800-810 8188
China Technical Support
TEL: +86 400-812 8188
TEL: 1-800-425-8025
India Technical Support TEL: 1-800-425-7255
TEL: 1-800-102-7750
Australia

Service Support

TEL: +61 1800 659 465

Korea

Technical Support

TEL: +82 1544-6119

Ultrasound system manufacturer

Information about system manufacturer is located in the Basic User Manual (appropriate revision).
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Chapter 2
Site Preparations

Section 2-1

Overview

2-1-1

NOTE:

2-1-2

Purpose of this chapter

This chapter provides the information required to plan and prepare for the setup of a LOGIQ Fortis.
Included are descriptions of the facility and electrical needs to be met by the purchaser of the
LOGIQ Fortis.

The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

Contents in this chapter

2-1 OVEIVIBW. .« . 2-1
2-2 General LOGIQ Fortis Requirements. . . ... .. ... .. 2-2
2-3 Facility Needs. . . ... 2-9
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Section 2-2
General LOGIQ Fortis Requirements

Contents in this section

2-2-1 LOGIQ Fortis environmental requirements . . . ........... ... .. i 2-2
2-2-2 Electrical requirements . . . .. ... . e 2-4
2-2-3 EMIimitations. . . ... .. e 2-6
2-2-4 Probe environmental requirements. . . ........ .. .. 2-8
2-2-5 Time and manpower requIrements . . . ... ... 2-8
2-2-1 LOGIQ Fortis environmental requirements
If the LOGIQ Fortis is very cold or hot
A CAUTION RISK OF DAMAGE TO EQUIPMENT
IF THE ULTRASOUND SYSTEM IS VERY COLD OR HOT, DO NOT TURN ON ITS POWER UNTIL
IT HAS HAD A CHANCE TO ACCLIMATE TO ITS OPERATING ENVIRONMENT.
When unpacking the LOGIQ Fortis, allow the temperature to stabilize before powering up.
Refer to Table 2-1 for guidelines on reaching operational temperatures from storage or transport
temperatures.
Table 2-1 LOGIQ Fortis Acclimate Time
°c | 50 | 45 | 40 | 35 | 30 | 25 | 20 | 15 | 10 | 5 0 | -5 |-10
OF | 122 113|104 | 95 | 86 | 77 | 68 | 59 | 50 | 41 | 32 | 23 | 14
Hrs | 4 2 0 0 0 0 0 0 0 2 4 6 8
Environmental specifications
The LOGIQ Fortis should be operated, stored, and transported according to the listed environmental
requirements.
NOTE: Probe environmental specifications may be different than the LOGIQ Fortis.
Refer to Table 2-2 for environmental specifications.
Table 2-2 Environmental Specifications for the LOGIQ Fortis
Operational Storage Transport (< 16 hrs.)
T ) 10° - 35°C -10°-50°C -10°-50°C
emperature 50° - 95°F 14° - 122°F 14° - 122°F
Humidity 30 - 80% non-condensing 30 - 80% non-condensing 30 - 80% non-condensing
Pressure 70 - 106kPa 70 - 106kPa 70 - 106kPa
Heat Dissipation 3070 Btu/hour n/a n/a
2-2 Section 2-2 - General LOGIQ Fortis Requirements
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2-2-1 LOGIQ Fortis environmental requirements (cont’d)
Cooling

The cooling requirement for the LOGIQ Fortis with monitor and onboard peripherals is up to 3070 Btu/
hr. This figure does not include cooling needed for lights, people, or other equipment in the room. Each
person in the room places an additional 300 Btu/hr. demand on the cooling system.

Lighting

Bright light is needed for LOGIQ Fortis set up, updates, and repairs. However, operator and patient
comfort may be optimized if the room light is subdued and indirect. Therefore a combination lighting
system (dim/bright) is recommended. Keep in mind that lighting controls and dimmers can be a source
of EMI which could degrade image quality. These controls should be selected to minimize possible
interference.
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2-2-2

Electrical requirements

General requirements

NOTE: GE requires a dedicated power and ground for the proper operation of its ultrasound equipment. This
dedicated power shall originate at the last distribution panel before the LOGIQ Fortis.
The LOGIQ Fortis will function on voltages from 100-240 volts and 50 or 60 Hz. However, if using 220
volt power, then a center tapped power source is required.
Sites with a mains power system with defined neutral and live:
The dedicated line shall consist of one phase, a neutral (not shared with any other circuit), and a full
size ground wire from the distribution panel to the LOGIQ Fortis outlet.
Sites with a mains power system without a defined neutral:
The dedicated line shall consist of one phase (two lines), not shared with any other circuit, and a full
size ground wire from the distribution panel to the LOGIQ Fortis outlet.
NOTE: Please note that image artifacts can occur, if at any time within the facility, the ground from the
main facility’s incoming power source to the Ultrasound system is only a conduit.
Electrical requirements for LOGIQ Fortis
In Table 2-3, the electrical specifications for the LOGIQ Fortis include monitor and on board peripherals.
Table 2-3 Electrical Specifications for the LOGIQ Fortis
POWER
PART NUMBER DESCRIPTION VOLTAGE TOLERANCES CONSUMPTION FREQUENCY
6601000/6602000 |LOGIQ Fortis, 100-240 VAC 100-240 VAC +-10% 0.9 KVA 50/60 Hz
Inrush current
During power on, an inrush circuit prevents the current from increasing above the stated values.
Refer to Table 2-4 for inrush currents at various main voltages.
Table 2-4 Inrush Current at Different Mains Voltages
VOLTAGE Inrush Current
110 VAC 25 A max
120 VAC (with UPS
ABCE1442-11MED) 60 A max
230 VAC 50 A max
NOTE: These values are estimations.
Inrush current with UPS
During power on, the inrush current is higher than the one documented in the LOGIQ Fortis manuals
due to the use of the UPS. The inrush current value is measured by UPS input point.
Power Supply 230V 50Hz
UPS ABCE1442-22MED
Inrush Current 70A max
2-4 Section 2-2 - General LOGIQ Fortis Requirements
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2-2-2 Electrical requirements (cont’d)

& CAUTION

Site circuit breaker

RISK OF POWER OUTAGE

THE LOGIQ Fortis REQUIRES A DEDICATED SINGLE BRANCH CIRCUIT. TO AVOID CIRCUIT
OVERLOAD AND POSSIBLE LOSS OF CRITICAL CARE EQUIPMENT, MAKE SURE YOU DO NOT
HAVE ANY OTHER EQUIPMENT OPERATING ON THE SAME CIRCUIT.

It is recommended that the branch circuit breaker for the LOGIQ Fortis be readily accessible.
Site power outlets

A dedicated AC power outlet must be within reach of the LOGIQ Fortis without extension cords. Other
outlets adequate for the external peripherals, medical and test equipment needed to support this
LOGIQ Fortis must also be present within 1 m (3.2 ft.) of the LOGIQ Fortis. Electrical installation must
meet all current local, state, and national electrical codes.

LOGIQ Fortis power plug

If the LOGIQ Fortis arrives without a power plug, or with the wrong plug, you must contact your GE
dealer or the installation engineer must supply what is locally required.

Power stability requirements
Voltage drop-out
Max 10 ms.
Power transients (all applications)

Less than 25% of nominal peak voltage for less than 1 ms for any type of transient, including line
frequency, synchronous, asynchronous, or aperiodic transients.
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2-2-3

EMI limitations

Ultrasound machines are susceptible to Electromagnetic Interference (EMI) from radio frequencies,
magnetic fields, and transients in the air or wiring. Ultrasound machines also generate EMI. The
LOGIQ Fortis complies with limits as stated on the EMC label. However there is no guarantee that
interference will not occur in a particular installation.

Possible EMI sources should be identified before the LOGIQ Fortis is installed.

Electrical and electronic equipment may produce EMI unintentionally as the result of a defect. These
sources include:

* medical lasers

* scanners

» cauterizing guns

* computers

*  monitors

+ fans

* gel warmers

* microwave ovens

* light dimmers

* mobile phones

* in-house wireless phones (DECT phones)
» wireless computer keyboard and mouse

* air conditioning system

» High Frequency (HF) surgery equipment
» general AC/DC adapters

The presence of a broadcast station or broadcast van may also cause interference.

Section 2-2 - General LOGIQ Fortis Requirements



GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

2-2-3 EMI limitations (cont’d)

See Table 2-5 for EMI prevention and abatement tips.

Table 2-5

EMI Prevention/Abatement

EMI Rule

Detail

Be aware of RF sources

» Keep the LOGIQ Fortis at least 5 meters or 15 feet away from other EMI sources.

 Special shielding may be required to eliminate interference problems caused by high frequency,
high powered radio or video broadcast signals.

Ground the LOGIQ Fortis

Poor grounding is the most likely reason a LOGIQ Fortis will have noisy images. Check grounding
of the power cord and power outlet.

Replace all screws, RF
gaskets, covers, cores

« After you finish repairing or updating the LOGIQ Fortis, replace all covers and tighten all screws.
» Any cable with an external connection requires a magnet wrap at each end.

« Install the card rack cover over the card rack. Loose or missing covers or RF gaskets allow radio
frequencies to interfere with the ultrasound signals.

Replace broken RF
gaskets

If more than 20% or a pair of the fingers on an RF gasket are broken, replace the gasket. Do not
turn on the LOGIQ Fortis until any loose metallic part is removed.

Do not place labels where
RF gaskets touch metal

Never place a label where RF gaskets meet the LOGIQ Fortis. Otherwise, the gap created will
permit RF leakage. Or, if a label has been found in such a position, move the label.

Use GE specified
harnesses and peripherals

The interconnect cables are grounded and require ferrite beads and other shielding. Also, cable
length, material, and routing are all important; do not change from what is specified.

Take care with cellular
phones

Cellular phones may transmit a 5 V/m signal; that could cause image artifacts.

Properly dress peripheral
cables

Do not allow cables to lie across the top of the card rack or hang out of the peripheral bays. Loop
the excess length for peripheral cables inside the peripheral bays. Attach the monitor cables to
the frame.
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2-2-4

NOTE:

A NOTICE

2-2-5

& CAUTION

Probe environmental requirements

Probes should be operated, stored, and transported according to the listed environmental requirements.
For specific information on environmental requirements for the probes, see “Environmental
Requirements” in Chapter 3 of the Basic User Manual (latest revision).

LOGIQ Fortis environmental specifications may be different than the probes.

STORAGE TEMPERATURES VARY DEPENDING ON THE TYPE OF PROBE. WHEN EXPOSED TO
LARGE TEMPERATURE VARIATIONS, THE LOGIQ Fortis AND PROBES SHOULD BE KEPT AT
ROOM TEMPERATURE BEFORE USE.

Refer to the table in "If the LOGIQ Fortis is very cold or hot" on page 2-2 to determine the needed
settlement time.

Time and manpower requirements

RISK OF INJURY OR DAMAGE TO EQUIPMENT

HAVE TWO PEOPLE AVAILABLE TO DELIVER AND UNPACK THE LOGIQ FORTIS.
ATTEMPTS BY ONE PERSON TO MOVE THE LOGIQ Fortis CONSIDERABLE DISTANCES,
OR ON AN INCLINE, COULD RESULT IN INJURY, DAMAGE, OR BOTH.

Time requirement

Site preparation takes time. Begin pre-installation checks as soon as possible. If possible, begin pre-
installation six weeks before delivery to allow enough time to make any changes.

Manpower requirement

Two persons for delivery and unpacking.
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Section 2-3
Facility Needs

2-3-1

NOTE:

Contents in this section

2-3-1 Purchaser responsibilities. . . . ... ... 2-9

2-3-2 Required facility needs . . . . ... ... 2-10
2-3-3 Desirable features . . ... . 2-11
2-3-4 Minimal floor plan suggestions . . . ... ... ... 2-11
2-3-5 Networking setup requirements . . . ... . 2-13
2-3-6 Privacy and security . . ... ... 2-15
2-3-7 Environmental dangers. . . .. ... 2-15

Purchaser responsibilities

The work and materials needed to prepare the site are the responsibility of the purchaser. Delay,
confusion, and waste of manpower can be avoided by completing pre-installation work before delivery.
Purchaser responsibility includes:

»  Procuring the materials required.
+ Completing the preparations before delivery of the LOGIQ Fortis.
» Paying the costs for any alterations and modifications not specifically provided in the sales contract.

All electrical installations that are preliminary to the positioning of the equipment at the site
prepared for the equipment must be performed by licensed electrical contractors. Other
connections between pieces of electrical equipment, calibrations, and testing must also be
performed by qualified personnel. The products involved (and the accompanying electrical
installations) are highly sophisticated and special engineering competence is required. All
electrical work on these products must comply with the requirements of applicable electrical
codes. The purchaser of GE equipment must only utilize qualified personnel to perform
electrical servicing on the equipment.

The desire to use a non-listed or customer provided product or to place an approved product further
from the LOGIQ Fortis than the interface kit allows, presents challenges to the installation team. To
avoid delays during installation, such variances should be made known to the individuals or group
performing the installation at the earliest possible date (preferably prior to the purchase).

The ultrasound suite must be clean prior to delivery of the machine. Carpet is not recommended
because it collects dust and creates static. Potential sources of EMI (electromagnetic interference)
should also be investigated before delivery. Dirt, static, and EMI can negatively impact LOGIQ Fortis
reliability.
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2-3-2 Required facility needs
NOTE: GE requires a dedicated power and ground for the proper operation of its ultrasound equipment. This
dedicated power shall originate at the last distribution panel before the LOGIQ Fortis.
The LOGIQ Fortis will function on voltages from 100-240 volts and 50 or 60 Hz. However, if using 220
volt power, then a center tapped power source is required.
Sites with a mains power system with defined neutral and live:
The dedicated line shall consist of one phase, a neutral (not shared with any other circuit), and a full
size ground wire from the distribution panel to the ultrasound outlet.
Sites with a mains power system without a defined neutral:
The dedicated line shall consist of one phase (two lines), not shared with any other circuit, and a full
size ground wire from the distribution panel to the ultrasound outlet.
+ Dedicated single branch power outlet of adequate amperage (see Table 2-3 "Electrical
Specifications for the LOGIQ Fortis" on page 2-4) meeting all local and national codes which is
located less than 2.5 m (8 ft.) from the LOGIQ Fortis’s proposed location.
» Door opening is at least 76 cm (30 in) wide.
* Proposed location for LOGIQ Fortis is at least 0.46 m (1.5 ft) from the wall or objects for cooling.
» Power outlet and place for any external peripheral are within 2 m (6.5 ft.) of each other with
peripheral within 1 m (3.2 ft.) of the LOGIQ Fortis to connect cables.
+ Power outlets for other medical equipment and gel warmer.
»  Power outlets for test equipment within 1 m (3.2 ft.) of the LOGIQ Fortis.
+ Clean and protected space to store transducers (in their cases or on a rack).
* Material to safely clean probes (done with a plastic container, never metal).
2-10 Section 2-3 - Facility Needs
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2-3-3

2-3-4

Desirable features

In addition to the floor plan suggestions shown in Figure 2-1 and Figure 2-2, a nearby waiting room and
a receptacle for bio—hazardous waste, like used probe sheaths is suggested. Grid represents 30.5 x
30.5 cm (1 x 1 foot).

Minimal floor plan suggestions
Figure 2-1 Floor Plan Suggestion 4.27 x 5.18 m (14 x 17 foot)

T Pelle

Floor Plan Suggestion 4.27 x 5.18 m (14 x 17 foot) Key

Item Description Item Description

1. | Secretary or doctors desk 2 Lockgble cabinet ordered by GE for its software and
proprietary manuals

3. | Film viewer 4. | Counter top

5. | Counter top and sink with hot and cold water 6. | Overhead light dimmer — dual level lighting (bright/dim)

7. | Emergency oxygen 8. | Suction line

9. Ded.lcated poyver outlet — circuit breaker protected and 10. |LOGIQ Fortis

easily accessible

11. | Network interface 12. 45.,7 cm (1.5 ft) distance of LOGIQ Fortis from wall or
objects

13. | Stool 14. | Footswitch

15. | Storage for linens and equipment 16. | Examination table — 193 x 61 cm (76 x 24 inches)

17. | Lavatory and dressing room 18. | Door — at least 76 cm (30 inches)
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2-3-4 Minimal floor plan suggestions (cont’d)
Figure 2-2 Floor Plan Suggestion 2.44 x 3.05 m (8 x 10 foot)

Ultrazound
{ S!.lsem

._..1.--.. - [

Floor Plan Suggestion 2.44 x 3.05 m (8 x 10 foot) Key

ltem Description Item Description
1. |Door — at least 76 cm (30 inches) 2. |Film viewer
3. Counter top, sink with hot and cold water, and supplies 4. |Linen supply
storage
5. |Probes/supplies 6. |Examination table — 193 x 61 cm (76 x 24 inches)
7. |Footswitch 8. |Stool
9. |External peripherals 10. |LOGIQ Fortis

1 Dedicated power outlet — circuit breaker protected and 12

) . Network interface
easily accessible

13 45,7 cm (1.5 ft) distance of LOGIQ Fortis from wall or 14, |Lockable cabinet ordered by GE for its software and
" |objects " | proprietary manuals
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2-3-5

Networking setup requirements

Stand alone scanner (without network connection)

None.

Scanner connected to hospital’s network

For supported networks, a 10/100/1000 Mbps Ethernet/DICOM network connection is required.
InSite™ requirements

Need internet access on the outbound port to GE’s remote service platform (Insite), which is only
opened on request by the user and through a secure HTTPS connection on port 443.

Insite requires an Ethernet connection with a 10/100 Mbps or 10/100/1000 Mbps interface.
Purpose of the DICOM network function

DICOM services provide the operator with clinically useful features for moving images and patient
information over a hospital network. Inbound and outbound connections through port 104 are for
DICOM connectivity. Examples of DICOM services include the transfer of images to workstations for
viewing or transferring images to remote printers. As an added benefit, transferring images in this
manner frees up the on-board monitor and peripherals, enabling viewing to be done while scanning
continues. With DICOM, images can be archived, stored, and retrieved faster, easier, and at a lower
cost.

DICOM option setup requirements

To configure the LOGIQ Fortis to work with other network connections, the site’s network administrator
must provide information to complete the form in Figure 2-3 "Worksheet for DICOM Network
Information" on page 2-14. Ensure that there are no spaces in any field of the form.

Entries must include:

* A host name, local port number, AE Title, IP address and Net Mask for the LOGIQ Fortis.

+ The IP addresses for the default gateway and other routers at the site for ROUTING
INFORMATION.

» The host name, IP address, port and AE Title for each device the site wants connected to the
LOGIQ Fortis for DICOM APPLICATION INFORMATION. A field for the make (manufacturer) and
the revision of the device, is also included. This information may be useful for troubleshooting.

For connectivity setup information, see the current revision of the LOGIQ Fortis Basic User

Manual (latest revision). See 7-4-1 "Label Location" on page 1-14.
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2-3-5

Networking setup requirements (cont’d)

Figure 2-3 Worksheet for DICOM Network Information

LOGIQ
Fortis
Host Name | IP Address | || || || | Local Port I:l
AETitle | | Netmask [ [ ][ [ |
Network | |
Speed Default Gateway | | | || || |
once [
DICOM APPLICATION
OTHER
NAME MAKE/ AE TITLE IP PORT CONFIGURATION
Store1 |- ----------oflooo el __Raw Data
__Allow Multiframe
__Structured
Reporting
Compression
e e | | __Raw Data
__Allow Multiframe
__Structured
Reporting
Compression
Store3 |- --------- | e
__Raw Data
__Allow Multiframe
__Structured
Reporting
Compression
DICOM
Print |~~~ "~~~ """}~ “~"“"~"~"“"“"“"“"“"“"“"}{~ ~“~"“"""“""~"""""/"7° Vendor:
Print Size:
Medium:
Copies:
Orientation:
Color
Worklist |- - - - - - - - - - - oo e e
Storage Associated
(0771111 11 I | Storage AE
10 [0 ] e e
MPPS
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2-3-6

2-3-7

Privacy and security

Since the LOGIQ systems are integrated into your IT-network, GE wants to make sure that you are
aware of the proactive measures we are taking to secure the LOGIQ Fortis.

For more information on privacy and security, see “Privacy and Security Manual” (latest revision).

Environmental dangers

Commercial devices such as laser cameras, printers, VCRs and external monitors, usually exceed
allowable leakage current limits and, when plugged into separate AC outlets, are in violation of patient
safety standards. Suitable electrical isolation of such external AC outlets, or providing the device with
extra protective earth, will be required in order to meet ANSI/AAMI ES60601-1 and IEC60601-
1standards for electrical leakage.
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2-3-7 Environmental dangers (cont’d)
Patient Vicinity UL60601-1 (USA)

2.12.20DV (UL60601-1:2003)

In area in which patients are normally cared for, the patient vicinity is the space with surfaces likely to
be contacted by the patient or attendant who can touch the patient. This encloses a space within the
room 1.83 m (6 ft.) beyond the perimeter of the bed (examination table, dental chair, treatment booth,
and the like) in its intended location, and extending vertically 2.29 m (7.5 ft.) above the floor.

Figure 2-4 Patient Vicinity
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Patient Environment IEC60601-1 (IEC60601-1-1) and ANSI AAMI ES60601-1

Sub Clause 2.202 and figure 201 (IEC60601-1-1:2000)

Sub Clause 3.79 and figure A.9 (IEC60601-1:2005 and ANSI AAMI ES60601-1:2005)

Such an area is an environment in which medical diagnosis, monitoring or treatment is carried out. It is
very difficult to attach unique dimensions to the PATIENT ENVIROMENT.

In practice, a distance of 2,5 m (8.2 ft.) above the floor on which the medical personnel stand and a
horizontal distance of 1,5 m (4.9 ft.) have justified themselves as indicative of the dimensions of the
Patient Environment.

The patient environment/vicinity will be depicted as a dashed line in this procedure. See example below.

Figure 2-5 Patient Environment

Item

Description

Patient environment

Chapter 2 Site Preparations



Direction 5874372, Rev. 3

GE CONFIDENTIAL

LOGIQ Fortis Proprietary Service Manual

This page was intentionally left blank.

Section 2-3 - Facility Needs



Direction 5874372, Rev. 3

GE CONFIDENTIAL
LOGIQ Fortis Proprietary Service Manual

Chapter 3

LOGIQ Fortis Setup

Section 3-1

Overview

3-1-1

NOTE:

3-1-2

Purpose of this chapter

This chapter contains information needed to set up the LOGIQ Fortis. Also included in this section are
guidelines for transporting the unit to a new site.

The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

Contents in this chapter

3-1
3-2
3-3
3-4
3-5
3-6
3-7
3-8

OVEIVIBW. .« . 3-1
Setup Reminders . . ... .. 3-2
Receiving and Unpacking the Equipment. . . ... ... ... .. ... i 3-4
Preparing for Setup. . . . . ... 3-10
Completingthe Setup. . .. ... 3-13
Configuring the LOGIQ Fortis. . .. .. .. e 3-35
CoNNECtiVIty . .. 3-54
Setting Up Paperwork. . ... ... 3-55
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Section 3-2
Setup Reminders

Contents in this section

3-2-1 Average setup time . . . ... 3-2
3-2-2 Setup Warnings . . . . ... 3-2
3-2-1 Average setup time
Table 3-1 Average Setup Time
AVERAGE SETUP
DESCRIPTION TIME COMMENTS
UNPACK THE LOGIQ Fortis 0.5 HOUR
SET UP THE LOGIQ Fortis (without OPTIONS) 4 HOURS DEPENDENT ON THE CONFIGURATION
CONFIGURE DICOM NETWORK 2 HOURS OR MORE | DEPENDENT ON THE CONFIGURATION
INSTALL INSITE 0.5 HOUR
3-2-2 Setup warnings
/) DANGER WHEN USING ANY TEST INSTRUMENT THAT IS CAPABLE OF OPENING THE
AC GROUND LINE (FOR EXAMPLE, THE METER’S GROUND SWITCH IS OPEN),
DO NOT TOUCH THE LOGIQ FORTIS!
/\ DANGER DO NOT WEAR THE ESD WRIST STRAP WHEN YOU WORK ON LIVE CIRCUITS
AND MORE THAN 30V PEAK IS PRESENT.
/A DANGER TO PREVENT ELECTRICAL SHOCK, CONNECT THE LOGIQ FORTIS TO A
PROPERLY GROUNDED POWER OUTLET. DO NOT USE A THREE-TO-TWO
PRONG ADAPTER. THIS DEFEATS SAFETY GROUNDING.
A CAUTION DO NOT OPERATE THE LOGIQ FORTIS UNLESS ALL BOARD COVERS AND FRAME PANELS
ARE SECURELY IN PLACE. LOGIQ FORTIS PERFORMANCE AND COOLING REQUIRE THIS.
cAUTION NEVER REVERSE POLARITY ON ANY METER THAT INTERCEPTS THE POWER CORD WITH
& POWER CONNECTED TO THE LOGIQ Fortis.
EVEN IN THE OFF STATE, REVERSING POLARITY ON THE POWER CAN SERIOUSLY DAMAGE
THE POWER SUPPLY.
& CcAUTION IF THE LOGIQ FORTIS IS VERY HOT OR COLD, ALLOW THE TEMPERATURE TO STABILIZE
BEFORE POWERING UP. FOR GUIDELINES ON REACHING OPERATIONAL TEMPERATURES
FROM STORAGE OR TRANSPORT TEMPERATURES, SEE 2-2-1 "LOGIQ Fortis environmental
requirements" on page 2-2.
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3-2-2 Setup warnings (cont’d)

& CAUTION OPERATOR MANUAL(S)

THE USER MANUAL(S) SHOULD BE FULLY READ AND UNDERSTOOD BEFORE OPERATING
THE LOGIQ FORTIS AND KEPT NEAR THE LOGIQ FORTIS FOR QUICK REFERENCE.

A CAUTION ACOUSTIC OUTPUT HAZARD
ALTHOUGH THE ULTRASOUND ENERGY TRANSMITTED FROM THE LOGIQ FORTIS PROBE IS
WITHIN AIUM/NEMA STANDARDS, AVOID UNNECESSARY EXPOSURE. ULTRASOUND
f ENERGY CAN PRODUCE HEAT AND MECHANICAL DAMAGE.
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Section 3-3
Receiving and Unpacking the Equipment

Contents in this section

3-3-1 Purpose of thissection . . ... . . . . 3-4
3-3-2 Receiving and unpacking warnings. . . .. ... ... . 3-4
3-3-3 Tilt Watch Indicator . . . .. ... 3-5
3-34 Transportation box label . .. ... .. .. . . . . 3-6
3-3-5 Receiving the LOGIQ Fortis . . . .. ... e 3-7
3-3-6 Unpacking the LOGIQ Fortis. . . .. ... e 3-8
3-3-7 Packing materials - recycling information . . . ......... .. ... .. .. L 3-9
3-31 Purpose of this section

This section describes how to receive and unpack the LOGIQ Fortis.

3-3-2 Receiving and unpacking warnings
A CAUTION TWO PEOPLE ARE NEEDED TO UNPACK THE LOGIQ FORTIS BECAUSE OF ITS
WEIGHT.

ATTEMPTS TO MOVE THE LOGIQ FORTIS CONSIDERABLE DISTANCES OR ON AN
INCLINE BY ONE PERSON COULD RESULT IN INJURY OR DAMAGE OR BOTH.

TWO PEOPLE ARE REQUIRED WHENEVER A PART WEIGHING 16 KG (35 LBS) OR
MORE MUST BE LIFTED.

& CAUTION REMEMBER TO USE RELEVANT PERSONAL PROTECTING EQUIPMENT (PPE) DURING
PACKING/UNPACKING. CHECK WITH YOUR LOCAL EHS REPRESENTATIVE.
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3-3-3

3-3-341

Tilt Watch Indicator

Improper handling during transportation may harm the equipment inside the package even if the
package itself is undamaged.

To make it easier to detect if the handling during transportation has been improper, a set of Tilt Watch
Indicator have been attached to the transportation box.
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Figure 3-1 Tilt Watch Indicator (example)

If Tilt Watch Indicator has triggered or is missing

The purpose of the Tilt Watch Indicator label is to alert people handling a product that it is sensitive to
tipping and it must remain upright at all times. It is basically an active “Up Arrow” that changes color if
the package is tipped 89 degrees or more from horizontal. These labels can be false activated if tipped
less than 89 degrees, and shocked or vibrated at the same time. This event does occur, but is
considered uncommon. If a package is received with an activated Tilt Watch Indicator label, there is high
degree of certainty it tipped 89 degrees or more from horizontal during shipment.

An activated Tilt Watch Indicator label does not indicate if the package was simply “Tipped” (laid down
with no impact shock) or “Tipped Over” (free fall, with an impact shock). Using both shock indicator
labels and Tilt Watch Indicator labels will help identify if a Tip Over impact shock occurred.

Table 3-2 Tilt Watch Indicator has triggered or is missing

Step Task

If the Tilt Watch Indicator is missing:

1 Note on the shipping papers at the time of receipt that the Tilt Watch Indicator label is missing.
' If the Tilt Watch Indicator has triggered:

Note on the shipping papers at the time of receipt that the Tilt Watch Indicator label was activated.

2. Inspect the product for possible concealed damage.
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3-3-3-2 Position of the Tilt Watch Indicators
Before cutting the straps, check the indicator to make sure they have not been triggered. If damaged,
report it to the carrier. If not, then cut the straps around the crate.

The Tilt & Shock indicators have been attached to the transportation box as illustrated in the figure
below.

3-3-4 Transportation box label

Figure 3-2 Transportation box label

Table 3-3 LOGIQ Fortis Transportation Box Labeling

SYMBOL DEFINITION SYMBOL DEFINITION

RECYCLING TOP, UPRIGHT - Transportation FRAGILE, Handle with
Recyclable Wood and Storage Care

¢ 4
B AT
E DO NOT STACK . E KEEP DRY. /Y Thermal management
(protect from moisture)

ATE -~ BT I Slerage
.~ 90 In Trammperintion

hir Pressure Range of Air Pressure RECYCLING
700~1060hPa 9 Recyclable Wood
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3-3-5

Receiving the LOGIQ Fortis

Improper handling during transportation may harm the equipment inside the package even if the
package itself is undamaged.

Examine package

Examine package closely at time of delivery.

Damage in transportation

Follow this procedure if damage is apparent:

Table 3-4 Damage in Transportation
STEP TASK
1. Write “Damage In Shipment” on ALL copies of the freight or express bill BEFORE delivery is accepted or “signed
for“ by a GE representative or hospital receiving agent.
2. Take pictures of any damage to the packaging and the LOGIQ Fortis. These pictures will be needed if a claim
against the carrier is applied.
3.

Report the damage to the carrier.

*  Whether noted or concealed, damage MUST be reported to the carrier immediately upon discovery, or in
any event, within 14 days after receipt, and the contents and containers held for inspection by the carrier.

»  Atransportation company will not pay a claim for damage if an inspection is not requested within this 14 day

period.
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3-3-6 Unpacking the LOGIQ Fortis

The instruction manual describes the best method for unpacking the LOGIQ Fortis ultrasound scanning
unit. Images are ONLY for reference; wear proper PPE when handling packaging (gloves, safety shoes,

etc....).
Table 3-5 Unpacking Procedure
Step Task Corresponding graphic
1. Cut the straps around the crate.
2. Remove the top cover.
3.
Remove three P-Joint, then remove the out sleeve.
4. Remove the option box.
5. Carefully remove foam packing material and plastic bag
from the ultrasound unit and monitor
6.
Remove the box bottom assy.
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Table 3-5 Unpacking Procedure

Step Task Corresponding graphic

Unlock the casters and align the orientation of the 4 caster's
direction (refer to 4-3-3 "Brakes and direction lock functional
checks" on page 4-15) and then using the incline plane of

the box bottom assy., slowly move the system from the box.

Note: Place all of the filling inside the Transportation Box. Close the box, and store the filling for possible future use.

3-3-7 Packing materials - recycling information
The packing materials for the LOGIQ Fortis are recyclable:

» The transportation box is made of cardboard.

» Lever locking (hinges) is made of zinc plated steel.

» The inner reinforcements are made of Ethafoam (Polyethylene foam).
» The plastic wrap is made of LDPE (Low Density Polyethylene).
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Section 3-4

Preparing for Setup

Contents in this section
3-4-1 Verify customer order . . .. ... . 3-10
3-4-2 Physical inspection . . ... ... .. e 3-10
3-4-3 Location of Multi Caution label and rating label ... ......... .. ... .. ... .. ....... 3-11
3-4-4 EMI protection. . . ... .. 3-12

3-4-1 Verify customer order
Compare items received by the customer to what is listed on the delivery order. Report any items that
are missing, back ordered, or damaged.

3-4-2 Physical inspection
Verify that the LOGIQ Fortis arrived intact (visual inspection). If the LOGIQ Fortis has been damaged,
see 3-3-5 "Receiving the LOGIQ Fortis" on page 3-7.
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3-4-3 Location of Multi Caution label and rating label

Figure 3-3 Multi Caution Label

Figure 3-4 Rating Label (OPIO arm)
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3-4-3 Location of Multi Caution label and rating label (cont’d)
Figure 3-5 Rear Cover Label
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3-4-4 EMI protection

The LOGIQ Fortis has been designed to minimize the effects of Electro-Magnetic Interference (EMI).

Many of the covers, shields, and screws are provided primarily to protect the LOGIQ Fortis from image
artifacts caused by this interference. For this reason, it is imperative that all covers and hardware are

installed and secured before the LOGIQ Fortis is put into operation.

See 2-2-3 "EMI limitations" on page 2-6 for more information about EMI protection.
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Section 3-5
Completing the Setup

3-5-1

3-5-2

Contents in this section

3-5-1
3-5-2
3-5-3
3-5-4
3-5-5
3-5-6
3-5-7
3-5-8
3-5-9
3-5-10
3-5-11
3-5-12
3-5-13
3-5-14
3-5-15
3-5-16

Purpose of thissection. . .................
LOGIQ Fortis specification verification. . . . . ..
Electrical specification verification .. ........
Connections onthe rear /O panel ..........
Connections on the patient I/O panel . .. ... ..
Connectingprobes . . . ............ . ... ...
Poweron/bootup ........... ... .. ... ....
Default security level . ...................
Password policies. . .....................
USers . ...

Purpose of this section

This section describes how to complete the set up of LOGIQ Fortis.

LOGIQ Fortis specification verification

Verification of the LOGIQ Fortis requirements

+ Verify that the site meets the requirements listed in (see Section 2-3 "Facility Needs" on page 2-9).

»  Verify that the specifications (physical dimensions, mass, and acoustic noise output) below do not
conflict with any on-site conditions.

Physical dimensions

* Height: 1250 - 1800 mm, 49 - 71 in (HDU display), 1210 - 1760 mm, 48 - 69 in (LCD Monitor)

*  Width: 530mm, 20.9 inch (Caster), 545mm, 21.5 inch (LCD Monitor), 565mm, 22.2 inch (HDU
display)

*  Depth: 885mm, 34.8 inch

*  Weight: 85 kg (187.4 Ib.)

Acoustic noise output

The acoustic noise output is less than 48 dB(A) at 20 degrees Celsius at a distance of 1 meter at all four
sides and 1 meter above the floor.
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3-5-3

& CAUTION

Electrical specification verification

CONNECTING A LOGIQ FORTIS TO THE WRONG VOLTAGE LEVEL WILL MOST LIKELY

DESTROY IT.

Verification of the LOGIQ Fortis voltage setting

Verify that the mains voltage specified for the LOGIQ Fortis is available on-site.

The voltage setting for the LOGIQ Fortis is found on the rating label on the back of the LOGIQ Fortis on

the lower rear frame.

Figure 3-6 Rating Label - LOGIQ Fortis

“ GE ULTRASOUND KOREA, Ltd.

100-240V~, 50/60Hz, 900-900VA

M 202001

SIS, MEDICAL-

E355835

9, Sunhwan-ro 214beon-gil, Jungwon-gu,
SEONGNAM-SI, GYEONGGI-DO, Republic of Korea

LOGIQ Fortis HDU

501 123456789 [Ton) (01/00000000000000
uﬁ (11)000000(21)000000000

ULTRASOUND EQUIPMENT AS TO ELECTRICAL
SHOCK, FIRE AND MECHANICAL HAZARDS ONLY IN

C US ACCORDANCE WITH ANSI/AAMI ES60601-1:2005/[RI2012
AND A1:2012, C1:2009/RI2012 AND A2:2010/[RI2012

CSA CAN/CSA-C22.2 NO. 60601-1:14

LOGIQ Fortis
121kg
6601000
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3-5-4

NOTE:

Connections on the rear I/O panel

Accessory equipment connected to the analog and digital interfaces must be certified according
to the respective IEC standards (e.g. IEC60950-1 or IEC62368-1 for data processing
equipment and IEC60601-1 for medical equipment). Furthermore, all complete configurations
shall comply with the valid version of the LOGIQ Fortis standard IEC60601-1-1. Everybody who
connects additional equipment to the signal input part or signal output part of LOGIQ Fortis,
configures a medical system, and is therefore responsible that the LOGIQ Fortis complies with
the requirements of the valid version of IEC60601-1-1. If in doubt, consult the technical service
department or your local representative for GE.

Connect Ethernet

Connect the Ethernet cable to the Ethernet connector on the external I/O (rear side of LOGIQ Fortis).

Figure 3-7 1/0 Rear Panel

1.) USB 3.0 Port
2.) Ethernet connector (RJ-45 modular, 8-pin)

3.) S-Video Option (NTSC (720x480i, 60Hz) and
PAL (720x576i, 50Hz))

4.) HDMI Port (1920x1080 is the only supported
resolution)

Connect USB Flash Drive

For information, see “USB Hard Disk Drive and USB Flash Drive” in Chapter 9 of the LOGIQ Fortis Basic
User Manual (latest revision).
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3-5-5

3-5-6

& CAUTION

NOTE:

& CAUTION

& CAUTION

Connections on the patient I/O panel
Connect ECG

For information on the ECG, see “Patient Cardiac and ECG Connections” in Chapter 3 of the Basic User
Manual (appropriate version).

Connecting probes

Probes can be connected at any time, whether the LOGIQ Fortis is on or off.

DO NOT CONNECT A PROBE WHILE THE LOGIQ FORTIS IS POWERING UP.

The LOGIQ Fortis has four DLP probe ports (Figure 3-8). This is the only type of probe port on the
LOGIQ Fortis

Figure 3-8 Probe Connectors, Four DLP Probe Ports

To connect a probe:

It is not necessary to turn OFF power to connect or disconnect a probe. However, it is a good
idea to select a different probe or to freeze the image when removing a probe to avoid
disconnecting a live probe.

DO NOT ALLOW THE PROBE HEAD TO HANG FREELY. EXCESSIVE IMPACT TO THE PROBE
WILL RESULT IN IRREPARABLE DAMAGE.

KEEP THE PROBE CABLES AWAY FROM THE WHEELS.
DO NOT BEND THE PROBE CABLES.
DO NOT CROSS CABLES BETWEEN PROBES.

1.) Before connecting the probe:

a.) Perform a visual check of the probe and LOGIQ Fortis sockets.

b.) Remove any dust or foam rests from the probe.

c.) Verify the probe and the probe cable for any visual damage.
2.) Hold the probe connector vertically with the cable pointing upward.
3.) Turn the connector locking handle counter-clockwise to the horizontal position.
4.) Align the connector with the probe port and carefully push into place.
5.) Turn the locking handle clockwise to the full vertical position to lock in place.
6.) Position the probe cable so that it is not resting on the floor.
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3-5-6 Connecting probes (cont’d)

To disconnect a probe:

1.

2)
3)
4)

Select a different probe or freeze the image before removing a probe to avoid disconnecting a live
probe.

Rotate the lock handle counter-clockwise to the horizontal position to unlock the connector.
Remove the connector from the port.

Ensure that the probe head is clean before placing the probe in its storage case. For cleaning
instructions, see “Probe Cleaning Process” in Chapter 11 of the LOGIQ Fortis Basic User
Manual (latest revision).
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3-5-7

A DANGER

& DANGER

A DANGER

& CAUTION

A CAUTION

NOTE:

Power on/boot up

Warnings

ALWAYS CONNECT THE ULTRASOUND SYSTEM TO A FIXED POWER SOCKET
WHICH HAS THE PROTECTIVE GROUNDING CONNECTOR. FAILURE TO
FOLLOW THESE INSTRUCTION COULD LEAD TO ELECTRICAL SHOCK.

NEVER USE A THREE-TO-TWO PRONG ADAPTER; THIS DEFEATS THE
SAFETY GROUND. FAILURE TO FOLLOW THESE INSTRUCTION COULD LEAD
TO ELECTRICAL SHOCK.

ENSURE THAT THE POWER CORD AND PLUG ARE INTACT AND THAT THE
POWER PLUG IS THE PROPER HOSPITAL-GRADE TYPE (WHERE REQUIRED).
FAILURE TO FOLLOW THESE INSTRUCTION COULD LEAD TO ELECTRICAL
SHOCK.

LOGIQ FORTIS REQUIRES ALL COVERS.

ONLY OPERATE THE LOGIQ FORTIS WHEN ALL OF THE BOARD COVERS AND FRAME
PANELS ARE SECURELY IN PLACE. THE COVERS ARE REQUIRED FOR SAFE OPERATION,
GOOD PERFORMANCE AND COOLING PURPOSES.

USE ONLY POWER SUPPLY CORDS, CABLES, AND PLUGS PROVIDED BY OR DESIGNATED
BY GE.

Do not cycle the circuit breaker ON-OFF-ON in less than five seconds. When turning OFF the
circuit breaker, WAIT until the ON/OFF button is no longer lit. The LOGIQ Fortis should de-
energize completely before turning the circuit breaker ON.
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3-5-7

NOTE:

Power on/boot up (cont’d)

Connect AC (mains) power to the LOGIQ Fortis

Connecting AC power to the LOGIQ Fortis involves preliminary checks of the power cord, voltage level
and compliance with electrical safety requirements.

The LOGIQ Fortis will function on voltages from 100-240 volts and 50 or 60 Hz. However, if
using 220 volt power, then a center tapped power source is required (North America Only).

1.) Ensure that the wall outlet is of appropriate type, and that the circuit breaker is turned off.
2.) Uncaoil the power cable, allowing sufficient slack so that the LOGIQ Fortis can be moved slightly.
3.) Verify that the:

- power cable is without any visible scratches, any sign of damage or tangled.

- on-site mains voltage is within the limits indicated on the rating label near the circuit breaker
on the rear of the LOGIQ Fortis.

4.) Connect the female plug of the power cable to the power inlet at the rear of the LOGIQ Fortis.

5.) Verify that the mains power circuit breaker is in OFF position, If not, switch it to OFF.
Figure 3-9 Circuit Breaker

6.) Connect the other end (male plug) of the power cable to a hospital grade mains power outlet with
the proper rated voltage, and the LOGIQ Fortis is ready for power ON/boot up.
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3-5-7 Power on/boot up (cont’d)
Switch ON the AC power to LOGIQ Fortis

1.) Switch ON the circuit breaker at the rear of the LOGIQ Fortis. The ON/OFF button turns white.
Figure 3-10 ON/OFF Button

You should hear a click from the relays in the AC power and the LOGIQ Fortis is ready to boot. This
indicates that there is power to the PS, but the LOGIQ Fortis is OFF.

2.) Press once on the ON/OFF button on the Operator Panel to boot the LOGIQ Fortis. The ON/OFF
button turns blue when it is pressed.

During a normal boot, you may observe that:

a.) The ventilation fans start on full speed, but slow down after a few seconds (listen to the fan).
b.) Power is distributed to the peripherals, operator panel, monitor, front end and back end.
c.) Back end and rest of the LOGIQ Fortis starts with the sequence listed in the next steps:

1.) Back end is turned ON and starts to load the software.

2.) The Start screen is displayed on the monitor.

3.) A start-up bar indicating the time used for software loading, is displayed on the monitor.
4.) The software initiates and sets up the front end electronics and the rest of the instrument.
5.) The backlight in the keyboard is lit.

6.) As soon as the software has been loaded, either a B-Mode screen is displayed on the
screen, indicating that a probe has been connected, or a No Mode screen is displayed,
indicating that no probe has been connected.

NOTE: Total time used for start-up is typically less than 170 seconds.

After the B-Mode screen is displayed and any function is touched, the LOGIQ Fortis will prompt a
password protected Login.
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3-5-8

NOTE:

Default security level

The Default Security Level dialog box displays when the software is initially installed and whenever the
software is reloaded. When the ADM user logs onto the LOGIQ Fortis, the password level dialog will
display. This dialog will display every time the ADM user logs on until a level selection is made. If they
make a selection and then reload software, the level will be cleared and they will need to select the level
again.

To set the login security level:

» After boot up, log in as ADM (no password required) and, when prompted, select Lowest for the
security level.

Select the Lowest security level and then continue with installation and testing.

After installation and testing is complete, transfer the LOGIQ Fortis to the Site Administrator who can
reset the security level for the site.

The security level can be reset through Utility > Admin > Logon.

Refer to “Initial Login to the LOGIQ Fortis® in the Basic User Manual (latest revision) for more
information.

Figure 3-11 Default Security Level Dialog Box

Apply Changs
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3-5-9 Password policies

To create password policies:

1.) Navigate to Utility > Admin > Logon.
2.) Select Enable Password Policies. The LOGIQ Fortis prompts the user for a password at logon.

Figure 3-12 Policies Window

Policies

User Name Policies

Password Policies

3.) Under Password Policies, use the drop down selection beside each feature to set the rules for
passwords.
4.) Click Save.
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3-5-10

NOTE:

NOTE:

NOTE:

Users

See the Basic User Manual (appropriate version) for more information.
To add users:

1.) Navigate to Utility > Admin > Users.

2.) Select Add and enter the user details.

You will need to edit the ID field from NewUser default. Do not push “Add” again until adding
another user.

Touch Keyboard is available with User Defined Key. Please use it if you need to type any texts.

DO NOT include the following characters in a user ID: slash (/), dash (-), asterisk (*), question mark (?),
an underscore (_), ampersand (&), or blank spaces. Also, DO NOT set up Users with the same
initials/signifier.

3.) Enter password using the defined policies.

4.) If needed, select User Must Change Password. The user will be prompted to change the
password on the next logon.

5.) Under Group Membership, select the groups for the new user.

The user password is system specific. If the user needs to access multiple systems the
password will need to be entered manually on each system.

Figure 3-13 Users Window

6.) Allow the system administrator to specify whether the user account is active, blocked or requires a
password change.

7.) Allow the system administrator to remove a user by highlighting the user ID, selecting Remove to
mark the user as inactive, and then selecting Remove again to remove user from the list.
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3-5-11

NOTE:

Groups
To use groups:

You can use predefined groups or create new groups. Assign groups to a user from Users and under
Group Memberships.

1.) Navigate to Utility > Admin > Groups.
Figure 3-14 Groups Window

T

2.) To use a pre-defined group:
a.) Under Group List, select from the list of groups with pre-determined access is available to
select for each new user.

b.) To view access rights for these groups, highlight a group and then, under Group Rights, view
the access rights.

3.) To create a new group and assign access rights:

a.) Select Add.

b.) Under Name and Description, type in the name and a description.

c.) Under Group Rights, select the boxes according to the users access needs.
d.) Select Exit and then select Admin before trying to assign new groups to a user.

Admin has full system access rights.

Section 3-5 - Completing the Setup



GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

3-5-12

NOTE:

Lock out and log on

To set lock out and log on:

1.) Navigate to Utility > Admin > Logon.
Figure 3-15 Logon Window
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2.) Under Policies, select Enable Session Timeout.

3.) Under Password Policies, in Session Lock Screen Timeout, select the system idle time for
timeout (lock screen) in minutes. The screen will appear completely black when locked (timeout).

4.) Click Save.

5.) Press or move any button/trackball on the operator panel to display Login window.

6.) On the Login window, enter the user ID, enter the password, and then select Ok.
The user will have access according to the rights in their assigned group.

To set auto logon:

Auto LOGON only works when password policies are disabled and if there is no password assigned to
the user.

1.) Navigate to Utility > Admin > Logon.
2.) Select Auto Logon. The LOGIQ Fortis will start by using the ID of the last operator.

Auto LOGON only works when password policies are disabled and if there is no password assigned
to the user.
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3-5-13

Disk encryption

The LOGIQ Fortis supports full disk encryption. Both system partition and user partitions can be
encrypted. GE requires the SSD (System partitions) to be encrypted to protect Intellectual property and
safe system performance. The SSD (Patient archive) can be encrypted or decrypted based on user
preference. GE highly recommends to keep Encryption on/automatically unlocked at the minimum to
ensure privacy and security.

Encryption OFF (Initialize System Encryption not selected)

This is how the Disk Encryption tab appears when first opened and before any initialization has
been selected. (after a software installation).

Figure 3-16 Encryption OFF (Initialize System Encryption not selected)

Measure Report Scan Assistant Managelmaging Preset Managel DiékEriéry'pt

Initialize System Encryption

yption ¢

These are the values for the encryption fields:

- Conversion status: Fully decrypted (data drives)
- Protection status: Unprotected (data drives)

- System Drives: 0%

- Data Drives: 0%
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3-5-13 Disk encryption (cont’d)
Encryption OFF
1.) Select Initialize System Encryption.
2.) Select Choose Encryption Policy and set it to Encryption OFF. This only affects data drives.

3.) View System Drive as it continues to encrypt up to 100%.
This is how the Disk Encryption tab appears once initialization and a policy has been selected.

Figure 3-17 Disk Encryption - Encryption OFF

These are the values for the encryption fields (The % values are examples and will not always
display as shown):

- Conversion status: Fully decrypted (data drives)

- Protection status: Unprotected (data drives)

- System Drives: 19% - once initialized, the SSD drive will be encrypted.

- Data Drives: 0% - once initialized, the use data drive will be encrypted. If the encryption policy
is changed to OFF, the data drive will be unencrypted.
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3-5-13 Disk encryption (cont’d)
Encryption Suspended

NOTE: Suspend is a service only option. SSA or Class M is required. If SW reload is initiated from the
Class A/Class C CSD the suspension happens automatically but there is no way to manually
trigger it without service options/key.

1.) Once Initialize System Encryption has started, encryption can be suspended on the data drives
if needed.

2.) Select Choose Encryption Policy and set it to Encryption Suspended.

This is how the Disk Encryption tab appears once initialization has been selected and encryption
has begun, but the policy has been changed to suspend encryption.

Figure 3-18 Disk Encryption - Encryption Suspended

Audit Report

These are the values for the encryption fields (The % values are examples and will not always
display as shown):

- Conversion status: Encryption in progress (data drives)

- Protection status: Unprotected (data drives)

- System Drives: 47%

- Data Drives: 3%
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3-5-13 Disk encryption (cont’d)
Encryption ON. Disks are unlocked automatically

1.) Select Initialize System Encryption.

2.) Select Choose Encryption Policy and set it to Encryption ON. Disks are unlocked
automatically.

This is how the Disk Encryption tab appears once initialization and a policy has been selected and

encryption has been to run through completion.

Figure 3-19 Disk Encryption - Encryption ON

These are the values for the encryption fields:

- Conversion status: Fully encrypted (data drives)
- Protection status: Protected (data drives)

- System Drives: 100%

- Data Drives: 100%
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3-5-13 Disk encryption (cont’d)
Encryption Suspended after encryption

This is how the Disk Encryption tab appears once initialization and a policy has been selected and
encryption has been to run through completion, but has then been suspended.

Figure 3-20 Disk Encryption - Encryption Suspended

These are the values for the encryption fields:

Conversion status: Fully encrypted (data drives)
Protection status: Unprotected (data drives)
System Drives: 100%

- Data Drives: 100%
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3-5-14

A

NOTICE

NOTE:

Login

At login, you are notified that “You are accessing a diagnostic medical device that is provided by
authorized usage only. Data stored on this device may be subject to various regulations including but
not limited to regulations which govern disclosure and privacy of this data. By using this device you are
acknowledging that you are authorized to do so and are trained in appropriate use and regulatory
guidelines.”

The System Administrator manages system groups, users, and permissions. After you have been
added as a valid user, the System Administrator assigns you a temporary password. When you log into
the LOGIQ Fortis for the first time, you will be prompted to change your password.

Touch Keyboard pop-ups automatically when edit boxes are focused. Please use it if you need
to type any texts.

Figure 3-21 Login Window

Current User

After you have established your password, follow these steps to login.

1.) Type your user name in the Operator field.

2.) Type your password in the Password field.

3.) Press OK to login, or Cancel to cancel login.

You can change the password when first logging onto the LOGIQ Fortis.
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3-5-14 Login (cont’d)
To change your password:

1.) In Operator, enter your name.
2.) Select Change Password. The Change Password dialog box displays.

Figure 3-22 Change Password Dialog Box

Change Password

Cancel

3.) Type the following:
- Password: Type your current password.
- New Password: Type your new password.
- Confirm Password: Retype your new password.
4.) Press OK to confirm your changes, or Cancel to cancel your changes.
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3-5-15 Logoff/Power shut down

You can use the SYSTEM - EXIT menu to log off, shut down, and exit.

1.) Press once on the ON/OFF button on the operator panel to display the SYSTEM - EXIT menu.
2.) Select Logoff to logoff the system, select Shutdown to shutdown the system.

Table 3-6 SYSTEM - EXIT Menu

Corresponding Graphic

The SYSTEM - EXIT menu, used when switching OFF the LOGIQ Fortis, gives you these
choices:

Logoff:

Use this button to log off the current user.

The Ultrasound system remains ON and ready for a new user to log on.

If the Logoff button is dimmed, it indicates that no user is logged on to the LOGIQ Fortis at the
moment.

Shutdown:

Use this button to shut down the Ultrasound system. The entire system will shut down. It is
recommended to perform a full shutdown at least once a week.

If the Shutdown button is dimmed, press the ON/OFF button or Alt+F10 to shut down the
LOGIQ Fortis.

Cancel:

Use this button to exit from the SYSTEM - EXIT menu and return to the previous operation.
Exit (Only available when logged in as GE Service with an SSA key):

Select this button when you want to exit to the Windows desktop.

Change Password

Exit

S ks
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3-5-16 Complete power down

1.) Press once on the ON/OFF button on the operator panel to display the SYSTEM - EXIT menu
2.) Select Shutdown to do a complete power down of the LOGIQ Fortis.

The back end will first turn off the LOGIQ Fortis activity and print the message “Please wait -
Shutdown in progress” in the display on the operator panel.

Next, it starts to shut down. The time to turn down the LOGIQ Fortis, including the back end, may
vary from 10 seconds up to approximately 1 minute.

The last thing that shuts down, is the light on the operator panel, indicating that you can continue
with the next step.

/\ WARNING RISK OF LOSING DATA. BE SURE TO WAIT UNTIL THE LOGIQ FORTIS HAS FINISHED
ITS SHUT-DOWN. FAILING TO DO SO MAY CORRUPT DATA ON THE HDD, MAKING
THE LOGIQ FORTIS FAIL.

3.) Switch off the Mains Power Circuit Breaker, located on the rear of the LOGIQ Fortis. This will cut
power distribution within the LOGIQ Fortis.
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Section 3-6
Configuring the LOGIQ Fortis

Contents in this section
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After completing configuration, the next step is to control/adjust connectivity settings starting with

Section 3-7 "Connectivity"” on page 3-54.

3-6-1 Purpose of this section

This section describes how to configure the LOGIQ Fortis.

3-6-2 LOGIQ Fortis configuration

For complete instructions, see the appropriate version of the LOGIQ Fortis Basic User Manual or LOGIQ

Fortis Release Notes.
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3-6-3 Optional peripherals/peripheral connection

Approved internal peripherals (optional)

This list covers the internal peripherals available for the LOGIQ Fortis. All of these internal peripherals
should be connected already when the LOGIQ Fortis is delivered.
» 4D Option

+  CW Option

*  Volume Navigation (V Nav) Option

» Patient /O ECG Option

» Printer (Digital Graphic) Option

» Power Assistant Option

» Scan on Battery Option

»  Pencil CW Option

+  S-Video Option

*  Wireless LAN Option

Approved external peripherals (optional)

This list covers the external peripherals available for the LOGIQ Fortis. The external printers are network
DICOM devices. The inkjet printer is USB connected.

*  Customer-supplied USB Flash Drives/Hard Drives

»  Color Inkjet Printer

+ USB Hard Disk Drives

* Report Printer

+ Footswitch

+ DICOM Printers

* Rolling Volume Navigation Stand

*  Option Tray

*  Probe Holder Option

Additional information

See Section 9-15 "Options" on page 9-25 for replacement units.
Printer checks

Check to see if the printer works as described in Table 3-7.

Table 3-7 Peripheral Checks

Step Task Note

1. |Press Freeze. Stops image acquisition.

5 |Press (Print 1), (Print 2), (Print 3) or (Print 4) |Prints image displayed on the screen on a black and white or color
" |on the control panel. printer, depending on the key assignment configuration.
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3-6-4

NOTE:

Software options configuration
Software option installation

A password (Software Option String) enables a software option or a combination of software options.
This password is specific for each LOGIQ Fortis.

Installing a software option
Before you install a software option, you must login.

After you have established your password, follow these steps to login.

1.) Type your user name in the Operator field.
2.) Type your password in the Password field.

3.) Press OK to login, or Cancel to cancel login.
Figure 3-23 Login Window

Current User

4.) From the touch panel, select Utility > Admin > System Admin.
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3-6-4 Software options configuration (cont’d)

5.) Enter the new option key code in the SW Option Key section.
Figure 3-24 System Admin Window - Add Button

6.) Select the Add button.

A CAUTION INCORRECT PASSWORD ENTRY WILL RESULT IN LOSS OF SYSTEM OPTIONS.
IF PASSWORD IS INCORRECT, PLEASE CONTACT YOUR LOCAL GE SERVICE
REPRESENTATIVE OR THE ONLINE CENTER.

7.) Import the Option String from the media.
Figure 3-25 SW Option Import

SW Option Import

Option keys file can be imported from Media (CD/DVD,
USB) or the Service Folder.

There is an Import button on the Utility > Admin >
System Admin menu.

Cancel

8.) Press Save to save the new setting.
9.) Restart to save and activate the settings and adjustments you have done so far.
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3-6-5

NOTE:

Breast Assistant and Thyroid Assistant, Powered by Koios DS

Breast Assistant, Powered by Koios DS

In LOGIQ Fortis, integration with Breast Assistant, Powered by Koios DS is available. Breast Assistant,
Powered by Koios DS is a breast lesion diagnostic assessment tool and is an option.

Some options are not available in all areas.

Breast Assistant, Powered by Koios DS is integrated with the LOGIQ Fortis through DICOM and is
configured similar to a DICOM service. The user can accept/reject analysis results. If accepted, these
results are included in DICOM Structured Reporting. These are the related HCATSs for the Breast
Assistant, Powered by Koios DS option:

H4919KO - This required HCAT allows the activation of Koios communication on a compatible
scanner (LOGIQ Fortis, for example), with this option the scanner can communicate with the Koios
Medical software/application which is installed on the network.

H4919KI - This required HCAT allows for the installation and configuration of the Koios web server
on a customer networked virtual machine. The installation is performed by Koios Medical and is
required for accessing Koios capabilities from a compatible scanner (Breast Assistant on the
LOGIQ Fortis, for example.) and/or a compatible PACS system.

In addition, one of the following is required:

H4919S0 — This optional HCAT to use Breast Assistant, Powered by Koios DS on the
LOGIQ Fortis only. This catalog item is for the initial term of a subscription to the Koios
software (breast lesion diagnostic assessment tool) which automatically renews annually.
The subscription provides access from compatible Ultrasound scanners (Breast Assistant on
LOGIQ Fortis, for example). Koios manages the activation of the subscription on the Koios
web server installed on a customer networked virtual machine.

H4919SP — This is the HCAT to use Breast Assistant, Powered by Koios DS with PACs.
This catalog item is for the initial term of a subscription to the Koios software (breast

lesion diagnostic assessment tool) which automatically renews annually. The subscription
provides access from compatible ultrasound scanners (Breast Assistant on the

LOGIQ Fortis, for example) and compatible PACS systems. Koios manages the activation of
the subscription on the Koios web server installed on a customer networked virtual machine.
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3-6-5

NOTE:

Breast Assistant and Thyroid Assistant, Powered by Koios DS (cont’d)

Thyroid Assistant, Powered by Koios DS

In LOGIQ Fortis, integration with Thyroid Assistant, Powered by Koios DS is available. Thyroid
Assistant, Powered by Koios DS is a thyroid lesion diagnostic assessment tool and is an option.

Some options are not available in all areas.

Thyroid Assistant, Powered by Koios DS is integrated with the LOGIQ Fortis through DICOM and is
configured similar to a DICOM service. The user can accept/reject analysis results. If accepted, these
results are included in DICOM Structured Reporting. These are the related HCATSs for the Thyroid
Assistant, Powered by Koios DS option:

H4920KT - This required HCAT allows the activation of Koios communication on a compatible
scanner (LOGIQ Fortis, for example), with this option the scanner can communicate with the Koios
Medical software/application which is installed on the network.

H4921KY - This required HCAT allows for the installation and configuration of the Koios web server
on a customer networked virtual machine. The installation is performed by Koios Medical and is
required for accessing Koios capabilities from a compatible scanner (Thyroid Assistant on the
LOGIQ Fortis, for example.) and/or a compatible PACS system.

In addition, one of the following is required:

H4921TL — This optional HCAT to use Thyroid Assistant, Powered by Koios DS on the
LOGIQ Fortis only. This catalog item is for the initial term of a subscription to the Koios
software (thyroid lesion diagnostic assessment tool) which automatically renews annually.
The subscription provides access from compatible Ultrasound scanners (Thyroid Assistant on
LOGIQ Fortis, for example). Koios manages the activation of the subscription on the Koios
web server installed on a customer networked virtual machine.

H4919TP — This is the HCAT to use Thyroid Assistant, Powered by Koios DS with PACs.
This catalog item is for the initial term of a subscription to the Koios software (thyroid

lesion diagnostic assessment tool) which automatically renews annually. The subscription
provides access from compatible ultrasound scanners (Thyroid Assistant on the

LOGIQ Fortis, for example) and compatible PACS systems. Koios manages the activation of
the subscription on the Koios web server installed on a customer networked virtual machine.
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3-6-5 Breast Assistant and Thyroid Assistant, Powered by Koios DS (cont’d)
Checklist for Breast Assistant and Thyroid Assistant, Powered by Koios DS

Use Table Table 3-8 to determine the steps needed to set up, test, and check the Breast Assistant and
Thyroid Assistant, Powered by Koios DS options.

For more information, refer to "Koios DS Configuration" in the Basic User Manual (appropriate version).

Table 3-8 Checklist for the Breast Assistant/Thyroid Assistant, Powered by Koios DS Option

Topic

Steps

Notification of the LOGIQ Fortis with Breast
Assistant, Powered by Koios DS or Thyroid
Assistant, Powered by Koios DS.

Confirm that the Breast Assistant, Powered by Koios DS or Thyroid Assistant,
Powered by Koios DS option is installed in the customer network.

Confirm the option is enabled on the
LOGIQ Fortis.

Navigate to Utility > Admin > System Admin and enter the option string (if not
already present) to enable the option.

Set up and test the Breast Assistant,
Powered by Koios DS or Thyroid Assistant,
Powered by Koios DS connection.

1. For a new installation contact your commercial project leader or your
Applications leader in the region to confirm that the system is ready to be set
up for Breast Assistant, Powered by Koios DS or Thyroid Assistant, Powered
by Koios DS. Do not proceed until obtaining that confirmation. If this is a set
up after reloading the software and assuming that the system was already set
up for Breast Assistant, Powered by Koios DS or Thyroid Assistant, Powered
by Koios DS, this step is not necessary.

2. Navigate to Utility > Connectivity > Koios.

3. In IP Address, enter the IP address for the Koios DS server.

4. Select Activate. You will receive notification that you have successfully

connected to the Koios DS server and the required device, service, and
printflows will be automatically created.

5. In the confirmation dialog box, select Ok.

6. Navigate to Utility > Connectivity > Device and ping the Koios DS server
to confirm that the connection was successful.

7. Navigate to Utility > Connectivity > Service and ping the
Koios_Assessment service to confirm that the service is running.

Create an image.

Confirm that the results are received. Refer to the Basic User Manual (appropriate version) for complete instructions.

Perform the functional tests for Koios.
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3-6-6 Imaging Insights
In LOGIQ Fortis, a log file for Imaging Insights has been added. Enabling Imaging Insights appends
analytics information to DICOM images and, at the end of each exam, creates a summary DICOM
object. The Imaging Insights log file uses common data format (CDF) logging and is sent to the DICOM
server and then on to the back office through an autofile transfer.
To access Imaging Insights, navigate to Utility > Connectivity > Miscellaneous.
Figure 3-26 Miscellaneous > Imaging Insights
TCPIP Davice Sarvic Button Removable Media Miscellaneous Tricafy
Print and Sto
Exit Search Cancel
This table shows all the elements available under Imaging Insights with descriptions.
Table 3-9 Imaging Insights
Element Description
Store incremental analytic data in each Determines whether analytics information is appended to individual DICOM
image images. Default value is enabled.
Determines whether consolidated analytics data [Between exam start and end
Send consolidated analytic data to server or data collected for a time period] that will get sent to the configured DICOM
server (Connectivity >Device Image Storage Server). Default value is disabled
Time duration (in hours) that elapses before the collected consolidated
Trigger interval outside an exam (hours) analytics data is sent to the selection made in Server (normally configured on
99 Connectivity > Device as the Image Storage Server). These are the valid
values available are OFF, 1,2,3,5. Default value is OFF.f
Name of the DICOM server. This server is located on premise at the hospital
and parses the DICOM tags to provide the customer with Clinical Performance
Server Management insights.
The DICOM server is configured as a device on Connectivity > Device. All of
the configured devices are available except MyComputer. Default value is “-“.
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3-6-6 Imaging Insights (cont’d)
To configure Imaging Insights:

1.) Navigate to Utility > Connectivity > Device and add a DICOM device.

2.) Navigate to Utility > Connectivity > Service and add a DICOM Storage service and Modality
Performed Step service against the added DICOM device.

3.) Save and exit the configuration.

4.) Navigate to Utility > Connectivity > Miscellaneous.
5.) Enable Imaging Insight.

6.) Enable Imaging Insight Service

7.) Trigger interval as appropriate.

8.) In Imaging Insights Server, select the device configured for DICOM image store and DICOM
Performed Procedure services.

9.) Save the configuration.
10.)Reboot the LOGIQ Fortis.
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3-6-7

NOTE:

Device Management (Device Mgmt)

Device Mgmt is a way to back up and restore presets to and from the back office. Use Device Mgmt to
do the following:

+ Send presets from the LOGIQ Fortis to the back office (using Manual Backup)

+ Send presets from the LOGIQ Fortis to the back office (using Backup Automatically)

+ Send presets from the LOGIQ Fortis to the back office (using Upload For Fleet)

» Restore presets from the back office to the LOGIQ Fortis (using Download from the tool bar)

These timeout fields (editable when Device Mgmt is active) were added:
- Upload/Download Timeout (sec)
- Query Timeout (sec) - This is a query for Device management updates.

The support email has been updated to: dc.support@ge.com.

For more information, refer to the Basic User Manual (appropriate version).

To access Device Connect, navigate to Utility > Connectivity > Device Mgmt.

Figure 3-27 Device Management (Device Mgmt)
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3-6-7 Device Management (Device Mgmt) (cont’d)

This table shows all the elements available on Device Mgmt with descriptions.

Table 3-10 Device Management

Element Description

Indicates whether Device Management is active or not. Valid values are
Inactive or Active.

Status NOTE: This field will be Inactive only the right after the Activate was failed.
Otherwise the field will be empty. if you never activated or activated and then
deactivated, this field will be empty.

Account Email Email address for the Device Management account.

Registration key for the Device Management account. Product specific key

Registration Key strings, pre-populated by the device (can be overwritten if necessary).

URL of registration server strings, pre-populated by the device (can be

Server URL ) .
overwritten if necessary).

Name of the proxy server IP provided by the customer. This field is optional

Proxy Server unless required by the customer facility infrastructure.

Number of the proxy server port provided by the customer. This field is optional

Proxy Port unless required by the customer facility infrastructure.

Name of the proxy user provided by the customer. This field is optional unless

Proxy User Name required by the customer facility infrastructure.

Password for the proxy user name provided by the customer. This field is

Proxy Password optional unless required by the customer facility infrastructure.

Runs for the set number of seconds when the upload, (Auto Backup, Manual
Backup, and Upload for Fleet) or download (Install) operation begins. When the
timeout occurs, an error displays indicating you should attempt the operation
again.

Upload/Download Timeout (sec)

For Device Management updates, runs for the set number of seconds when the
New Patient and End Current Patient, logging off, logging on, or unlocking the
lock screen operations begin. When the timeout occurs, an error displays
indicating you should attempt the operation again.

Query Timeout (sec)

Verify Select to verify a connection with the service.
Activate/Deactivate Select to activate/deactivate Device Management.
Update Connection Configuration Select to update changes made on the Device Mgmt page.

Select to download the certificate for Device Management from the backoffice

Device Management Service Certificate
server.
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3-6-8

NOTE:

GE Backoffice Connectivity

A connection between the LOGIQ Fortis to the GE back office (InSite RSVP) allows for a direct link with
GE Service (either through a GE Online Service Engineer or Applications Support Engineer).

A connection to the back office is only reversible by reloading the base image full load software.

To disable GE back office (InSite RSVP)

When the customer does not want to connect to the GE back office (InSite RSVP), use Disable Remote
Connectivity to uninstall remote connectivity items like Agent Configuration, SSH and Virtual
Console Observation (VCO) from the Service desktop.

To access Disable Remote Connectivity, select Utility (second page) > Service > Utilities > Disable
Remote Connectivity. For more information, refer to Disable Remote Connectivity in "Utilities" on page
7-52.

If the InSite agent is disabled, these are some additional results:

* Remote Connectivity is no longer available.
* Remote service can no longer connect to the LOGIQ Fortis to diagnose system issues.

+ The customer will not be able to initiate a Request for Service or Clinical Support Request using the
GE InSite icon located at the bottom of the monitor display.

To connect to the GE back office (InSite RSVP)
When the customer wants to connect to the GE back office (InSite RSVP), use Agent Configuration.

To access Agent Configuration, navigate to Utility (second page) > Service > Agent Configuration.
For more information, refer to "Agent Configuration" on page 7-82.
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3-6-8

NOTE:

GE Backoffice Connectivity (cont’d)
GE back office (InSite) wizard

In LOGIQ Fortis, there is a GE Backoffice Connectivity Troubleshooting wizard that can be used to set
up a connection to the InSite back office.

You can perform all required functions from this tool. For example, you have to start the agent
from Agent Configuration.

For more information, see the latest revision of the LOGIQ Fortis Basic User Manual.

Figure 3-28 GE Backoffice Connectivity Troubleshooting

/& GE Backoffice Connectivity Troubleshooting

" Agent Configuration

Ensure the CRM Number displayed is cormect. Ifnot, update with the correct CRM and save changes. If the Serial and CRM Numbers are
correct, proceed to next step,
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3-6-9 Service settings
When the InSite agent is activated, you can edit some service settings (shown in Figure 3-29 and
Table 3-11).
NOTE: Ifthe InSite agent is disabled, the Service section will be removed from the System Admin page.

To access Service settings, navigate to Utility > System Admin.

Figure 3-29 System Admin > Service

Service

Enable Automatic Request for Service
Transfer Machine Logs to GE

Transfer Operator Information to GE

Enable Automatic Probe Diagnostics

Transfer Images (captured without patient information) to GE
Include Annotations with Image Transfer to GE

This table shows all the elements available under Service with descriptions.

Table 3-11  Service Settings

Element

Description

Enable Automatic Request for Service

Allows system-generated requests for service to be sent without user
intervention.

Transfer Machine Logs to GE

Allows transfer of monitoring errors and status log files to the GE back office for
data analytics.

Transfer Operator Information to GE

When Transfer Machine Logs to GE is enabled, allows the transfer of
operator information to the GE back office for usage analytics.

Enable Automatic Probe Diagnostics

When Transfer Machine Logs to GE is enabled, allows the VITA Tool to
gather information about probes used and put that information into a VITA
dump file. Once enabled, the VITA routine will run once at system startup to
generate this dump file. The VITA dump file is then transferred to the data lake
like the other log files.

Transfer Images (captured without patient
information) to GE

When Transfer Machine Logs to GE is enabled, allows the transfer of images
for analysis.

Include Annotations with Image Transfer to
GE

Allows transfer of operator information to the GE back office for usage analytics.
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3-6-10 Magstripe card reader
The Magstripe card reader can be used to populate the following:

+ Patient screen: Patient ID, First Name, Last Name, Middle Name, Perf. Physician, Ref. Physician.
»  Worklist: Patient ID, Search String.
* Image Display: Comments (Annotation)

To connect the card reader:

1.) Connect the card reader to any USB port. For example, on the user USB ports on the left side of
the upper operator panel Boot up the Ultrasound system.

2.) Scan the card that comes with the card reader to activate device.

NOTE: Consult the card reader manufacturer’s instructions. This configuration process will vary based
on the card reader model/manufacturer and the keyboard language set on the Ultrasound
system.

Once the configuration process is complete, the card reader is ready to use to start a new patient.

You do not need to repeat this process if software is reloaded, this card reader can be used on any
scanner as long as they have the same keyboard language selection.
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3-6-11 Barcode reader

The barcode reader can be used to populate the following:

+ Patient screen: Patient ID, First Name, Last Name, Middle Name, Perf. Physician, Ref. Physician.
*  Worklist: Patient ID, Search String.

* Image Display: Comments (Annotation)

To connect the barcode reader:

1.) Connect the barcode reader to any USB port. For example, on the user USB ports on the left side
of the upper operator panel (shown below).

2.) Boot up the Ultrasound system.
3.) Scan the bar code that comes with the barcode reader to activate device.

NOTE: Consult the barcode reader manufacturer’s instructions. This configuration process will vary
based on the barcode reader model/manufacturer and the keyboard language set on the
Ultrasound system.

Once the configuration process is complete, the barcode reader is ready to use to start a new
patient.

You do not need to repeat this process if software is reloaded, this barcode reader can be used on
any scanner as long as they have the same keyboard language selection.
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3-6-12

Cable hook direction
Cable hook direction can be changed depending on Customer preference.
With keyboard option,

Loosen
screw

Remove screw and change :
direction of cable hook.
Tighten screws to fix.

Default

Without keyboard option,

Loosen
screw

Remove screw and change
direction of cable hook.
Tighten screws to fix.
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3-6-13 LAN Protection Cable (Option)
NOTE: To prevent claw breakage of LAN cable, use LAN protection cable as below.

If LAN cable is pulled away from the console, the connection will be unplugged first preventing damage
to the LAN connector in the unit.

- L'é'--.'?l a4 r N 2 .}I.' .-‘:‘I..I"u o

Figure 3-30 LAN protection cable

Figure 3-31 LAN cable with protection cable (example)
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3-6-14

NOTE:

Network printers

In R3.x.x, you can add a network printer when logged on to the system as an administrator.

It is solely the customer’s responsibility to determine printer and network settings and
configuration to enable and ensure the specific network printer usage and functionality.

To add a network printer, navigate to Utility > System > Peripherals, and then under Network Printer,
select Add Network Printer.

Refer to “Network Printer” in the Basic User Manual (appropriate version) for more information. See
Section 1-4 "Labels/Icons on the system" on page 1-14 for a list of the available user documentation.

Technical details:

» The only supported driver for the network printer is Microsoft Enhanced Point and Print
Compeatibility driver.

+ Adding a network printer requires the user is logged in with Admin group rights.

* You cannot use the same IP address for two printer names.

+ Adding a network printer logs an event to both the main log and the audit log.
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Section 3-7
Connectivity

NOTE:

3-7-1

If you are new or unfamiliar to connectivity on the LOGIQ Fortis, see “Customizing Your System” in
Chapter 10 of the LOGIQ Fortis Basic User Manual (latest revision) before you continue with the next
descriptions and procedures.

Physical connection

Stand-alone LOGIQ Fortis

No network connection needed.

Sneaker Net environment

No network connection needed.

Wired Ethernet from LOGIQ Fortis to a workstation

For a direct cable connection from the LOGIQ Fortis to a workstation, you will only need a crossover
cable for network use to connect the two units this way.

1.) Connect one end of the crossed network cable to the network connector on the LOGIQ Fortis.

2.) Connect the other end to the network connector to the workstation, see the Workstation Service
Manual.

Connection through a peer-to-peer network
You will need a network switch and one network cable for each unit connected to the switch.
Connection through the hospital network

You will need one network cable to connect the LOGIQ Fortis to a wall outlet on the hospital’s network.
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Section 3-8
Setting Up Paperwork

NOTE:

3-8-1

3-8-2

NOTE:

During and after setup, the documentation (for example, removable medias with

documentation, user manuals, and installation manuals) for the peripheral units must be kept

as part of the original system documentation. This will ensure that all relevant safety and user
information is available during the operation and service of the complete system.

User manual(s)

Check that the correct user manual (or removable media with user manuals) for the software revision
and language of the LOGIQ Fortis is included.

Product locator card/UDI
The product locator card shown may not be the same as the provided product locator card.

The UDI of the medical device must be captured when any work is performed on that device. Refer to
your local procedures on the actual capturing of the UDI.

Figure 3-32 Product Locator Card (Example)

GIB, European Central Admin Product Locator Card
GEHC - Americas Product Locator Cards Asia Service Operation
Mailing Product Locator - W523 XEROX Office N No. 1, Yongchang North Road
Address  P.O. Box 414 VAKUUMTECHNOLOGIAI GEPGYAR Beijing Economic and
Milwaukee, Wl 53201-0414 FOTIUT 141 Technologic Development Area
1046 Budapest Hungary Beijing 100176 China
DESCRIPTION FDA  MODEL REV/ SERIAL
ocP BS ORD
DISTRICT CUSTOMER NO. DATE (MO - DA - YR)
DESTINATION
NAME AND

SHIPMENT

ZIP CODE

46-303268P1 Rev 14

GIB, European Central Admin Product Locator Card
GEHC - Americas Product Locator Cards Asia Service Operation
Maiing  Product Locator - W523 XEROXOffice o No. 1, Yongchang North Road
Address P.O. Box 414 V/}KUEJMTECHNDLOGIAI GEPGYAR Beijing Economic and
= Milwaukee, W1 53201-0414 FOTIUT 141 Technologic Development Area
1046 Budapest Hungary Beijing 100176 China
DESCRIPTION FDA  MODEL REV SERIAL
SYSTEMLTD. ocP BS ORD EMPLOYEE NO.
DISTRICT ROOM DATE (MO-DA-YR)
CUSTOMERNO

INSTALLATION &

2IP CODE

46-303268P1 Rev 14
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Chapter 4
Functional Checks

Section 4-1
Overview

4-1-1 Purpose of this chapter

This chapter provides procedures for quickly checking major functions of the LOGIQ Fortis Ultrasound
system and diagnostic instructions using the built-in service software.

NOTE: The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

4-1-2 Contents in this chapter
4-1 OV BIVIBW. . . o 4-1
4-2 General Procedures . . .. ... e 4-3
4-3 Functional Checks . .. ... . . e 4-11
4-4 SIte LOg - 4-32
4-1-3 Special equipment required

This is the special equipment you may need to complete functional checks:

*  An empty (blank) DVD-R disk.

» At least one probe (ideally you should check all of the site probes that will be used with the
Ultrasound system.) For available probes, see Section 9-14 "Probes" on page 9-20.

+ Ifthe ECG option is present, ECG cables (AHA or IEC) and pads. For part numbers, see Section 9-
15 "Options" on page 9-25.

» Test phantom. See 4-1-4 "Recommended test phantoms” on page 4-2.
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4-1-4 Recommended test phantoms

GE recommends the RMI 430GS phantom is preferred, but it is not required. It is the most current
phantom recommended to our field service personnel and provides the necessary targets and extended
life necessary for consistent Ultrasound system testing.

Figure 4-1 Performance Tests
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Section 4-2
General Procedures

Contents in this section

4-2-1 General safety information . . . ... . 4-4
4-2-2 General system functional checks ... ........ . . .. ... . .. 4-5
4-2-3 Power ON/BOOt Up . . . ..o e 4-7
4-2-4 Power shut down . .. ... 4-10
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4-2-1

General safety information

Table 4-1 Energy Control and Power Lockout for LOGIQ Fortis

Preparations - you must perform the following steps

& DANGER

LOCKOUT

Risk of dangerous voltage within the LOGIQ Fortis.

Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.

To avoid potentially hazardous voltage when servicing the LOGIQ Fortis, do the following:
¢ Plan and prepare for shutdown.

e Completely power down the LOGIQ Fortis.

¢ Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
e Apply lockout/tagout devices to maintain exclusive control of the power cable.
¢ Relieve all potentially hazardous stored or residual energy (batteries).

e Verify isolation.

For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:

e 1-7-2-1"Power down the LOGIQ Fortis" on page 1-26.

e 1-7-2-2 "Disconnect Power to the LOGIQ Fortis" on page 1-27.

¢ "Disconnect battery power" on page 1-28.

La

/\ DANGER Risk of electrical shock, system must be turned off.
Avoid all contact with electrical contacts, conductors and components. Always use non-conductive han-
dles designed for the removal and replacement of ESD sensitive parts. All parts that have the potential for
é storing energy must be discharged or isolated before making contact.
& CAUTION |THE ULTRASOUND SYSTEM REQUIRES ALL COVERS.
Operate the LOGIQ Fortis only when all board covers and frame panels are securely in place. The
covers are required for safe operation, good system performance and cooling purposes.
cAuUTION |Risk of damage to equipment.
A DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE NECESSARY ESD PRE-

CAUTIONS:

1. ALWAYS CONNECT YOURSELF. THE ESD WRIST STRAP SHOULD BE CONNECTED TO ONE OF THE TWO
RECEPTICALS INTEGRATED ON THE FRAME, SPECIFICALLY FOR THAT PURPOSE.

2. FOLLOW GENERAL GUIDELINES FOR HANDLING OF ELECTROSTATIC SENSITIVE EQUIPMENT.
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4-2-2

NOTE:
NOTE:

General system functional checks

After setting up the Ultrasound system, performing an upgrade, or replacing hardware, perform all
appropriate functional checks before returning a system to the customer. Include the functional check
information in the service dispatch.

For a service call with FRU replacement:

» Perform the functional checks and include the debrief script found at the end of the respective
replacement procedure in Chapter 8.

For a service call with no FRU replacement or when installing the LOGIQ Fortis:
+ Perform the following general functional tests. If all are successful, include the debrief script
provided below.

Some procedures are used more often than others. The intention with this section is to keep the most
used procedures in one place.

In case of replacing hardware, refer to related section in Chapter 8.

NOT ALL functional checks will have to be repeated or performed if not all options are present.
If ONLY a particular option is present, perform the functional checks for that particular option
and the options installed.

Table 4-2 General System Functional Checks

See
Section Functional Check Debrief Script

4-2-3  |Power ON/Boot Up

4-3-8 B-Mode functional checks

4-3-10 |System CFM and PWD functional checks

4-3-20 |Basic measurement functional checks

10-6-7  |Grounding continuity

10-6-8 |Chassis leakage current test

Power shut down
4-2-4  |DO NOT POWER SHUT DOWN until ALL
functional checks have been performed

Leakage Current measured at (record the value) and meets

In addition: Perform the following functional checks if the |allowable limits. Equipment passed all required checks and is
option was or options were removed during backplane ready for use.
replacement.

4D

4-3-23 |4D option functional checks
Perform a 4D sweep

Pedof CW

4-3-14 |PW/CW Doppler mode functional checks
use pencil probes

GCw

4-3-15 |CW Doppler mode functional checks
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Table 4-2 General System Functional Checks (Continued)
See
Section Functional Check Debrief Script
VSIO (ECG)
ECG Checks
Active ECG:
Utility > Applications > Settings > ECG >
Show ECG Tools.
4-3-22 | Connect cables. Press Display ECG Tab on
TP. Verify ECG signal displayed on monitor.
Plug in the ECG cables with nothing attached | Leakage Current measured at (record the value) and meets
so they pick up noise. allowable limits. Equipment passed all required checks and is
Diagnostics ready for use.
Power Assistant/
4-3-25 |Power Assistant functional checks
V Nav
4-3-24 |Volume Navigation with inside probe functional

checks
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4-2-3

A DANGER

& DANGER

A DANGER

& CAUTION

& CAUTION

NOTE:

Power ON/Boot Up

Warnings

ALWAYS CONNECT THE LOGIQ FORTIS TO A FIXED POWER SOCKET WHICH
HAS THE PROTECTIVE GROUNDING CONNECTOR.

NEVER USE A THREE-TO-TWO PRONG ADAPTER; THIS DEFEATS THE
SAFETY GROUND.

ENSURE THAT THE POWER CORD AND PLUG ARE INTACT AND THAT THE
POWER PLUG IS THE PROPER HOSPITAL-GRADE TYPE (WHERE REQUIRED).

LOGIQ FORTIS REQUIRES ALL COVERS.

ONLY OPERATE THE LOGIQ FORTIS WHEN ALL OF THE BOARD COVERS AND FRAME
PANELS ARE SECURELY IN PLACE. THE COVERS ARE REQUIRED FOR SAFE OPERATION,
GOOD PERFORMANCE, AND COOLING PURPOSES.

Use only power supply cords, cables, and plugs provided by or designated by GE.

Do not cycle the circuit breaker ON-OFF-ON in less than five seconds. When turning OFF the
circuit breaker, WAIT until the ON/OFF button is no longer lit. The LOGIQ Fortis should de-
energize completely before turning the circuit breaker ON.
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4-2-3

NOTE:

Power ON/Boot Up (cont’d)

Connect AC (mains) power to the LOGIQ Fortis

Connecting AC power to the LOGIQ Fortis involves preliminary checks of the power cord, voltage level,
and compliance with electrical safety requirements.

The LOGIQ Fortis will function on voltages from 100-240 volts and 50 or 60 Hz. However, if
using 220 volt power, then a center tapped power source is required (North America Only).

1.) Ensure that the wall outlet is of appropriate type, and that the circuit breaker is turned off.
2.) Uncaoil the power cable, allowing sufficient slack so that the LOGIQ Fortis can be moved slightly.
3.) Verify that the:

- power cable is without any visible scratches, any sign of damage or tangled.

- on-site mains voltage is within the limits indicated on the rating label near the circuit breaker
on the rear of the LOGIQ Fortis.

4.) Connect the female plug of the power cable to the power inlet at the rear of the LOGIQ Fortis.

5.) Verify that the mains power circuit breaker is in OFF position, If not, switch it to OFF.
Figure 4-2 Circuit Breaker

6.) Connect the other end (male plug) of the power cable to a hospital grade mains power outlet with
the proper rated voltage, and the LOGIQ Fortis is ready for power ON/boot up.
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4-2-3 Power ON/Boot Up (cont’d)
Switch ON the AC power to LOGIQ Fortis

1.) Switch ON the circuit breaker at the rear of the LOGIQ Fortis. The ON/OFF button turns white.
Figure 4-3 ON/OFF Button

You should hear a click from the relays in the AC power and the LOGIQ Fortis is ready to boot. This
indicates that there is power to the PS, but the LOGIQ Fortis is OFF.

2.) Press once on the ON/OFF button on the Operator Panel to boot the LOGIQ Fortis. The ON/OFF
button turns blue when it is pressed.
During a normal boot, you may observe that:

a.) The ventilation fans start on full speed, but slow down after a few seconds (listen to the fan).
b.) Power is distributed to the peripherals, operator panel, monitor, front end and back end.
c.) Back end and rest of the LOGIQ Fortis starts with the sequence listed in the next steps:

1.) Back end is turned ON and starts to load the software.

2.) The Start screen is displayed on the monitor.

3.) A start-up bar indicating the time used for software loading, is displayed on the monitor.
4.) The software initiates and sets up the front end electronics and the rest of the instrument.

5.) The backlight in the keyboard is lit.

6.) As soon as the software has been loaded, either a B-Mode screen is displayed on the
screen, indicating that a probe has been connected, or a No Mode screen is displayed,
indicating that no probe has been connected.

NOTE: Total time used for start-up is typically less than 170 seconds.

After the B-Mode screen is displayed and any function is touched, the LOGIQ Fortis will prompt a
password protected Login.
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4-2-4 Power shut down

When you switch OFF the LOGIQ Fortis, the Ultrasound system performs an automatic shutdown
sequence.

1.) Press once on the ON/OFF button on the operator panel to display the SYSTEM - EXIT menu.
2.) Select Shutdown to shutdown the system..

Table 4-3 SYSTEM - EXIT Menu

Corresponding Graphic

The SYSTEM - EXIT menu, used when switching OFF the LOGIQ Fortis, gives you these
choices:

Logoff:

Use this button to log off the current user.

The Ultrasound system remains ON and ready for a new user to log on.

If the Logoff button is dimmed, it indicates that no user is logged on to the LOGIQ Fortis at the
moment.

Shutdown:

Use this button to shut down the Ultrasound system. The entire system will shut down. It is
recommended to perform a full shutdown at least once a week.

If the Shutdown button is dimmed, press the ON/OFF button or Alt+F10 to shut down the
LOGIQ Fortis.

Cancel:

Use this button to exit from the SYSTEM - EXIT menu and return to the previous operation.

Exit (Only available when logged in as GE Service with an SSA key): —

Select this button when you want to exit to the Windows desktop.
S ks

Change Password

4-2-5 Complete power down

1.) Press once on the ON/OFF button on the operator panel to display the SYSTEM - EXIT menu
2.) Select Shutdown to do a complete power down of the LOGIQ Fortis.
The back end will first turn off the LOGIQ Fortis activity and print the message “Please wait -
Shutdown in progress” in the display on the operator panel.

Next, it starts to shut down. The time to turn down the LOGIQ Fortis, including the back end, may
vary from 10 seconds up to approximately 1 minute.

The last thing that shuts down, is the light on the operator panel, indicating that you can continue
with the next step.

& NOTICE Risk of losing data. Be sure to wait with the next step until the LOGIQ Fortis has finished its shut-down.
Failing to do so may destroy data on the hard disk drive, making the LOGIQ Fortis fail later.

3.) Switch off the Mains Power Circuit Breaker, located on the rear of the LOGIQ Fortis. This will cut
power distribution within the LOGIQ Fortis.
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4-3-1 Top console adjustment control functional checks

& CAUTION To avoid injury or damage, make sure nothing is within the range of motion before moving the

top console. This includes both objects and people.

Table 4-4 Top Console Adjustment Controls

Step

Corresponding Graphic

& CAUTION

console. This includes both objects and people.

To avoid injury or damage, make sure nothing is within the range of motion before moving the top

To SWIVEL the top console:
Press and hold down the SWIVEL button to move the console left or
right.

Release the button.

To RAISE/LOWER the top console:
Press and hold the Up/Down button accordingly to raise or lower the
top console.

Release the button when the top console is at the desired height.
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4-3-2 Main monitor positions and lock functional checks

To perform the function checks for the main monitor:

*  When the monitor arm lock is unlocked, verify the monitor can move up/down (vertically) and left/
right (horizontally).

NOTE: The monitor can move approximately 150 mm (5.91 inches) vertically and
350 mm (13.78 inches) horizontally from center.

Figure 4-4 Main Monitor Positions - Ergotron Arm

Tilt
a. No Collision
1. | Vertical Travel = 150mm 4. |p. Approximately 20°
(based on Pan Arm Off-set)
c. 85°-90°

5 Monitor Translation = 350mm

2. i = 9n° o
Rotation at Mount = 90° (180° total) (both sides from center)

3. |Lift Arm Rotation = 135° (270° total) 6. |Pan Arm Rotation = 45° (90° total)

Chapter 4 Functional Checks 4-13



GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

4-3-2  Main monitor positions and lock functional checks (cont’d)

To check main monitor platform maneuverability:

Check that the main monitor functions as described below.

Table 4-5 Main Monitor Platform Maneuverability Checks

Step Task Note(s)

Use both hands, one at the top of the main monitor and one at the bottom, to rotate

1. Tilt the main monitor forward/back the screen forward and back.

Use both hands, one at the lower left handle hold of the main monitor and one at the

2 Move the main monitor leftright lower right handle hold, to adjust the screen left and right.

To unlock the main monitor:

*  Turn the knob clockwise to unlock the main monitor. The main monitor can be moved freely in all
directions.

To lock the main monitor:

»  Turn the knob counter clockwise to lock the main monitor in the parked position.
To set the main monitor position for transport:

* Lock the arm and tilt the main monitor down.
Figure 4-5 Main Monitor Transport Position
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4-3-3 Brakes and direction lock functional checks

Examine the wheels frequently for any obvious defects that could cause them to break or bind.

Each wheel has an independent brake pedal. A left rear wheel also has a swivel lock.

Figure 4-6 Wheel lock and Swivel lock

1.) Brake pedal
2.) Swivel lock

4-3-3-1 Brake pedal

Figure 4-7 Front and right-rear caster

1.) Step on Lower side pedal to activate Brake
2.) Step on Upper side pedal to release Brake
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Figure 4-8 Left-rear caster

1.) Step on to activate Brake
2.) Raise up to release Brake

4-3-3-2 Swivel lock

Figure 4-9 Rear-left with Swivel lock

1.) Step on Lower side pedal to activate Swivel Lock with clicking sound
2.) Step on Lower side pedal to De-activate Swivel Lock

NOTE: Wheel needs to be straight when you activate Swivel Lock.

Figure 4-10 Caster position for Swivel lock
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4-3-4

4-3-5

Alphanumeric keyboard functional checks

To perform the function checks for the alphanumeric keyboard:

1.) Press Comment on the operator control panel to activate Comment.
2.) Type any comments using alphanumeric keys to confirm keyboard functionality.

Footswitch functional checks

1.) Plug in the footswitch.

2.) Select Utility > Application. Under Footswitch, you should see the footswitch programming
options for Left, Middle, and Right.

3.) Program the left, middle, and right footswitch pedals for Freeze.
4.) Scan and use each footswitch pedal to freeze and unfreeze to confirm each one works.

Figure 4-11 Footswitch Functional Checks

Template Pharmacological 4x4

ECG
ShowECGTab B
ECGlead 2 »

ELASTO
Show Quality Bar @
Show Quality Graph (restart needed) Off
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4-3-6

O hrWN =

Probe Holder and Cable Management 7.

Touch Panel and Joystick controls 8. Steer/Width/Depth/Reverse
On Screen Keyboard (not display in this graphic) 9

User Defined Keys. 1

Mode/Gain/XYZ (3D) Controls

Trackball, Trackball Keys, Pointer, Measure, Comment, Body Pattern, Clear, Zoom,

Basic control functional checks

Different functions can be assigned to the basic controls depending on the current active mode. The
trackball area consist of the following:

Controls are grouped together by function for ease of use.

L/R, Start/Stop, P1, Simultaneous

. Auto, CF/PW Auto Positioning
0. Freeze, P2

Programmable Keys
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4-3-7 Probe/connector functional checks
NOTE: Probes can be connected at any time, whether the LOGIQ Fortis is ON or OFF.
For information about connecting a probe, see 3-5-6 "Connecting probes" on page 3-16.
To perform the function checks for a probe/connector:
Table 4-6 Probe and Connector Functional Checks
Step Task Expected Result(s)
1. i i - i
Select the appropriate connected probe from the probe indicators on The plrobe actlvates_, in the currently-selected operating mode. The
probe's default settings for the mode and selected exam are used
the Touch Panel. -
automatically.
2. Launch the application.
To change application without changing the current probe, press THE | The selected application starts.
DESIRED MODE on the Operator Panel.
3. Verify no missing channels. All channels is functioning.
4. Verify there is no EMI/RFI or artifacts specific to the probe. No EMI/RFI or artifacts.
5. Test the probe in each active connector slot. It will displav pictorial data each time
See Section 3-5-6 "Connecting probes" on page 3-16. play p '
6. Repeat this procedure for all available probes.

Probes requiring a leakage test

If the probe requires a leakage test, see Section 10-6 "Electrical Safety Tests" on page 10-20.
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4-3-8

B-Mode functional checks
B-Mode is the Ultrasound system’s default mode.

For information on the Ultrasound system’s different modes as well as expected results, see Chapter 5
of the LOGIQ Fortis Basic User Manual (latest revision), or the appropriate LOGIQ Fortis Release
Notes. See 1-4-1 "Label Location" on page 1-14.

Figure 4-13 B-Mode Screen Example

Depending on probe availability, choose the preset application shown below. The LOGIQ Fortis probes
are ONLY approved for use in the applications listed in Chapter 11 of the LOGIQ Fortis Basic User
Manual (latest revision), or the appropriate LOGIQ Fortis Release Notes.

IQC preset for Service is available

Image Quality Check (IQC) is intended to facilitate image quality checks during quality assurance
evaluations. Quality assurance tests are used to determine whether a scanner is providing the same
level of performance year after year.

By using the same settings year after year, this ensures that the data collection is consistent
independently of who performs the test.

This preset only includes fundamental settings for B-Mode.
Processing modes like SRI, Harmonics, etc., are turned off.
To do an Image Quality Check (IQC):

1.) Navigate to Utility > Imaging Preset Manager.

2.) Select the probe.

3.) Under Imaging Preset Selections, select Category.

4.) Expand the plus sign in front of IQC for Service.

5.) Select IQC and then the right arrow to assign it to a touch panel key.
6.) Map the IQC to the location you want it to appear on the touch panel.
7.) Select Probe > 1QC.
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4-3-8 B-Mode functional checks (cont’d)

Probe indications for use

See the online Help or Chapter 11 of the appropriate version of the LOGIQ Fortis Basic User Manual.
See 1-4-1 "Label Location" on page 1-14.

Preparations
You may use a phantom (optional) when doing these tests.

1.) Connect one of the probes, to the scanner’s active probe connector.
- See Section 3-5-6 "Connecting probes" on page 3-16 for info about connecting the probes.
- For available probes, see Section 9-14 "Probes" on page 9-20.

2.) Turn ON the scanner. The B-Mode window is displayed (default mode).

3.) If needed, adjust the Brightness and Contrast setting on the monitor (see Section 6-2 "Monitor
Adjustments" on page 6-2).

/\\ WARNING ALWAYS USE THE MINIMUM POWER REQUIRED TO OBTAIN ACCEPTABLE IMAGES
IN ACCORDANCE WITH APPLICABLE GUIDELINES AND POLICIES.

4.) Press B-MODE on the Operator Panel to access B-Mode.

5.) These Image Controls are used to optimize the B-Mode picture:
- Use Gain and TGC controls to optimize the overall image together with the Power control.
- Use Depth to adjust the range to be imaged.

- Use Frequency (move to higher frequencies) or Frame rate (move to lower frame rate) to
increase resolution in image.

- Use Frequency (move to lower frequency) to increase penetration.

- Use the control to optimize imaging in the blood flow regions and make a cleaner, less noisy
image.

- Use Reject controls to reduce noise in the image.
Checks

» Check Width, Frame rate, Frequency. The results of these adjustments must be verified on the
B-Mode sector on the screen.

»  Check Up/Down, Left/Right, B Color Maps and Cineloop. The results of these adjustments must be
verified on the B-Mode sector on the screen.

*  Check Gain, TGC and Depth.

»  Check B-Mode Soft Menu Controls.

*  Check Compress, Contour, Reject and Tilt.
» Check Power and Dynamic Range.
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4-3-9 M-Mode functional checks

For information on the Ultrasound system’s different modes as well as expected results, see the
LOGIQ Fortis Basic User Manual. It will familiarize you with image optimization for B-Mode, M-Mode,
Color Flow, and Doppler.

Table 4-7 B/M-Mode Functions

Control Description

Optimizes image quality and allows user to reduce beam intensity. 10% increments between

Power Output (Acoustic Power) 0-100%. Values greater than 0.1 are displayed.

Controls how echo intensities are converted to shades of gray, thereby increasing the

Dynamic Range adjustable range of contrast.

Selects a level below which echoes will not be amplified (an echo must have a certain

Rejection minimum amplitude before it will be processed).

Temporal filter that averages frames together. This has the effect of presenting a smoother,
Frame Average

softer image.
Colorize Enables gray scale image colorization. To deactivate, reselect a Gray Map.
Gray Map Determines how the echo intensity levels received are presented as shades of gray.
Rotation (Up/Down) Rotates the image by selecting the value from the pop up menu.
Frequency L\rll:(l:lijzr:i?fency mode lets you downshift to probe's next lower frequency or shift up to a higher
Frame Rate/Resolution Optimizes B-Mode frame rate or spatial resolution for the best possible image.
Sweep Speed Changes the speed at which the timeline is swept.

Preparations
You may use a phantom (optional) when doing these tests.

1.) Connect one of the probes, to the scanner’s active probe connector.
- See Section 3-5-6 "Connecting probes" on page 3-16 for info about connecting the probes.

- For available probes, see the online Help or the appropriate version of the LOGIQ Fortis Basic
User Manual. See 71-4-1 "Label Location" on page 1-14.

2.) Turn ON the scanner.
Checks

»  Check Horizontal Sweep, Frequency, and Focus.
» Check Compress, Reject, Power and Dynamic Range.
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4-3-10

4-3-11

4-3-12

4-3-13

System CFM and PWD functional checks

For information on the Ultrasound system’s different modes as well as expected results, the Basic User
Manual will familiarize you with image optimization for B-Mode, M-Mode, Color Flow, and Doppler.

For complete information, see the appropriate version of the LOGIQ Fortis Basic User Manual,
Chapter 5, or the appropriate LOGIQ Fortis Release Notes. See 1-2-5 "Product description” on page 1-
10.

Preparations
You may use a phantom (optional) when doing these tests.
1.) Connect one of the probes, to the scanner’s active probe connector.

2.) Turn ON the scanner.

Color Mode functional checks

Color Flow screens are B- or M-Mode screens with colors representing blood or tissue movement. Color
Flow may be selected both from B-Mode, or from M-Mode, or a combination of these screens.

For more information, see the appropriate version of the LOGIQ Fortis Basic User Manual, Chapter 5,
or the appropriate LOGIQ Fortis Release Notes.

Color B-Mode functional checks

For information, see the appropriate version of the LOGIQ Fortis Basic User Manual, Chapter 5, or the
appropriate LOGIQ Fortis Release Notes.

Color M-Mode functional checks

For information, see the appropriate version of the LOGIQ Fortis Basic User Manual, Chapter 5, or the
appropriate LOGIQ Fortis Release Notes.

* Check Horizontal Sweep, PRF, Baseline, and Invert.

»  Check Variance, Color Maps, and Cineloop.

»  Check Frequency and Acoustic Power.

* Adjust ROL.
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4-3-14

PW/CW Doppler mode functional checks

For information on the Ultrasound system’s different modes, the Basic User Manual will familiarize you
with image optimization for B-Mode, M-Mode, Color Flow, and Doppler.

Doppler is used to measure velocity (most often in blood). Doppler mode can be done with a special
pencil probe or with an ordinary probe. By using an ordinary probe, you can first bring up a B-Mode
picture for navigation purpose and then add Doppler.

Preparations

1.) Connect one of the probes to the scanner.

2.) Turn ON the scanner.

3.) The 2D Mode window is displayed (default mode).

4.) If needed, adjust the display’s Brightness and Contrast setting.

5.) Press PW or CW to start Pulsed Wave Doppler (PW) or Continuous Wave Doppler (CW).

6.) Use the Trackball to select the Area of Interest (Sample Volume) in PW or direction of interest in
Cw.

To adjust the PW/CW Doppler Mode controls:
Adjust the Active mode gain to set the gain in the spectral Doppler area.

» Adjust Low velocity reject to reduce unwanted low velocity blood flow and tissue movement.

* In PW mode, adjust Sample volume to low setting for better resolution, or higher setting to more
easily locate the disturbed flows.

* Adjust the Compress setting to balance the effect of stronger and weaker echoes and obtain the
desired intensity display.

» Adjust Frequency to optimize flow display. Higher setting will improve resolution and the lower
setting will increase the depth penetration.

* Adjust Frame rate to a higher setting to improve motion detection, or to a lower setting to improve

resolution.
NOTE: Frequency and Frame rate settings may affect the Low Velocity Reject.
+ Adjust Power to obtain an acceptable image using the lowest setting possible. This is particularly
important in CW-mode, as the energy duty cycle is 100% (constant).
NOTE: The Doppler Power setting affects only Doppler operating modes.
» Adjust the following settings to further optimize the display of the image.
* Use the Horizontal sweep to optimize the sweep speed.
+ To view signal detail, adjust Scale to enlarge the vertical spectral Doppler trace.
* Use Invert to reverse the vertical component of the spectral Doppler area of the display.
* Use Angle correction to steer the ultrasound beam to the blood flow to be measured.
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4-3-15

CW Doppler mode functional checks

For information on the Ultrasound system’s different modes, the Basic User Manual will familiarize you
with image optimization for B-Mode, M-Mode, Color Flow, and Doppler.

1.) Connect one of the probes to the scanner.

2.) Turn ON the scanner.

3.) The 2D Mode window is displayed (default mode).

4.) If needed, adjust the display’s Brightness and Contrast setting.
5.) Press CW to start Continuous Wave Doppler (CW).

6.) Use the Trackball to select the direction of interest in CW.
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4-3-16

Cineloop functional checks

For complete information, see the appropriate version of the LOGIQ Fortis Basic User Manual,
Chapter 5, or the appropriate LOGIQ Fortis Release Notes. See 1-4-1 "Label Location" on page 1-14.

To activate CINE:

1.) Press Freeze, then roll the trackball to activate CINE.
2.) To start CINE Loop playback, press Run/Stop.

3.) To stop CINE Loop playback, press Run/Stop.

To omit images:

* Roll the trackball to the frame you want to delete and press Omit Image.
To restore images:

» To undo deleting an image from the CINE Loop, press Restore Image.
To move quickly to start/end frame:

1.) Press First to move to the first CINE frame.
2.) Press Last to move to the last CINE frame.
To start frame/end frame:

1.) Turn the Start Frame dial to the left to move to the beginning of the CINE Loop.
2.) Turn the dial to the right to move forward through the CINE Loop.

3.) Turn the End Frame dial to the right to move to the end of the CINE Loop.

4.) Turn the dial to the left to move backward through the CINE Loop.

To adjust the CINE loop playback speed:

» Turn the Loop Speed dial right/left to increase/decrease the CINE Loop playback speed.
To move through a CINE loop frame by frame:

*  Turn Frame by Frame to move through CINE memory one frame at a time.
Checks

»  Check Left Marker, Right Marker, Cycle Select and Number of Cycles.
» Check First, Last Cycle, Select all.
» Adjust Scroll and Cine Speed.
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4-3-17

4-3-18

4-3-19

Removable media functional checks
Refer to Chapter 9 of the appropriate LOGIQ Fortis Basic User Manual.

* Using Removable Media

* Labeling Removable Media

+ Formatting Removable Media

»  Verifying Removable Media

Types of removable media - CD/DVD, USB - flash drive and HDD
Archiving and loading presets

To load presets from removable media:

Refer to Chapter 9 of the appropriate LOGIQ Fortis Basic User Manual.

Installation and setup procedures for peripherals
Refer to 3-6-3 "Optional peripherals/peripheral connection" on page 3-36.

Table 4-8 Printer Functional Check

See Section Functional Test Debrief Script

7-15-1 Test of printers Equipment passed all required tests and is ready for use.
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4-3-20

NOTE:

NOTE:

NOTE:

Basic measurement functional checks
The following instructions assume that you first scan the patient and then press Freeze.

To check Distance and Tissue Depth Measurement:

1.) Press Measure once to display an active caliper.

2.) Move the trackball to position the active caliper at the start point (distance) or the most anterior point
(tissue depth).

3.) Press Set to fix the start point. The LOGIQ Fortis fixes the first caliper and displays a second active
caliper.

4.) Move the trackball to position the second active caliper at the end point (distance) or the most
posterior point (tissue depth).

5.) Press Set to complete the measurement. The Ultrasound system displays the distance or tissue
depth value in the measurement results window.

Before you complete a measurement:

» To toggle between active calipers, press MEASURE.

» Toerase the second caliper and the current data measured and start the measurement again, press
CLEAR once.

* To rotate through and activate previously fixed calipers, turn Cursor Select.

After you complete the measurement, to erase all data that has been measured to this point, but not
data entered onto worksheets, press Clear.

To check Circumference/Area (Ellipse) Measurement:

1.) Press Measure once to display an active caliper.
2.) Move the trackball to position the active caliper.

3.) Press Set to fix the start point. The LOGIQ Fortis fixes the first caliper and displays a second active
caliper.

4.) Move the trackball to position the second caliper.
5.) Turn the Ellipse control; an ellipse with an initial circle shape appears.

Be careful not to press the Ellipse control as this activates the Body Pattern.

6.) Move the trackball to position the ellipse and to size the measured axes (the calipers).
7.) To increase the size, turn the Ellipse control in a clockwise direction.

8.) To decrease the size, turn the Ellipse control in a counterclockwise direction.

9.) To toggle between active calipers, press Measure.

10.)Press Set to complete the measurement. The Ultrasound system displays the circumference and
area in the measurement results window.

Before you complete a measurement:

» To erase the ellipse and the current data measured, press Clear once. The original caliper is
displayed to restart the measurement.

* To exit the measurement function without completing the measurement, press Clear again.
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4-3-20

4-3-21

4-3-22

Basic measurement functional checks (cont’d)

Worksheets

Measurement/Calculation worksheets are available to display and edit measurements and calculations.
There are generic worksheets as well as Application specific worksheets. The worksheets are selected
from the Measurement Touch Panel.

Report Pages

Measurements/Calculations that are included on the worksheet can also be displayed on Report Pages.
Report Pages can be customized to meet the appropriate needs of the user.

Multi image functional checks

1.) Press L to activate a dual screen. The single image is placed on the left side.

2.) Press R. The left side image is freezed and the image displays in the right side.

3.) Press B key to return to the single screen.

4.) Press and hold down L to activate a quad screen. The single image is placed on the upper left.
5.) Press B key to return to the single screen.

ECG functional checks

The ECG capability on this LOGIQ Fortis is intended as a trigger for measurements, but can also be
viewed on the screen.

Parts needed: ECG cable and M5Sc-D
ECG Checks

Table 4-9 ECG Functional Checks

Step Task Expected Result(s)

1. Select Preset, select Cardiac, select Scan.

2. If you do not see the ECG line, select the ECG tab, you
should see selection on touch screen for DISPLAY You should then see the line.
ECG. Select and press.

3. Plug in the ECG cables with nothing attached so you

pick up noise The line should display noise.

4. Connect the ECG harness to the connector on the front | The LOGIQ Fortis displays a straight curve along the bottom
of the Ultrasound system. edge of the image sector on the screen.

5. Connect the three leads to an ECG simulator, or fasten |When connecting, the signal on the screen will be noisy.
the three ECG Pads to your body and connect the three | When the connection is completed, a typical clean ECG signal
leads to respective ECG Pad. is displayed.
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4-3-23

4-3-24

4-3-25

4-3-26

4D option functional checks
Required equipment: 4D Probe (RAB6-D or RIC5-9-D)
To perform the functional checks for 4D:

1.) Connect a 4D probe. Press the [3D/4D] button on the console.

2.) Press the [4D] button on the [Mode] tab. Press the [Visualization] button, then select Render.
3.) Press the [L] key the console to start 4D data acquisition.

4.) To complete the acquisition, press [Freeze] or [R].

Volume Navigation with inside probe functional checks
Required tools: a supported VN probe, Transmitter

1.) Connect a transmitter. Connect a VN probe to any probe ports and select it.
2.) Using a VN probe scan and enable VNAV.

3.) Check the system detects sensor and scans by confirming the appearance of a single quality bar
on the screen.

4.) Move a VN probe towards transmitter. Expected result is that the quality bar gauge shows 4.

Power Assistant functional checks
1.) With the LOGIQ Fortis powered up, verify the “batteries charging” icon displays in the status bar and
the LOGIQ Fortis operates as intended.

2.) Unplug the mains cable from the wall. The LOGIQ Fortis enters Power Assistant upon AC power
loss. There is an initial temporary message saying the LOGIQ Fortis is entering battering mode,
then a message appears, saying the LOGIQ Fortis is “running on battery”.

3.) Plug the mains cable back into the wall power and continue with functional checks.

Scan on Battery functional checks
1.) With the LOGIQ Fortis powered up, verify the “batteries charging” icon displays in the status bar and
the LOGIQ Fortis operates as intended.

2.) Go to Utility -> System->General then make sure "Auto Switch to Power Saving Mode” is 30minutes
and “Freeze When AC is Unplugged” is unchecked like following picture.
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4-3-27

3.) Then the system should be able to be unplugged and remain on for at least several seconds and
plugged back on without shutting down. A message may appear to user with a notification of being
in this mode.

4.) Verify that Scan is continued while the system is unplugged without shutdown.
5.) Reconnect AC power. Verify that the batteries begin charging via the battery status icon.

Shear Wave Elastography (Shear Elasto) functional checks
1.) Select a probe (L2-9-D or C1-6-D).
2.) Select the ELASTO button.

3.) From the touch panel, select the Shear Wave button (if not already selected).
4.) Verify that the Shear Wave button is available.
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Section 4-4
Site Log
Table 4-10 Site Log
DATE SERVICE PERSON PROBLEM COMMENTS
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Chapter 5
Components and Functions (Theory)

Section 5-1
Overview

5-1-1 Purpose of this chapter

This chapter explains LOGIQ Fortis’s Ultrasound system concepts, component arrangement, and
subsystem functions. It also describes the power distribution system. Refer to the LOGIQ Fortis Basic
User Manual (latest revision) for more information.

NOTE: The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

5-1-2 Contents in this chapter
5-1 OVEIVIBW. .« . 5-1
5-2 LOGIQ Fortis Models . . ... ... 5-2
5-3 LOGIQ Fortis DesCription . . . . ...t 5-3
5-4 Software Description. . . .. .. . 5-6
5-5 Service Desktop Description . . ... .. 5-19
5-6 Front End Description. . . ... . . e 5-21
5-7 Back End Description . . . . ... e 5-30
5-8 Backplane Description . .. ... ... e 5-34
5-9 Top Console Description. . . ... ... 5-36
5-10 Power Distribution Description . . . ... ... .. . 5-44
5-11 Cable Connection BEPS - OP .. .. ... . . e 5-48
5-12 Air Flow Distribution . . . . .. ... 5-52
5-13 Casters and Brakes Description. . ... ... .. 5-53
5-14 Options and Peripherals Description .. ........ ... .. ... . . . 5-54
5-15 Product Manuals. . . . ... . e 5-62
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Section 5-2
LOGIQ Fortis Models

Table 5-1 LOGIQ Fortis Software Configuration and Hardware

MODEL NUMBER DESCRIPTION SOFTWARE VERSION
6601000 LOGIQ Fortis LCD monitor CONSOLE, 100-240 VAC R3.x.x
6602000 LOGIQ Fortis HDU Display CONSOLE, 100-240 VAC R3.x.x
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Section 5-3
LOGIQ Fortis Description

5-3-1

5-3-2

Purpose of this section

The purpose of this section is to give you an overview of the LOGIQ Fortis and how it functions.

Contents in this section

5-3-1 Purpose of thissection . . . ... .. 5-3
5-3-2 IntroduCtioNn. . . . .. 5-3
5-3-3 LOGIQ Fortis general description. . . . ... . 5-4
5-3-4 LOGIQ Fortis block diagram. . . . . ... . e 5-5

Introduction

The LOGIQ Fortis Ultrasound system is a high performance digital Ultrasound imaging system with total
data management.

The LOGIQ Fortis provides image generation in B-Mode, Color Doppler, Power Doppler, M-Mode, PW,
4D, Harmonic Imaging, and Contrast imaging applications. The fully digital architecture of the

LOGIQ Fortis Ultrasound system allows optimal usage of all scanning modes and probe types
throughout the full spectrum of operating frequencies.
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5-3-3

LOGIQ Fortis general description

The LOGIQ Fortis is a digital beamforming Ultrasound system. The Ultrasound signal flows from the
probe through the Ultrasound system where it is processed and finally displayed as a diagnostic image
on the monitor. Images and patient data can be sent to peripheral devices to be stored, printed, or
displayed.

System configuration is stored on the hard drive and all necessary software is loaded from the hard drive
on power up.

The LOGIQ Fortis is comprised of the following major components:

+ BEPS (Back end and Power supply)
+ DA192 (Front end, Data Acquisition)
* DPI-L (Probe Interface relay)

*  Operator panel

* Peripherals

+ Options
*  Mechanical Parts
» Software

Section 5-3 - LOGIQ Fortis Description
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5-3-4 LOGIQ Fortis block diagram

The transmitted pulse bursts are routed from the DA192 board to the DPI-L relay board where the
ultrasound probes send the energy into the body. Weak ultrasound echoes from body structures and
blood cells are received by the probes and routed through the DPI-L relay board to the DA192 board.
The DA192 board amplifies the ultrasound signal and connects it with an A/D converter to the digital
domain. The digital signals are then further processed on the back end. The user operates the
Ultrasound system operation through the operator panel which consists of an alphanumeric keyboard,
customized controls, trackball, and a touch panel display. Images and patient data are displayed on the
main monitor.

Figure 5-1 LOGIQ Fortis Block Diagram
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Section 5-4
Software Description

5-4-1 Purpose of this section

This section gives you a brief overview of the software used on LOGIQ Fortis. You can also see the
LOGIQ Fortis Basic User Manual (latest revision) for more information.
Contents in this section
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5-4-2 LOGIQ Fortis base load image and application software

LOGIQ Fortis software consists of:

+ Base load image

- Windows 10 Embedded

- Contains all necessary drivers to support devices and peripherals approved for this product
» Application software

- Contains customized software to perform all functions and features for the LOGIQ Fortis
Software location:

« Software resides in the SSD.
Drive partitions

Table 5-2 Drive Partitions

Partition GB
Drive Type Letter Usage (approximately)
C: Windows 10/application 79
Z: Software Repository 31
SSD D: User settings/configuration 42
E: Database/data 783
V: Future Use 10

Software installation:

» Software can be loaded/reloaded with USB media.
+  System partition (Base+Application) can be reloaded from the Z partition.

»  System partition (Base+Application) can be updated through a remote connection to the Service
Back Office.

Network capabilities:

* LAN is IPv6 ready.
» Can only be set up for IPv4 or IPv6. They cannot be mixed.
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5-4-3

NOTE:

Electronic media

To access and view user documentation through a Windows PC:

1.) Insert the media into the media drive.

2.) Open the media drive on your desktop.

3.) Double click on the ‘gedocumentation.html’ document.

4.) Select the item you want to view (click on the blue, underlined link in the File Name column).
5.) To close the window, click on the ‘X’ in the upper, right-hand corner of the browser window.

If your PC does not have Adobe Reader, a free download is available on the Adobe website at
http.//www.adobe.com.

Section 5-4 - Software Description
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5-4-4

LOGIQ Fortis’s operating modes
B-Mode

B-Mode is a two-dimensional image of the amplitude of the echo signal. It is used for location and
measurement of anatomical structures and for spatial orientation during operation of other modes. In B-
Mode, a two-dimensional cross-section of a three-dimensional soft tissue structure such as the heart is
displayed in real time. Ultrasound echoes of different intensities are mapped to different gray scale or
color values in the display. The outline of the 2D (B-Mode) cross-section is a sector, depending on the
particular transducer used. B-Mode can be used in combination with any other mode.

Harmonic imaging

Tissue Harmonic Imaging, acoustic aberrations due to tissue, are minimized by receiving and
processing the second harmonic signal that is generated within the insonified tissue. LOGIQ
Fortis's high performance Harmonic Imaging provides superb detail resolution and penetration,
outstanding contrast resolution, excellent acoustic clutter rejection and an easy to operate user
interface for switching into Harmonic Imaging mode. Coded Harmonics enhances near field
resolution for improved small parts imaging as well as far field penetration. It diminishes low
frequency amplitude noise and improves imaging technically difficult patients. It may be especially
beneficial when imaging isoechoic lesions in shallow-depth anatomy in the breast, liver and hard-
to-visualize fetal anatomy. Coded Harmonics may improve the B-Mode (2D) image quality without
introducing a contrast agent.

M-Mode

In M-Mode, soft tissue structure is presented as scrolling display, with depth on the Y-axis and time on
the X-axis. It is used primarily for cardiac measurements such as value timing on septal wall thickness
when accurate timing information is required. M-Mode is also known as T-M mode or time-motion mode.
Ultrasound echoes of different intensities are mapped to different gray scale values in the display. M-
Mode displays time motion information of the ultrasound data derived from a stationary beam. Depth is
arranged along the vertical axis with time along the horizontal axis. M-Mode is normally used in
conjunction with a 2D (B-Mode) image for spatial reference. The 2D (B-Mode) image has a graphical
line (M-line) superimposed on the 2D (B-Mode) image indicating where the M-Mode beam is located.
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5-4-4 LOGIQ Fortis’s operating modes (cont’d)

Color flow Doppler mode

Color Doppler is used to detect motion presented as a two-dimensional display. There are three
applications of this technique:

» Color Flow Mode - used to visualize blood flow velocity and direction
*  Power Doppler (Angio) - used to visualize the spatial distribution of blood

A real-time two-dimensional cross-section image of blood flow is displayed. The 2D (B-Mode) cross-
section is presented as a full color display, with various colors being used to represent blood flow
(velocity, variance, power and/or direction). To provide spatial orientation, the full color blood flow cross-
section is overlaid on top of the gray scale cross-section of soft tissue structure (2D (B-Mode) echo).
For each pixel in the overlay, the decision of whether to display color (Doppler), gray scale (echo)
information or a blended combination is based on the relative strength of return echoes from the soft
tissue structures and from the red blood cells. Blood velocity is the primary parameter used to determine
the display colors, but power and variance may also be used. A high pass filter (wall filter) is used to
remove the signals from stationary or slowly moving structures. Tissue motion is discriminated from
blood flow by assuming that blood is moving faster than the surrounding tissue, although additional
parameters may also be used to enhance the discrimination. Color flow can be used in combination with
2D (B-Mode) and Spectral Doppler modes.

Power Doppler

A real-time two dimensional cross-section of blood flow is displayed. The 2D (B-Mode) cross-
section is presented as a full color display, with various colors being used to represent the power in
blood flow echoes. Often, to provide spatial orientation, the full color blood flow cross-section is
overlaid on top of the gray scale cross-section of soft tissue structure (2D (B-Mode) echo). For each
pixel in the overlay, the decision of whether to display color (Doppler power), gray scale (echo)
information or a blended combination is based on the relative strength of return echoes from the
soft-tissue structures and from the red blood cells. A high pass filter (wall filter) is used to remove
the signals from stationary or slowly moving structures. Tissue motion is discriminated from blood
flow by assuming that blood is moving faster than the surrounding tissue, although additional
parameters may also be used to enhance the discrimination. The power in the remaining signal
after wall filtering is then averaged over time (persistence) to present a steady state image of blood
flow distribution. Power Doppler can be used in combination with 2D (B-Mode) and Spectral
Doppler modes as well as with 4D mode.

Pulsed (PW) Doppler

PW Doppler processing is one of two spectral Doppler modalities, the other being CW Doppler. In
spectral Doppler, blood flow is presented as a scrolling display, with flow velocity on the Y-axis and time
on the X-axis. The presence of spectral broadening indicates turbulent flow, while the absence of
spectral broadening indicates laminar flow. PW Doppler provides real time spectral analysis of pulsed
Doppler signals. This information describes the Doppler shifted signal from the moving reflectors in the
sample volume. PW Doppler can be used alone but is normally used in conjunction with a 2D (B-Mode)
image with an M-line and sample volume marker superimposed on the 2-D image indicating the position
of the Doppler sample volume. The sample volume size and location are specified by the operator.
Sample volume can be overlaid by a flow direction cursor which is aligned, by the operator, with the
direction of flow in the vessel, thus determining the Doppler angle. This allows the spectral display to be
calibrated in flow velocity (m/sec.) as well as frequency (Hz). PW Doppler also provides the capability
of performing spectral analysis at a selectable depth and sample volume size. PW Doppler can be used
in combination with 2D (B-Mode) and Color Flow modes.

Section 5-4 - Software Description
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5-4-4 LOGIQ Fortis’s operating modes (cont’d)
Continuous Wave (CW) Doppler
Continuous Wave Doppler systems use two crystals, one to send and one to receive the echoes.
The transmitter inputs a continuous sinusoidal wave. The receiver detects the shift.

An audible sound is created and recorded by either an analog recorder or spectral analyzer. Spectral
analysis separates the signal into individual components and assigns a relative importance.

The benefits of CW Doppler include high sensitivity to low velocities and detection of high velocities
without aliasing. Although CW Doppler cannot distinguish between the sending and receiving signals or
extraneous echoes, nor does CW Doppler produce a precise image like Pulsed Wave Doppler.

Other modes

4D

The LOGIQ Fortis Ultrasound system may be used to acquire multiple, sequential 2D (B-Mode)
images which can be combined to reconstruct a three dimensional image. These 4D images are
useful in visualizing three-dimensional structures, and in understanding the spatial or temporal
relationships between the images in the 2D (B-Mode) sequence. The 4D image is presented using
standard visualization techniques, such as surface or volume rendering.

For more information on Volume Navigation and Contrast Imaging, see the LOGIQ Fortis Basic
User Manual (latest revision).

4D Data Collection and Reconstruction

2D (B-Mode) gray scale images may be reconstructed. The acquisition of volume data sets is
performed by sweeping 2D (B-Mode) scans with special transducers (called 4D-transducers)
designed for the 2D (B-Mode)-scans and the 4D-sweep.

Images are spatially registered, using internal probe position sensing and a position control to
ensure geometric accuracy of the 4D data.

2D (B-Mode) ultrasound imaging modes are used to view a two dimensional cross-sections of parts
of the body. For example in 2D (B-Mode) gray scale imaging, a 2 dimensional cross-section of a 3-
dimensional soft-tissue structure such as the heart is displayed in real time. Typical, the user of an
ultrasound machine manipulates the position and orientation of this 2D (B-Mode) cross-section in

real time during an ultrasound exam.

By changing the position of the cross-section, a variety of views of the underlying structure are
obtained, and these views can be used to understand a 3-dimensional structure in the body.

To complete survey a 3-dimensional structure in the body, it is necessary to collect 2D (B-Mode)
images which span a volume containing the structure. One way is to sweep the imaging cross-
section by translating it in a direction perpendicular to the cross-section. Another example method
is to rotate the cross section about a line contained in the cross section. The LOGIQ Fortis
Ultrasound system uses the automated so called C-Scan for the motion perpendicular to automated
B-scan. Once a representative set of 2D (B-Mode) cross-sections are obtained, standard
reconstruction techniques can be used to construct other 2D (B-Mode) cross-sections, or to view
the collection of the cross-sections as a 4D images.
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5-4-4 LOGIQ Fortis’s operating modes (cont’d)

4D Image Presentation

The basic technique for 4D image presentation is to combine the 2D (B-Mode) cross—sections into
an image which represents how the volume of the data would appear from a particular viewing
direction. The mathematics behind this feature is called 4D-rendering. Such combined images are
called projections, because the data from the volume is projected onto a flat 2-dimensional surface,
e.g. the Ultrasound system display. This technique can be applied to any 2D (B-Mode) ultrasound
mode.

Several techniques can be used to aid the human observer in understanding the resulting 2D (B-
Mode) image as a representation of a three-dimensional object. One is to rotate the volume of data,
and present the resulting sequence of 2D (B-Mode) projections to the observer. The changing
direction of observation helps the observer to separate the features in the volume according to their
distance from the observer.

Volume Navigation

Using a position sensor attached to the probe, Volume Navigation Fusion (V Nav) lets you import a
pre-acquired Ultrasound, CT or MR DICOM volume dataset and register it to the live Ultrasound
image. As a result, you can view live Ultrasound scanning simultaneously with the corresponding
multi-planar reformatted (MPR) slice from the pre-acquired dataset.

In addition, you can use V Nav as a type of “GPS” positioning marker to track an anatomy of interest.

V Nav is available in B-Mode, Color Flow, PDI, and Contrast Modes; it is not available while in
3D/4D or when timeline modes are active. Biopsy capability is available while in V Nav.

Contrast Imaging

The LOGIQ Fortis is designed for compatibility with commercially available Ultrasound contrast
agents. Because the availability of these agents is subject to government regulation and approval,
product features intended for use with these agents may not be commercially marketed nor made
available before the contrast agent is cleared for use. Contrast related product features are enabled
only on Ultrasound systems for delivery to an authorized country or region of use. It is not currently
approved for use in the United States.

Elastography

Elastography shows the spatial distribution of tissue elasticity properties in a region of interest by
estimating the strain before and after tissue distortion caused by external or internal forces. The
strain estimation is filtered and scaled to provide a smooth presentation when displayed.

With Elastography active, the image will show a color map/bar indicating the level of elasticity
detected by the Ultrasound system. The Elastography image is achieved by pulsating the probe
manually while you are scanning the anatomy of interest.

Shear Wave Elastography

With the Shear Wave option, the scanner creates the distortion by generating shear waves in tissue
using a diagnostic ultrasound transducer. Shear waves “push” the tissue at a low frequency in either
a single burst of high amplitude, long duration pulses or a series of such pulses.

UGAP

Ultrasound-Guided Attenuation Parameter (UGAP) measures the attenuation value (i.e.
attenuation coefficient [dB/cm/MHz] or attenuation rate [dB/m]) in the liver to evaluate diffuse liver
disease. There are three visualizations: B Ref, Color Ref and Color Dual. All visualizations measure
a representative attenuation value. Color Ref and Color Dual measure a representative attenuation
value in 2D color map and dual display of B-Mode and 2D color map, respectively.
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5-4-5

Option activation keys

Option keys are a string of characters that activate purchased options and are stored in two different

locations.
BEPS

* Non Volatile RAM
* Primary source
Internal drive

» Stored as a text file under userdefs
+ Can be backed up to CD/DVD/USB
* Can be Imported from Media or from Service folder

Chapter 5 Components and Functions (Theory)



Direction 5874372, Rev. 3

GE CONFIDENTIAL
LOGIQ Fortis Proprietary Service Manual

5-4-6 System password
The system password is the Windows password used by the LOGIQ Fortis to automatically log into the
Windows operating system. This is the password you would use from a locked Windows desktop.
Users of the LOGIQ Fortis will never need to use this password. The only reason to change the
password would be if the user, for security reasons, prefers to define their own password instead of the
factory created default password. As with all passwords, this should be treated with care and archived
appropriately so that it can be provided to service personnel if necessary.
The requirement for this password is a minimum of 15 characters including an uppercase letter and a
special character.
The Windows password is not backed up with system presets.
The procedure to change the system password depends on the software version. These are the
available procedures:
A system administrator can change the password of the underlying Windows user from Utility (first
page) > Admin > System Password.
Figure 5-2 System Password
System Admin Users ogol Groy Disk Encryption Audit Report
To change the system password:
1.) Navigate to Utility (first page) > Admin, and then select System Password.
2.) In System Password, type the current password.
3.) In New Password, type a new password according to the password requirements (minimum 15
characters including one upper cap and one symbol).
4.) In Confirm Password, type the new password.
5.) Select Save.
NOTE: The new password procedure will need to be performed each time the LOGIQ Fortis is
reghosted.
5-14 Section 5-4 - Software Description
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5-4-6 System password (cont’d)
To confirm the new password:

1.) Insert an activated SSA key.
2.) Exit to the Windows desktop.

3.) Press Start with the left Trackpad key and select Command Prompt (Admin).
4.) In the Command Prompt window, type “netplwiz” and then press Enter.

The User Accounts window appears.

User Accounts X
Users  Advanced
‘;} Use the list below to grant or deny users access to your computer,
“E0)  andto change passwords and other settings.
v
Users for this computer:
User Name Group
&} DLSService DBLogAccess; Administrators; Us...
&) GEAdmin Administrators
&2 GEService Administrators; Users
Ll ichiro Administrators
& SV CService DBLeogAccess; Administrators; Us...
Password for Ichiro
“2 To change your password, press Ctrl-Alt-Del and select Change
Password.
oy

Chapter 5 Components and Functions (Theory) 5-15



GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

5.) In the User Accounts window, do the following:

a.) Check the Users must enter a user name and password to use this computer box.
b.) Under Users for this computer, select “Ichiro”.

c.) Uncheck the Users must enter a user name and password to use this computer box.
d.) Press OK. The Automatically sign in popup appears.

Automatically sign in X

@ You can set up your computer so that users do not have to type a user
EH’ name and password to sign in. To do this, specify a user that will be
automatically signed in below:

User name: [ Ichiro ‘
Password: | sesscssssssseee ‘
Confirm Password: | sescnssssene ‘

e.) In Password and Confirm Password, enter the new password and then press OK.

f.) If you incorrectly type the password, in the following popup, press OK and re-enter the
Password and Confirm Password information on the “Automatically sign in” popup again.

User Accounts X

The passwords you typed do not match. Type the password for this
account in both text boxes,

NOTE: The new password procedure will need to be performed each time the LOGIQ Fortis is
reghosted.
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5-4-7

Log file content

Uncompressing the log files provides a subdirectory with the results.

SysConfig.csv — Contains serial number, hardware info, software version, etc.
log/ExceptionTrace — subdirectory contains text file with call stack of system crashes.

log/DL — (Deep Learning) subdirectory contains anonymized low resolution jpg images. Can be
used for troubleshooting. Every time you press the print key. Very low resolution images, may be
useful to get examples of image issues visible in low resolution. Used for data analytics. Users can
disable them through the UI.

log/Diag — subdirectory contains diagnostics results.

log/Crashes — subdirectory may contain Windows/application crash info.
log/CrashDump — subdirectory may contain Windows/application crash info.
Log/ScLogsDatabase — subdirectory containing tab-separated text files (Data Logging).
Log/ScLogsDatabase_PI — subdirectory with Patient Proprietary Info (keyboard shadow).
WinEvt — subdirectory with Windows Event logs.

Logs are text files and can be open in Microsoft Excel. Fields are separated by tabs in order to make it
easier to be opened in Excel.

Logs will not be present until they are collected through Alt+D or Gather Logs.
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5-4-8

Smart Device applications

The following Smart Device applications (apps) are available for Android devices through a Bluetooth
connection:

LOGIQ Remote
LOGIQ Photo

For more information, see “Smart Device Apps” in Chapter 13 of the LOGIQ Fortis Basic User

Manual (latest revision).

LOGIQ Remote

With the LOGIQ Remote app, you will be able to adjust the following controls:

Depth

PW Gain

CF Gain
B-Mode Gain
Left/Right
Measure
Comment
Clear
Trackball
Freeze

Store

Color Flow Scale
Cursor

LOGIQ Photo

With the LOGIQ Photo app, you can capture images that will go to the patient’'s exam.
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Section 5-5
Service Desktop Description

5-5-1

The Service Desktop is an interface that provides access to system information, status, and diagnostics.
The Service Desktop has different content or views depending on the access level. The access level is
determined by the user profile as well as the service options enabled on the LOGIQ Fortis.

» Basic view is the standard view, restricted only by the user through the user profile settings.
Administrator default user has access to the Service Desktop. Any user with “local Service access”
in their user profile can have access to this view.

+ Class C view is the view enabled by the service options purchased.
- Service Advanced
- Service Expert (requires Service Advanced)
- Service Pro (requires Service Advanced)

Contents in this section

5-5-1 User level of the Service Deskiop .. ... ... e 5-19

User level of the Service Desktop

Table 5-3 shows Service Desktop widgets available for local service user without an SSA Key and
without service options.

Table 5-3 User Level of the Service Desktop

Basic View Class C View Levels
Main Main - : .
Menus Sub-menus Simple Service Service Service
Advanced Expert Pro
Home X X X X
Diags X X X
Run Diags X X X
e-PAT
diagnostic X
Diag History
DICOM
DICOM
Service Status X X X
DICOM X X X
Spooler
Utilities X X X X
Change
Password X X X X
Checkpoints X X X
Clean
Userdefs X X
Data Transfer X X X X
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Table 5-3 User Level of the Service Desktop (Continued)
Basic View Class C View Levels
Main Main - - -
Menus Sub-menus Simple Service Service Service
Advanced Expert Pro
Delete Files X X X X
Disk
Defragment X X X
Disruptive
Mode Utility X X X
Gather Logs X X X X
Network X X X X
Capture
Reset Patient
Database X X
Secure Delete X
Software
Reload X X
SSA License X X X X
Third Party
Licences X X X X
Options X X X X
Agent
Configuration X X X X
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Section 5-6
Front End Description

5-6-1

Purpose of this section

The intention with this section is to give you a brief overview of the front end configuration used on the
LOGIQ Fortis.

Contents in this section

5-6-1
5-6-2
5-6-3
5-6-4

Purpose of thissection . . . ... . e 5-21
Card rack circuit boards overview and location .. ............................. 5-22
Relay board (DPI-L) . . ... 5-25
Data Acquisition Board (DA192). . . .. ... 5-28
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5-6-2 Card rack circuit boards overview and location
The card rack houses all the transmit, receive, and processing circuit boards.

Figure 5-3 Card Rack Boards (indicate orange box)
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5-6-2

Card rack circuit boards overview and location (cont’d)

Table 5-4 Card Rack Boards
TOTAL NUMBER OF CARDS PER
ABBREVATION BOARD NAME LOGIQ Fortis
BEPS Back End and Power Supply 1
DA192 Data Acquisition 192 ch 1
DPI-L DLP Probe Interface 1
GBP Back Plane !

Figure 5-4 Details of Card Lack

DPl & DA192
Connected by
Stacking-connector

BEPS < DA19Z
Connected by GBP
(BackPlane)
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5-6-2 Card rack circuit boards overview and location (cont’d)

Card rack location in the LOGIQ Fortis

The card rack can be accessible by Rear side of the system.

Figure 5-5 Card Rack Location
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5-6-3

Relay board (DPI-L)

The main task of the relay board is to route the transducer channels between the active probe and the
Transmitter or Receiver modules that are active. Relays are used in order to switch the connections
between the active probe connectors.

The module contain four probe connectors:

» All connectors have a metal door enclosure that opens only when inserting the probe. The
enclosure protects the pins that connect to the probe flat contact pads. This connector type is
identified as DLP. Probes compatible with this style of connector are identified as “-D”

»  All connectors support probes with 192 channels (one connector is designed to support probes up
to 256 channels.

Location in the LOGIQ Fortis

For DPI-L board location, see 5-6-2 "Card rack circuit boards overview and location" on page 5-22.

Chapter 5 Components and Functions (Theory) 5-25



GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

5-6-3 Relay board (DPI-L) (cont’d)

Figure 5-6 Relay Board
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There are four probe connectors mounted on the solder side of the board.

The LOGIQ Fortis Ultrasound systems have one type of probe port that connects directly to the relay
board: four DLP probe ports.

Figure 5-7 Probe Connectors, Four DLP Probe Ports

[ —
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LOGIQ Fortis has Probe port illumination to indicate the Probe port location in the Dark Room.
Brightness of illumination can be controlled on the Touch Panel and in Utility page.
Fiber cable is used as lighting, and LED power is provided by DPI-L though connector.
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5-6-3 Relay board (DPI-L) (cont’d)

Pencil probes (P2D and P6D probes) can be connected to DPI-L board by applying Pencil CW

installation kit Hardware onto DPI-L board.

LOGIQ Fortis is using different connection, but Necessary TX/RX signals are automatically switched/
connected to applicable signal lines.

Figure 5-8 Pencil Probe Connector

- i
1
o ——
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5-6-4 Data Acquisition Board (DA192)

DA192 Board has two main tasks. One is to provide the transmitter channel hardware and function for
the beamformer system. Another is to receive the Weak ultrasound echoes and process 192 channels
concurrently. DA192 board has HV Power bank that generates HV+/- Power for Transmit, and MUX-HV

+/- for MUX-inside Probes.
Figure 5-9 Data Acquisition Board (DA192) Block Diagram
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Figure 5-10 Data Acquisition Board (DA192)
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Figure 5-11 Parts Location on Data Acquisition Board (DA192)

HV Power Circuit

Analog Front End IC

Transmit IC

Data acquisition (DACQ) FPGA
SSCI FPGA

CW Doppler Option Board (GCW)

m ml ool o >

Location in the LOGIQ Fortis

For DA192 board location, see 5-6-2 "Card rack circuit boards overview and location" on page 5-22.
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Section 5-7
Back End Description

5-7-1 Purpose of this section

The intention with this section is to give you a brief overview of the back end configuration used on the
LOGIQ Fortis.

Contents in this section

5-7-1 Purpose of thissection . . ... ... . . . . 5-30
5-7-2 BEPS. . 5-31
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5-7-2

BEPS
The BEPS (Back End and Power Supply) module has two main tasks.

One is single board computer built from a COM express module fitted into customized rack. Its main
function is to be the central processing unit of the Ultrasound system, controlling all the functionality,
user interface and connectivity of the scanner. Another is the Main Power Supply unit with semi-
customized ACDC converter unit.

BackPlane connectors give the Power to DA192/DPI-L boards, and PCl-e signals for image-processing.

The BEPS also host a single slot GPU card, a M.2 Solid State Drive (SSD).

Figure 5-12 Location of each module

A CPU module

B ACDC Converter module (Shield cover bracket is applied, module size/design may be different)
C ACFE (Filter) board

D M.2 SSD Hard Drive

E VCS (S-Video) board - option

F DC4D (4D motor control) board - Option

G Removable EEPROM to store Console S/N and Option keys

H Lithium Coin Battery
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5-7-2 BEPS (cont’d)

Figure 5-13 Location of each module (Back side)

J GPU module

K Connector for Battery Option
L Not used

M Not used
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5-7-2 BEPS (cont’d)
Figure 5-14 Connector description

Hole for Battery cable
Connect to BatteryOption

| ___Monitor Power
~USB3

For monitor

~ Monitor HDMI

Touchpanel HDMI

USB2

____—— Foron-board peripherals

~ Speaker audit out

Vnav-inside-sensor
To baybird 2

ECG signal
To 5" ECG module

DC-Out

For various peripherals

LAN
USB3 ,
S-video out(Option)
HDMI

Equipotential(Earth) Terminal

Circuit Breaker

I
b
r
b
]
. |
» 1
U
» |
-
-
-
-
= B
-
=
-
-
’
<

Internal Breaker must ON always (ON means, always “I” should be activated, as graphic
above).

AC-Inlet

NOTE:
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Section 5-8
Backplane Description

5-8-1 Purpose of this section
The intention with this section is to give you a brief overview of the backplane used on the LOGIQ Fortis.
Contents in this section

5-8-1 Purpose of thissection . . ... ... .. . . 5-34
5-8-2 Backplane (GBP) . ... . 5-35
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5-8-2

Backplane (GBP)

The LOGIQ Fortis backplane (GBP) is part of an Ultrasound system, main purpose is to connect BEPS
board and DA192 board, capable of processing 192 ultrasound channels concurrently. It also has
connector for Main FAN power, Front-LED, and Wireless LAN module.

GBP does not have ROM for VPD.
Figure 5-15 Backplane

BEPS side DA192 side DA192 side BEPS side
-

i~

Wireless LAN Option

Connector for Main-FAN

Connector for Front LED

Backplane connector for normal signals

m| O| O ®m| >»

Backplane connector for High speed (PClie Gen3 signals)
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Section 5-9
Top Console Description
5-9-1 Purpose of this section
The purpose of this section is to give you an overview of the top console and to tell you how it functions.

Contents in this section

5-9-1 Purpose of thissection . . ... ... . . . 5-36
5-9-2 Transporting the LOGIQ Fortis . . ... ... e 5-36
5-9-3 Operator panel movement - principle of operation . . . .......................... 5-37
5-94 Top console description. . .. ... 5-38
5-9-5 Top console block diagram . . . ... ... 5-39
5-9-6 Main MmoONItOr . . . . .. 5-40
5-9-7 Operator panel . . ... 5-42
5-9-8 Oppanel Interface. . . ... . . . 5-43
5-9-2 Transporting the LOGIQ Fortis

Refer to the appropriate version of the LOGIQ Fortis Basic User Manual, or the appropriate LOGIQ
Fortis Release Notes.
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5-9-3

& CAUTION

VAN

NOTICE

Operator panel movement - principle of operation

To avoid injury or damage, make sure nothing is within the range of motion before moving the
operator panel. This includes both objects and people.

Do NOT attempt to apply excessive rotating force to the operator panel. The elevation brake is
designed to hold the operator panel in desired position during normal use, and not meant to completely
fix the operator panel position.

Push right side button to raise/lower the operator panel.

1.) Hold the front handle in two hands.

2.) Push and hold down the Up/Down button next to the right front handle.
3.) Raise or lower the control panel.

4.) Release the Up/Down button at the desired height.

Push left side button to swivel the operator pane

1.) Hold the front handle in two hands.

2.) Push and hold down the swivel button next to the left front handle.
3.) Move the control panel to the left or the right.

4.) Release the swivel button at the desired position.
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5-9-4 Top console description
The top console includes the following:

e Main monitor
*  Operator panel with:
- An On/Off switch.

- A touch panel screen and a control panel with controls for manipulating the picture quality and
for use in Measure & Analyze (M&A).

- Gel warmer
- A trackball.

- Top console adjustment controls; controls and a lock to move the top console left/right, and
up/down.

*  Sound output (used during Doppler scanning/replay) not visible externally.
The top console is located on the top of the LOGIQ Fortis.
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5-9-5 Top console block diagram

Figure 5-16 Top Console Block Diagram

| [ usBPower oo — _ USB/Power
LCD Monitor HDMI Monitor USBLJEBz HDU Display| [ 5 monitor
M

Figure 5-17 Lower OPIO Block Diagram

From Hos{]

(Hirose)

ResenePans
{Barcode mader,
&V dongle Foot 51

Custom Keyboard
vPD
- - l_l (Buttoss . Encoder)oystick

Gelwarmer :
To Gelwarmer

Drawe /N Keyboard Opon

Figure 5-18 Upper OPIO Block Diagram

To Main Manitor Customer Ports
HOMI Power Mini Din -~ USB2.0 Typea USB3.0x2
= i ] U
CN4
F"O':"E"::OS[ User Ports Board
iy —— 1 CM11
Micro Coaxial Conn Cable
C_I::S [l | USL Series 20pin (KEL)
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Power Mini Din [\ @00
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5-9-6 Main monitor
LOGIQ Fortis supports Two monitors, LCD Monitor and HDU Display.

5-9-6-1 LCD Monitor
23.8" Wide screen high-resolution LCD Display

Figure 5-19 LCD Monitor Connections

[1]usB2.0from CN8 | 2] Power from CN7 [ 3] HDMI from CN6
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5-9-6-2 High Definition Ultrasound (HDU)

A 23.8-inch wide screen, high definition Ultrasound Dual Layer LED-LCD (Liquid Crystal Display) with
localized dimming and non-interlace scan is used as the main monitor.

Figure 5-20 HDU Display Connections

Upper OPIO 1

[1]usB2.0 from CN8 | 2] Power from CN7 [ 3] HDMI from CN6
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5-9-7 Operator panel

The operator panel includes an On/Off switch, different controls for manipulating the picture quality, and
controls for use in Measure & Analyze (M&A), top console adjustment controls.

An alphanumeric keyboard is Hardware Option, and can be assembled to bottom side of the operator

panel.

Upper Operator panel is 12.1" High-resolution, color, touch, display screen.

Figure 5-21 Operator Panel

1. Probe Holder and Cord Management

2, Touch Panel and Joystick controls

3 On Screen Keyboard (not display in this
" graphic)

4. User Defined Keys
5. Mode/Gain/XYZ (3D) Controls

o

N

Trackball, Trackball Keys, Pointer, Measure,
Comment, Body Pattern, Clear, Zoom,
Programmable Keys

L/R, Start/Stop, Freeze, Simultaneous
Steer/Width/Depth/Reverse

Auto, CF/PW Auto Positioning
P1, P2
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5-9-8

Op panel Interface

Figure 5-22 Upper Op Panel/Touch Panel Assembly Connections

|

L

' cna oz ONS On

._.'d‘

To
CN1 BEPS USB3
CN2 From BEPS to Upper OPIO (for touch panel)
CN3 Upper Tray USB3 ports (EUSB2)
CN4 From BEPS to Upper OPIO HDMI (for main monitor)
CN5 From BEPS to Upper OPIO Power
CN6 From Upper OPIO To Monitor HDMI
CN7 Monitor Power
CN8 Monitor USB2
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Section 5-10
Power Distribution Description

5-10-1 Purpose of this section
The power distribution within the LOGIQ Fortis is described in this section.
Contents in this section
5-10-1  Purpose of thissection . .. ... .. .. . . . . 5-44
5-10-2 Power Supply Distribution. . . . ... ... . 5-45
5-10-3  POWEr ON SEQUENCE . . . .ottt ittt et e e et e e e 5-47
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5-10-2

Power Supply Distribution

The main power module is located in the BEPS assy, and main task is to isolate the scanner from the
on-site mains power system and to supply the various internal subsystems with DC power.

Power from the wall outlet (100 to 240 VAC, 50/60 Hz) is connected to the main power supply. The main
power supply (ACDC module) provides main P12V Live (Stand-by) 5V.

LOGIQ Fortis does not have Motors for Operator panel motion. Thus, LOGIQ Fortis does not have
48Vdc lane.

Each DCDC converter (located on DPI-L,DA192,BEPS) generates the needed voltages to the rest of
the LOGIQ Fortis:

*  Printer (12 Vdc)

*  Main Monitor(12Vdc)

* Lower/Upper OPIO, Gelwarmer(12Vdc)

» HV (variable DC High voltage, +/-10V ~ +/-100V), THV(+/- 97V), on DA192

+ P5V, M5V on BEPS

!!!! »

Vnav

DPI

Patient IO
Probe Interface DCDCs —
DVvD

- p—— DC
DCDCs Printer
+- 10~100

I DA].dSZ! +-2+10 I
Ultrasound TX / RX !
for 192 elements OPIO:
Battery +/-97 :
x2 i
Or —= i
LIVESV = i
x4 o= !
- —= 1

. ! - !
BEPS CPU 0 oocooooooo
ooooooooo
oopoooooo
+12V

‘j:)-l ACDC - p— ] Ml | @I

DeDc ¢y, | j

Figure 5-23 Power Distribution Diagram

The mains cord has plugs in both ends. A female plug connects to the scanner and a male plug to the
wall outlet.

User cannot detach the mains cord by regulation (fixed by Bracket).
Fuses are located inside the ACDC module (cannot be replaced).
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5-10-2 Power Supply Distribution (cont’d)

LOGIQ Fortis has a Circuit Breaker, located on Rear bottom side.

Figure 5-24 Circuit Breaker

The main power module is located in the BEPS assy, and main task is to isolate the scanner from the
on-site mains power system and to supply the various internal subsystems with DC power.

LOGIQ Fortis Power module does not have dedicated FAN. Necessary Air-Flow is provided by Main-
FAN.

A current limiter will switch off the power if any of the outputs overload.

Under-voltage and over-voltage protection is provided for all of the output voltages.

The power supply will be turned off if the temperature goes too high.

Figure 5-25 Cooling Air Flow of Power Supply
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5-10-3

Power on sequence

1.) BEPS, powered by LIVE5V(stand by 5V), PIC-micon (to manage Power Sequence, on BEPS) starts
working.
=>|f Battery Option is installed (and Capacity is not Full), battery-charging starts with operating
Main-Fan.

2.) BEPS sends PSON signal to ACDC-module when Power button is pushed.

3.) ACDC-module powers up +12V, and provides Power Good signal.

4.) DCDC circuit on BEPS module powers up, +5V, -5V
THV circuit on DA192 powers up, +/- 97V

5.) HV circuit on DA192 powers up after booting up Echoloader application, +/-10~100V variable.
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Section 5-11
Cable Connection BEPS - OP

Almost internal Cables are outputted from BEPS, and connected to each board/modules through ICM

board.
# From To Description
1 BEPS J1 OPIO Lower OPIO CN1 USB2.0 x2_PWR_PW-On, Lower OPIO
2 BEPS J2 Upper OPIO CN1 USB3.0, Upper OPIO
3 BEPS J3 Upper OPIO CN2 HDMI Touch panel LCD, Upper OPIO
4 BEPS J4 Upper OPIO CN4 HDMI Main Monitor, Upper OPIO
5 BEPS LCD J8 Upper OPIO CN5 PWR, Upper OPIO and Main LCD
6 BEPS USB2.0 (L) BW Printer NA USB2.0, Option DC BW PRINTER
7 BEPS USB2.0 (C) V-Nav NA USB2.0, Option V-Nav
8 BEPS USB2.0 (R) NA NA NA
9 BEPS J5 Speaker NA Audio, Speaker
10 BEPS J44 DVD NA SATA, DVD
11 BEPS J9 DVD NA PWR, DVD
12 BEPS J10 V-Nav NA PWR, Option V-Nav
13 BEPS J11 BW Printer NA PWR, Option DC BW PRINTER
14 BEPS J51 VSIO (ECG) NA Option VSIO (ECG)
15 BEPS J52 NA NA Not Use
16 BEPS J53 V-Nav NA Signals, Option V-Nav
17 Upper OPIO CN6 Main Monitor NA HDMI, Main Monitor
18 Upper OPIO CN7 Main Monitor NA PWR, Main Monitor
19 Upper OPIO CN8 Main Monitor NA USB2.0, Main Monitor
20 Upper OPIO J51CN3 EUSB2 CN3 USB3.0 x2, EUSB2 User ports
21 Lower OPIO J1 EXT USB BOARD J3 USB2.0, EXT HUB BOARD
22 Lower OPIO J2 EXT USB BOARD J7 PWR, EXT HUB BOARD
23 EXT USB BOARD J1 Gel warmer NA PWR, Gel warmer
24 EXT USB BOARD J5 AN Keyboard NA USB2.0, Option AN Keyboard
25 EXT USB BOARD J8 AN Keyboard NA LED, Option AN Keyboard
26 GBP u1 CSI2 NA LED indicator cable

Section 5-11 - Cable Connection BEPS - OP
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EXT HUB
BOARD

(Top)

EXT HUB
BOARD
(Bottom)
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GBP
(Backplane)
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Section 5-12
Air Flow Distribution

5-121 Air Flow Distribution
Through the filter grid on the front of the system, air flow into the LOGIQ Fortis.

By means of the 1 FAN, air is blown through the nest-box, and the warm air exits the system through
holes in the left side panel and rear of the system.

Main Air Outlet(Side)

Main Air
Inlet (Filter grid)

Main Air Outlet(Rear)

Figure 5-26 Air Inlet/Outlet
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Section 5-13
Casters and Brakes Description

Examine the wheels frequently for any obvious defects that could cause them to break or bind.

Each wheel has an independent brake pedal. A left rear wheel also has a swivel lock.

Figure 5-27 Wheel lock and Swivel lock
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Section 5-14
Options and Peripherals Description

5-14-1

5-14-2

Purpose of this section

The options and peripherals within the LOGIQ Fortis is described in this section.

Contents in this section

5-14-1
5-14-2
5-14-3
5-14-4
5-14-5
5-14-6
5-14-7
5-14-8
5-14-9
5-14-10
5-14-11

Purpose of this section . .. ... . . . . 5-54
Internal hardware options and peripherals . .. ... ... ... .. ... ... ... . ... 5-54
External peripherals . .. ... ... 5-55
Real Time 4D option . . . .. .. 5-56
CW Doppler (Continuous Wave Doppler)option . .......... ... . ... ... ...... 5-56
Pencil CW option. . . ... . 5-56
S-Video (VCS) option . . ..o oo 5-56
Patient /O (ECG) option. . . ... ... 5-57
Power Assistant Option. . . ... . e 5-58
Volume Navigation option . . ... ... .. 5-60
Wireless LAN option . . ... ... 5-61

Internal hardware options and peripherals
(See 3-6-3 "Optional peripherals/peripheral connection" on page 3-36)

This list covers the internal peripherals available for the LOGIQ Fortis. All of these internal peripherals

should be connected already when the LOGIQ Fortis is delivered.

* Realtime 4D Option (DC4D)

+ CW Doppler Option (GCW)

»  Pencil CW Option

+  S-Video (VCS) Option

+ Patient /O (ECG) Option

» Power Assistant Option

»  Scan on Battery Option

*  Volume Navigation (V Nav) Option
*  Wireless Option

* DVD Drive option

» Printer (Digital Graphic) Option
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5-14-3

External peripherals

This list covers the external peripherals available for the LOGIQ Fortis. The external printers are network
DICOM devices. The inkjet printer is USB connected.

OPTION TRAY

Physical AN KEYBOARD

Probe Holders

Ethernet Protection cable

Inkjet Printer

Powervar144k120v MG UPS
SONY UPD25MD COLOR PRINTR
USB Footswitch 3 Button

Barcode Reader / Card Reader
Digital Expert tools

Rolling Volume Navigation Stand
Customer - supplied USB Flash Drive/Hard Drive
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5-14-4

5-14-5

5-14-6

5-14-7

Real Time 4D option

The Real Time 4D option is located on the BEPS assy of the LOGIQ Fortis and necessary Motor control
signals are delivered to DPI-L board and 4D Probes through an BackPlane connector.

See 8-8-6 "BEPS Assy Replacement" on page 8-144 for location of each modules on BEPS.

CW Doppler (Continuous Wave Doppler) option

The CW Doppler option is to enable the CW scanning mode on the LOGIQ Fortis. CW Doppler option
board (GCW) is located on the DA192 assy of the LOGIQ Fortis.

Pencil CW option

The Pencil CW option is intended to support the connection of CW pencil probes. To enable Pencil CW
option, CW Doppler option board (GCW) is also need to be installed.

See 8-10-6 "GCW (CW Doppler) Replacement" on page 8-224 for location.

S-Video (VCS) option

The S-video (VCS) Option is located on the BEPS assy of the LOGIQ Fortis.

S-Video output signal is generated on the VCS board, and provided to Rear S-Video port.
See 5-7-2 "BEPS" on page 5-31 for location of each modules on BEPS.
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5-14-8

NOTE:

Patient I1/0 (ECG) option

The ECG functionality of the Patient I/O module is not intended for patient monitoring nor to
support alarm functionality. This input is intended as a tool for easier synchronization of images
and cineloop control during ultrasound examinations.

The ECG (Patient I/O) panel is located on the front of LOGIQ Fortis
Figure 5-28 ECG (Patient I/O) Panel

The ECG (Patient I/O) contains the electronics for:

1.) Analog inputs - AUX (Pressure/Pulse)
2.) ECG
3.) Phono
The three inputs are separately isolated due to safety requirements.

The patient leads for ECG can be possible to change between Lead |, Il and Il by pushing a button).

The scanned image that is displayed, is synchronized with the ECG and phono traces. In M-Mode or
Doppler, the traces are synchronized to that particular mode's sweep. The operator can control the gain,
the position and the sweep rate of the traces using the assignable controls.

AUX is capable of handling a pulse/pressure signal.
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5-14-9

Power Assistant Option

LOGIQ Fortis has two kinds of Battery Options, Power Assistant (PA) Option and (ScoB) Option.
No Activation Code (Option String) is required for both Options.

The LOGIQ Fortis will identify the option if it is installed.

Power Assistant Option allows the user to move the LOGIQ Fortis from room to room (at least 20
minutes with Brand-new Battery Packs) without completely shutting down the console. Where the
typical boot up time is <100 seconds, typical Power Assistant boot up time is <10 seconds.

Power Assistant Option includes two Li-ion Battery packs.

Scan on Battery Option allows the user to keep scanning without Wall-outlet-Power (at least 50 minutes
as B-mode, with Brand-new Battery Packs).

Also on the Scan-on-Battery Option, User can choose the Power Saving mode. This can save Power-
consumption by freezing Scanning.

Scan on Battery Option includes four Li-ion Battery packs.

Both Options are using same Charger-board (BBG2) and Metal-Box.
Only internal Battery Qty is different (2pcs or 4pcs).

Battery Box is located to the Upper Rear side of the System

Power Cable and Signal Cable are connected to BEPS board.

Y ym g

_—
E———
-1 T- T

L ata

Figure 5-29 Battery location
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5-14-9 Power Assistant Option (cont’d)

Battery Charger board (BBG2) is connected to BEPS board, and communicating with CPU-module
(Host) via SM-bus signals.

Microcontroller on the BBG2 (MSP432) controls overall Charger operation and transfer the summarized
Battery information to Host.

BEPS

Max GO0
—{:‘,‘4—— ComE
Ideal _‘
250 ~ 400W max : : ‘
Swstem power BIC-Mican -
Power- | . ;.
e e sequencer :
¥ -~
i [ ]
Digitial : [
charge e | : -
MSP432 sEEEmEEEEEEEEEE
* 5M-Bus
Char || Char || Char || Char
ger || ger || ger [| ger
Battery || Bottery || Battery " Battery BBG

3amax 3Amax  JAmax  3Amox
charge charge charge charge
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5-14-10 Volume Navigation option

The V Nav (Volume Navigation) option allows for the use of probes that have built-in V Nav sensors,
avoiding having external cables and V Nav bracket use.

LOGIQ Fortis supports the Baybird2 module only. (Baybird1 is not supported)

Figure 5-30 V Nav Option HDMI Routing

Vnav Power Cable

Vnav USB Cable

Vnav
USB Cable
Vnav HDMI Cable
To DPI board Vnav
Power Cable
NOTE: If the DriveBay power connector is a 5-pin type, use a V-Nav power conversion cable (V-Nav

Unit accessories).
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5-14-11 Wireless LAN option

The WLAN (Wireless LAN) option allows the LOGIQ Fortis to connect to a Local Area Network wireless
network.

The WLAN is installed on the Backplane board (GBP) with the WLAN card mounting screw (A).
Antennas are attached to the exterior of the GBP.

Refer to the appropriate version of the LOGIQ Fortis Basic User Manual, Chapter 13.
Figure 5-31 Wireless LAN Option

Antenna
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Section 5-15
Product Manuals

The information needed to use and service the LOGIQ Fortis scanner is collected in the documents
described in this section.

NOTE: Dates on screenshots are represented in MM/DD/YYYY format throughout the manual.

Information on how to change the LOGIQ Fortis’s date can be found in Customizing Your
System, Chapter 10 in the LOGIQ Fortis User Manual.

5-15-1 User documentation
 LOGIQ Fortis User Manual
« LOGIQ Fortis Advanced Reference Manual
* LOGIQ Fortis Release Notes
+ LOGIQ Fortis eLabeling Kit (contains LOGIQ Fortis eDOCs Thumb Drive, which contains all User

Manuals and translations, and the Basic Service Manual)

5-15-2 Basic Service documentation
« LOGIQ Fortis Basic Service Manual
» LOGIQ Fortis Unpacking/Packing Procedure

5-15-3 Service/Proprietary documentation
+ LOGIQ Fortis Proprietary Service Manual
+ LOGIQ Fortis Service Notes

5-62 Section 5-15 - Product Manuals



Direction 5874372, Rev. 3

GE CONFIDENTIAL
LOGIQ Fortis Proprietary Service Manual

Chapter 6

Service Adjustments

Section 6-1

Overview

6-1-1

NOTE:

6-1-2

Purpose of this chapter
This section describes how to adjust the LOGIQ Fortis.

The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

Contents in this chapter

6-1
6-2
6-3
6-4
6-5

OVBIVIBW. .« . o o 6-1
Monitor Adjustments. . . ... ... 6-2
Monitor Arm and/or Monitor Range of Motion Adjustment . . . .................... 6-10
DICOM Server Service Adjustments . .. ... ... .. .. . . . 6-13
Volume Navigation (V Nav) Calibration . ......... ... ... .. ... . . ... . . . . ... 6-13
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Section 6-2
Monitor Adjustments

6-2-1 Purpose of this section

This section describes how to adjust the monitor for optimal performance.

Contents in this section

6-2-1 Purpose of thissection . . ... ... . . . 6-2
6-2-2 Access to monitor adjustments. . . .. ... 6-3
6-2-3 Monitor adjustments . . . ... ... 6-4
6-2-4 Advanced monitor adjustments. . . ... ... 6-6
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6-2-2 Access to monitor adjustments

All monitor settings have been optimized at the factory, so there should be no need for any further
adjustments. The default settings on Scan Screen are:.

Table 6-1 Room Profile Table

HDU Display LCD Monitor
Room Profile: Dark Room Profile: Dark
Brightness/Contrast: 52/50 Brightness/Contrast: 50/85

For more information, see the appropriate version of the LOGIQ Fortis Basic User Manual Chapter 3,
or the appropriate LOGIQ Fortis Release Notes. See 7-4-1 "Label Location"” on page 1-14.

To access the Scan Screen, navigate to Utility (second page) > Scan Screen

Figure 6-1 Scan Screen

Use the encoder knobs to adjust the Scan Screen settings (shown on the Scan Screen directly above
each encoder knob).

Figure 6-2 Operator Panel Encoder Knobs

A I
09000 e@
roo N
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6-2-3

Monitor adjustments
Room profile

To set the monitor to different room lighting conditions, you may want to manually adjust the room
profile.

To set the room profile:

1.) Navigate to Utility (second page) > Scan Screen. The scan screen displays on the main display
while the Utility Touch Panel is active so you can see the affect your adjustments are making to the
monitor.

2.) Under Room Profile, select the room type.

Table 6-2 Room Profile Table

Room Profile Brightness/Contrast HDU Brightness/Contrast LCD
Dark 52/50 50/85
Semi-Dark 60/70 70/85
Light 62/93 90/85
User Defined User-adjustable Brightness/Contrast User-adjustable Brightness/Contrast
Backlight

Under special lighting conditions, you may want to adjust the monitor screen’s backlight intensity.
To set the OPIO backlight:

1.) Navigate to Utility (second page) > Scan Screen. The scan screen displays on the main display
while the Utility Touch Panel is active so you can see the affect your adjustments are making to the
monitor.

2.) Under the operator panel, turn the encoder to adjust the OPIO backlight setting.
Brightness and contrast

Under special lighting conditions, you may want to manually adjust the brightness and contrast.
To manually set the brightness and contrast:

1.) Navigate to Utility (second page) > Scan Screen. The scan screen displays on the main display
while the Utility Touch Panel is active so you can see the affect your adjustments are making to the
monitor.

2.) Under Room Profile, select User Defined.
3.) Under the operator panel, turn the encoder to adjust the brightness/contrast setting.

Section 6-2 - Monitor Adjustments
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6-2-3 Monitor adjustments (cont’d)
Touch panel light

1.) Navigate to Utility (second page) > Scan Screen. The scan screen displays on the main display

while the Utility Touch Panel is active so you can see the affect your adjustments are making to the
monitor.

2.) Touch panel encoder labeled as Touch Panel Light, rotate for brightness.

3.) Push the mode button once to display the popup and select Unlock or wait for the timeout.
4.) Adjust the Touch Panel between 10% to 100%.

For complete information, see the appropriate version of the LOGIQ Fortis Basic User Manual,

Chapter 3 or the appropriate LOGIQ Fortis Release Notes. See 1-4-1 "Label Location" on page 1-
14.

Figure 6-3 Touch Panel Adjustment Button

Unlock
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6-2-4 Advanced monitor adjustments
Review Gamma Setting

Gamma settings can be adjusted in two ways, with or without DICOM Gray Scale Standard Display
Function (GSDF) enabled. GSDF-compliant with all contrast settings, but not all brightness settings.

Because of differences in display technology, the HDU Display or LCD Monitor is GSDF-compliant with
all contrast settings, but not compliant with all brightness settings.

To enable the GSDF mode:

1.) Navigate to Utilities > System > System Display.
2.) Select Enable DICOM grayscale display mode (GSDF).
3.) Set Use Wide Screen for... > Single Image to Off.

4.) Navigate to Utility (second page) > Scan Screen. The scan screen displays on the main display
while the Utility Touch Panel is active so you can see the affect your adjustments are making to the
monitor.

5.) With GSDF enabled, the Gamma button on the touch panel affects the image, emulating the
appearance of that gamma, but does not affect the monitor.
Figure 6-4 Check to Enable GSDF Mode

If a site’s PACS workstations are calibrated to the GSDF, this setting may help to make the image
appearance more uniform between the Ultrasound system and PACS.

+  With GSDF disabled, the monitor still uses a gamma curve that may be selected on the Touch Panel
(for backwards compatibility with sites that are happy with their PACS or may have a mix of older
systems).

+  With GSDF enabled, the gamma button on the touch panel affects the image, emulating the
appearance of that gamma, but does not affect the monitor.
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6-2-4 Advanced monitor adjustments (cont’d)
Test patterns
Test patterns are available to aid in evaluating the display visually and quantitatively.

For complete information, see the appropriate version of the LOGIQ Fortis Basic User Manual,
Chapter 3. See 1-4-1 "Label Location" on page 1-14.

Table 6-3 Test Patterns

Test
Pattern Description Corresponding Graphic

Confirm that you can clearly see all of the different

Gray Bars ) .
gradations of the grayscale in each gray cell.
Confirm that you can clearly see all of the different

Color Bars .
colors in each colored cell.

. Confirm that this image is clear and crisp, without

Resolution . )

jagged edges or lines.
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Table 6-3

Test Patterns (Continued)

Test
Pattern

Description

Corresponding Graphic

Brightness
Contrast

Before making any adjustments, record the settings for
contrast and brightness. In a dimly lit room, adjust the
monitor to Brightness 50 and Contrast 40. Increase the
contrast until the left most block in the second row from
the bottom is just visible.All the remaining blocks in the
last 2 rows of the image should now be visible.Reset
the contrast and brightness to the recorded levels.

LN1to LN18

Luminance for different grayscale levels. Usually, the
facility’s Biomed Engineer tests each gray level map on
the monitor from LN-1 to LN-18 with a light meter and
then graphs these on a scale to ensure that the curve
falls within the GSDF’s standard.

This can be performed with all three LOGIQ Fortis
monitors with GSDF enabled. Generally, this is
performed yearly.

LN-1

LN-18

QC

Quality Control. Confirm that this image is clear and
crisp, without jagged edges or lines.

N3N 3R 3R
A NI EA H3D
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Table 6-3 Test Patterns (Continued)
Test
Pattern Description Corresponding Graphic
CT
Used for Contrast. Confirm that you can detect the circles within
Luminance the square grayscale boxes.
response
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Section 6-3
Monitor Arm and/or Monitor Range of Motion Adjustment

6-3-1 Purpose of this section
This section describes how to adjust the monitor arm and/or monitor range of motion for optimal
performance.
Contents in this section
6-3-1 Purpose of this section . ... ... ... . 6-10
6-3-2 Monitor and Ergotron arm . . . ... ... 6-10
6-3-3 Cautions and Warnings . . . . . ..ot 6-10
6-3-4 Main monitor adjustments. . . ... ... . . 6-11

6-3-2 Monitor and Ergotron arm
These procedures are available for monitor range of motion and monitor vertical adjustment:
*  "Monitor arm vertical adjustment" on page 6-11
*  "Monitor arm tilt adjustment" on page 6-12

6-3-3 Cautions and warnings
Be aware of pinch points at hinges when adjusting the monitor arm and monitor.
Table 6-4 Pinch Point Caution and Warning Icons
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6-3-4

Main monitor adjustments
Monitor arm vertical adjustment

If the monitor rises or falls when it is released, perform a vertical adjustment.

Table 6-5 Monitor Arm Vertical Adjustment

Step Corresponding Graphic

1. Monitor Arm Vertical Adjustment Screw

| —~
SN 1O,

Tilt the monitor down to access the vertical
adjustment screw.

If the monitor was rising, turn the adjustment |
screw clockwise to increase the friction,
using a 4 mm hex wrench.

If the monitor was falling, turn the adjustment
screw counterclockwise to decrease the
friction.

The monitor should stay in the position it is
released at.

NOTE: The heavier the monitor, the more
friction will be required.
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Table 6-6

6-3-4 Main monitor adjustments (cont’d)

Monitor arm tilt adjustment

If the monitor is too loose or too tight when it is tilted, perform a tilt adjustment.

Monitor Arm Tilt Adjustment

Step

Corresponding Graphic

Tilt the monitor down and remove the
monitor rear cover.

If you have a thick wrench, it is easier to
reach the nuts by using the boxed end of the
wrench.

If the monitor is too loose, turn the
adjustment nut (A) towards the back and
nut (B) towards the front to increase the
friction, using a 13 mm wrench.

Turn the nuts the opposite direction to
decrease the friction. The monitor should
stay in the position it is released at.

NOTE: Be sure to tighten or loosen both
sides equally. Start with 1/4 turn and test full
90 degree movement before tightening or
loosening more.

Reinstall the monitor rear cover.
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Section 6-4
DICOM Server Service Adjustments

6-4-1

6-4-2

Slow response rate between the LOGIQ Fortis and a DICOM (PACS) server

Problems with slow responses may result in images being re-sent automatically and low transfer rates.
If you are experiencing problems with slow responses from a DICOM server, increase the timeout
setting.

To adjust properties for a DICOM server (online):

1.) Navigate to Utility > Connectivity > Service.
2.) Select the service for the DICOM server.
3.) Under Properties, set Timeout (sec) to 360.

Shutdown problems when running a portable LOGIQ Fortis

When portable (offline and not communicating with a PACS server), use the following settings to avoid
problems with shutdown speed:

To adjust properties for a DICOM server (offline):

1.) Navigate to Utility > Connectivity > Service.

2.) Select the service for the DICOM server.

3.) Under Properties, set these parameters:
- Maximum Retries - Set to 0.
- Retry Interval (sec) - Set to the lowest possible value.
- Timeout (sec) - Set to the lowest possible value.

Section 6-5
Volume Navigation (V Nav) Calibration

There is no calibration available in the field. If the registration seems to be out of calibration, reloading
the software will restore the factory settings. If the registration still seems out of calibration, replace the
Volume Navigation (V Nav) hardware.

For information on the hardware replacement, see 8-10-10 "V-Nav Option Replacement" on page 8-239.
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Chapter 7
Diagnostics/Troubleshooting

Section 7-1

Overview

7-11

Purpose of this chapter

This chapter describes how to setup and run the tools and software that help maintain image quality and
system operation. Basic host-, system-, and board-level diagnostics are run whenever power is applied.
Some Service Tools may be run at the application level.

NOTE: The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,

LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

7-1-2 Contents in this chapter
7-1 OVEIVIBW. .« . 7-1
7-2 Service Safety Considerations . . . ... ... .. . 7-2
7-3 Gathering TroubleshootingData. . ... ... .. . 7-3
7-4 Service Deskiop . . ... 7-11
7-5 DIagnostiCs . . . . . 7-90
7-6 Back End Troubleshooting . . . ... ... .. . 7-104
7-7 Connectivity Troubleshooting . . . ... ... .. 7-106
7-8 Electromagnetic Interference (EMI) Troubleshooting. . .. .......... ... .. ... .... 7-113
7-9 Image Troubleshooting. . . ... ... .. 7-114
7-10 Smart Device Apps Troubleshooting ... ... ... . ... . . . . . 7-115
7-11 Boot Issue Troubleshooting ... ... ... . 7-116
7-12 Noise Troubleshooting . . . .. ... ... 7-117
7-13 Options Troubleshooting. . ... ... ... 7-123
7-14 Probes Troubleshooting . . . . ... ... . 7-138
7-15 Peripherals Troubleshooting. . .. ... ... .. . e 7-142
7-16 Setting Troubleshooting . . . ... .. . 7-143
7-17 Scan Assistant Troubleshooting . . . ........ ... . . . 7-144
7-18 Log File Troubleshooting . .. ... ... e 7-145
7-19 System Error with TVD and Sample Volume Length from Utility . ................. 7-151
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Section 7-2
Service Safety Considerations

/\ DANGER DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, ARE PRESENT IN
THIS EQUIPMENT. USE EXTREME CAUTION WHEN HANDLING, TESTING, AND
ADJUSTING THE LOGIQ Fortis.

/\ DANGER IF A LOGIQ Fortis IS ENERGIZED AND THE NEST EMI BACK BRACKET IS REMOVED,
THE VOLTAGE TEST POINTS POSE A POTENTIAL SHOCK HAZARD.

/\ WARNING IF THE COVERS ARE REMOVED FROM AN OPERATING LOGIQ Fortis, SOME METAL
SURFACES MAY BE WARM ENOUGH TO POSE A POTENTIAL HEAT HAZARD IF
TOUCHED, EVEN WHILE IN SHUTDOWN MODE.

/\ WARNING USE ALL PERSONAL PROTECTION EQUIPMENT (PPE) SUCH AS GLOVES, SAFETY
SHOES, SAFETY GLASSES, AND KNEELING PAD TO REDUCE THE RISK OF INJURY.
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Section 7-3
Gathering Troubleshooting Data

Contents in this section

7-3-1 Purpose of this section. . . ... ... e 7-3

7-3-2 Collecting vital system information. .. ......... ... .. . . 7-4

7-3-3 ShortCUt KeYS . . . .. 7-4

7-3-4 Collecting a screen capture with logs. .. ... ... . 7-5

7-3-5 Capturing network logs to use for troubleshooting. . .. ......................... 7-9
7-3-1 Purpose of this section

Problem images and system data (logs) can be acquired at the LOGIQ Fortis or through service remote
connectivity. Use this data to perform service at the LOGIQ Fortis or to send it back to the manufacturer.
for analysis.

For more information, see:

+ "Diagnostics" on page 7-90

» "Back End Troubleshooting" on page 7-104

»  "Connectivity Troubleshooting" on page 7-106

» "Electromagnetic Interference (EMI) Troubleshooting" on page 7-113
* "Image Troubleshooting" on page 7-114

» "Smart Device Apps Troubleshooting" on page 7-115
*  "Boot Issue Troubleshooting" on page 7-116

*  "Noise Troubleshooting" on page 7-117

»  "Options Troubleshooting" on page 7-123

* "Probes Troubleshooting" on page 7-138

» "Peripherals Troubleshooting" on page 7-142

» "Setting Troubleshooting" on page 7-143

» "Scan Assistant Troubleshooting" on page 7-144

* "Log File Troubleshooting" on page 7-145
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7-3-2 Collecting vital system information

The following information is necessary to properly analyze data or images being reported as a
malfunction or a LOGIQ Fortis being returned to the manufacturer:

NOTE: This information is normally collected with Alt+D or Gather Logs.

Product Name = LOGIQ Fortis

Navigate to Utility > System > About.

Record the Package Type, Release Information and Part Number for the following:

- Application Software

- Service Platform
- Security Package
- Base Image

- Base Image Update

7-3-3 Shortcut keys

There are several shortcut keys on the LOGIQ Fortis that can be useful during troubleshooting:

Table 7-1 Shortcut Keys

Key

Description

Alt+1 or Alt+2

Marks events in the log file. Used for the flagging issues during operation.

Alt+F10

Displays SW Shut Down. If the LOGIQ Fortis can be shut-down by using these keys, it
means that SW is working and the problem could be the ON/OFF switch or the wire that
carries the shut-down signal.

Alt+F5 and F11

For the echo simulator (keyboard simulation), brings up or removes the front panel
simulator. It may be used with VCO to press buttons on the front panel that are not standard
keys on your PC.

F4 and F12

Displays the DICOM Job Spooler.

Alt+A

Displays a cursor (Alt+A stands for arrow).

Alt+D

Captures scanner logs.

Alt+Ctrl+D

With the SSA key connected, displays the Debug command window to run Sclogs.

Alt+Tab

With the SSA key connected, switches between screens. Access Windows and relaunch
the application to use this functionality.
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7-3-4

Collecting a screen capture with logs

If the LOGIQ Fortis malfunctions, simultaneously press the Alt+D keys. Alt+D is available at all times
and collects a screen capture of the image monitor, user-defined presets, and these logs:

Keyboard Shadow Log (protected information)
Error Logs

Crash Log (protected information)

Vital Product Data

DICOM Logs

Windows Event Logs

Windows Modem Log

Diagnostic Logs

Service Logs

For a detailed list of Service Logs captured,
see 7-3-5 "Capturing network logs to use for troubleshooting” on page 7-9.

Figure 7-1 ALT+D Dialog Box
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7-3-4  Collecting a screen capture with logs (cont’d)

NOTE:

To collect a screen capture with logs:

1.
2.)

3)

4)
5)
6.)

Press Alt+D. The System Problem Reporting dialog box opens.
Enter the following information:

- System ID serial number

- Software version

- System date and time of occurrence

- Sequence of events leading to issue

- Whether the issue is repeatable

- Imaging mode, probe, preset/application

- Media brand, speed, capacity, and type

To authorize the collection of protected information, check Include Protected Information,
requires Admin privileges. If this box is checked, the LOGIQ Fortis creates two log files with the
following format name:

- log_<SN> <DATE>_<TIME>_DB.zip

- log_<SN> <DATE>_ <TIME>_Protectedinfo_DB.zip

Where <SN> is the serial number, <DATE> is the date in format YYMMDD and <TIME> is the time
in format HHMMSS.
To include a duration, check Time Duration and select a duration from the dropdown.

Under Destination, select a storage media or Service directory for remote viewing.
Click the Store button.

To save to a CD/DVD or USB Flash Drive, you MUST select CD/DVD Recordable or USB drive
as the destination device, otherwise the data is written to the default Export/Service directory
on the hard drive. The Export/Service directory is only used for remote service and is not
intended for images or report storage use.

For a CD/DVD, the LOGIQ Fortis automatically formats an unformatted disk, gathers logs and writes it
out to the disk.

The subsequent file is compressed and time stamped. The screen capture is a bitmap which eliminates
the possibility of artifacts from compression.
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7-3-4  Collecting a screen capture with logs (cont’d)

Double check the media that you made to ensure it contains the file. An example is
shown in Figure 7-2 "Example of Zipped Trouble Image and Logs File" on page 7-7.

Figure 7-2 Example of Zipped Trouble Image and Logs File

| Pt DriveTools  DVD RW Drive (G:) 20171130_01
“ Home Share Vigys Manage
1Hi 15) | L
&« B » ThisPC » DVD RW Drive {G:) 2017113001 » (7]
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O Name Date mo
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5| Expost

O § log_EE0021_171130_142020 DB
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& This PC
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%| Documents
B Downloads
Ji Music
& Pictures
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i System (C1)
= User (D)
= ARCHIVE (E)
. SECURE KEY (F:)
DVD RW Drrive (G:) 20171130_01
DVD RW Drive (G:) 20171130_01
= Reposit (Z:)

Figure 7-3 Contents of the Zipped Trouble Image and Logs File
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DVD RW Drive (G:) 20171130_01

Mark log files

If a customer is experiencing issues during operation, mark the issue by pressing Alt+1 or Alt+2 when
the event occurs. When Alt+1 or Alt+2 is pressed, a marker is placed in the log to aid analysis.
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7-3-4  Collecting a screen capture with logs (cont’d)
Trouble image without patient information

To collect a trouble image you need to enable Transfer Images (captured without patient information)
to GE under ADMIN > System Admin.

To collect the image, press the P1 key (copy to hard drive). This places an unidentified .jpeg image in
the D:\Log \DL folder. This folder will be transferred to the back office if a transfer is scheduled.

Figure 7-4 Example of a Trouble Image Collected with P1

To collect logs using Gather Logs, the image or images will be captured in the log collection Zip file and
will be deleted from the D:\Log \DL folder.

Figure 7-5 Example of a Trouble Image Collected with Gather Logs

- o
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7-3-5

Capturing network logs to use for troubleshooting

Use the Network Capture utility to capture network logs. Once the logs are captured and extracted from
the LOGIQ Fortis, use Microsoft Message Analyzer to convert the output, and then Wireshark (or some
other network sniffer) to analyze it.

To troubleshoot network capture logs:

1.) On the LOGIQ Fortis, run the Network Capture utility to generate .etl and .cab files for analysis.
For more information, see "Network Capture" on page 7-68.

2.) Locate the .etl file at D:\Service.

3.) Transfer these files to a laptop.

4.) On the laptop, download Microsoft Message Analyzer (if not already done).
5.) In Microsoft Message Analyzer, open the .etl file.

If the DICOM connection is encrypted, you will not be able to see the contents of the packets.
Microsoft Message Analyzer does not have a plug-in to decode DICOM packets.

o =

...............

Mesige track 1

B rbooesbbbsbbbbbsbbbbbs
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6.) To export the .etl file to .cab, select File > Save As and then select Save As or Export.

Fe Semie  Too  Wep

Save/Export Session; trace

Step 1: Select Data

g For Arsysis G e

Step 2: Save or Bxport

=

Lo da

Saving an matp inchudes ol parsed S5t Mg Tatter adeg whan opesed

S22 a2 dddad ]y

B
¥

b

If the network capture was of a wireless connection, Microsoft Message Analyzer creates a .pcap
file that does not have any of the packets and is probably useless.

7.) Use Wireshark or some other third-party network sniffer to examine the .cab file.
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Section 7-4
Service Desktop

7-4-1

Contents in this section

7-4-1 Purpose of thissection. . ... ... . . . . . .
7-4-2 Disruptive mode . . ... ... . e
7-4-3 Color statuses. . . . ...
7-4-4 Service Classes . . ... oo
7-4-5 Home . . e
7-4-6 Diags . .
7-4-7 DICOM . .
7-4-8 Utilities . . .
7-4-9 OPtIONS .
7-4-10  Agent Configuration . .. .. ... .
7-4-11  Software Maintenance . .. .......... .. .

Purpose of this section

This section describes the features of the Service desktop. These are the different levels of access to

the Service desktop:

» Service Basic access (Class A) — a user locally logged into the machine with Local Service Access

privilege. This level provides limited access to Service desktop widgets and utilities.

» Service Expert, Pro, and Advanced access (Class C) Local — Depending on the purchase level,

includes an option string to control access.

* GE Service access (Class M) and an SSA key. For users with local Service Access privileges, this

level provides unrestricted access to all Service desktop widgets and ultilities.

* Remote access — a user remotely accessing the LOGIQ Fortis. This level provides unrestricted
access to all Service desktop widgets and utilities. Disruptive mode is limited to the user access

privileges to Remote Service Access.
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7-4-2

Disruptive mode

Disruptive mode is a way to control interruptions to operation of the LOGIQ Fortis. Disruptive mode is
required whenever service performs a function that may disrupt a normal scan. Activating Disruptive

mode results in a red message displayed on the task bar. This message indicates that the LOGIQ Fortis
needs to be restarted once the service activity is complete. The message remains until the LOGIQ Fortis
is restarted. This prevents patient scanning while the LOGIQ Fortis is not operating at an optimal status.
For example, running a diagnostic may leave the LOGIQ Fortis in a state that is not good for imaging.

Specifically, Disruptive mode is required to run diagnostics, clean presets, and reset the patient
database, and turn on Virtual Console Observation (VCO).

*  When Disruptive mode is On, all service functionality on the Service desktop is allowed but user
operation of the LOGIQ Fortis may be limited.

*  When Disruptive mode is Off, some service functionality on the Service desktop is not available and
user operation of the LOGIQ Fortis is normal.

Additionally, the ability to enable Disruptive mode depends on the logged in user.

» Local user —a user locally logged into the machine will be able to set the LOGIQ Fortis to Disruptive
mode or allow a Disruptive mode request from a remote user through the Service desktop. The local
user must have Authorize Remote Service Access to allow Disruptive mode. If the local user does
not have this right, the remote user’s request will be automatically denied.

* Remote user — a user remotely accessing the LOGIQ Fortis will not be able to automatically switch
Disruptive mode to On. The logged in user (user actually logged on to the LOGIQ Fortis) needs to
have the ability to grant remote access. The logged in user will be notified through a dialog box and
asked to allow Disruptive mode.

NOTE: Change Password and Disk Defragment are not available for the remote user whether
Disruptive mode is On or Off.
For more information, see "Disruptive Mode" on page 7-65.
7-4-3 Color statuses

Throughout the Service desktop, colors indicate the following:
* Green — Status is normal
+ Orange — Status is a warning
* Red - Status is an error
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7-4-4

NOTE:

Service Classes

With Service Basic Access (Class A), these are the available options:

HOME

Utilities

- Change Password

- Data Transfer

- Delete Files

- Gather Logs

- Network Capture

- Resolve Agent Quarantine
- Secure Delete

- SSA License

- Third Party Licenses
Options

Agent Configuration
Software maintenance

With Service Advanced (Class C), these are the available options:

With a Class C license, options display according to these purchased level of access.

HOME

Diags

DICOM

Utilities

- Backup and Clean LogDb
- Change Password

- Checkpoints

- Data Transfer

- Delete Files

- Disk Defragment

- Disruptive Mode Utility

- Gather Logs

- Network Capture

- Resolve Agent Quarantine
- Secure Delete

- SSA License

- Third Party Licenses

- Virtual Console Observation
Options

Agent Configuration

Software maintenance
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7-4-4  Service Classes (cont’d)

With Service Advanced plus Service Expert (Class C), the Clean Userdefs, Reset Patient Database,
Secure Delete, and Software Reload utilities are added to the Service Advanced options listed.

With Service Advanced and Service Expert plus Service PRO (Class C), the probe assessment tool
(e-PAT) diagnostic is added to the Service Advanced and Service Expert options listed.
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7-4-4  Service Classes (cont’d)

With GE Service access (Class M) and an SSA key, these are the available options:

+ HOME
+ Diags

« DICOM
+  Utilities

- Backup and Clean LogDb
- Change Password (not available through a remote connection)
- Checkpoints
- Clean Userdefs
- Data Transfer
- Delete Files
- Disable Remote Connectivity
- Disk Defragment (not available through a remote connection)
- Disruptive Mode Utility
- Gather Logs
- Network Capture
- Reset Patient Database
- Reset Log Database
- Resolve Agent Quarantine
- Secure Delete (not available through a remote connection)
- Software Reload
- SSA License
- SSH
- System Shutdown
- Third Party Licenses
- Virtual Console Observation
* Options
» Agent Configuration
+  Software Maintenance
For more information, see Section 5-5 "Service Desktop Description" on page 5-19.
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7-4-5 Home

Home configurations vary depending upon the purchased service level.

Figure 7-6 Home with Class C and Class M Access

Figure 7-7 Home with Class A Access

For more information, see:

+ "System Information" on page 7-17

+ "Software Status" on page 7-19

+ "System Status" on page 7-20

» "Disk Drive Space" on page 7-34

»  "Network Configuration" on page 7-39
» "Connected Probes" on page 7-41
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7-4-5 Home (cont’d)

System Information

System Information displays general information about the LOGIQ Fortis. When the LOGIQ Fortis has
been successfully configured with the back office, these elements will have the corresponding values:

» Agent Registered will be Yes

+ Agent Quarantine will be No

» Agent CRM Verified will be Yes

The information on System Information is available to all service class licenses.

To access System Information, navigate to Utility (second page) > Service > Home.

Figure 7-8 System Information

@ Systemn Information

CRM Number 1 INEER_E70012
Agent Registered

Agent Quarantine

Agent CRM Verified

Agent Connected

Model Number DO0OP4

Serial Number engineer_E70012
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7-4-5 Home (cont’d)
This table shows all the elements available on System Information with descriptions.

Table 7-2 System Information

Element Description

Customer Relationship Management (CRM) number. System identifier assigned to

CRM Number the customer unit by the service region.

Registered status of the agent. Valid values are:

* Yes — The agent is registered in the back office.

* No — The agent is not registered in the back office.

* Not Available — The agent is not running or has not been configured.

Agent Registered

Quarantine status of the agent. Valid values are:

* Yes — The agent has more than one device registered with the same CRM Number
in the back office.

* No — The agent has one device registered with the listed CRM Number in the back
office.

» Not Available — The agent is not running or has not been configured.

Agent Quarantine

CRM verified status of the agent. Valid values are:

* Yes — The agent is verified in the back office.

» No — The agent is not verified in the back office.

» Not Available — The agent is not running or has not been configured.

Agent CRM Verified

Connection status of the agent. Valid values are:

* Yes — The agent is connected to the back office.

» No — The agent is not connected to the back office.
Not Available — The agent is not configured or running.

Agent Connected

Model Number GE part number for the LOGIQ Fortis. The same number as listed on the rating plate.
Serial Number Serial number of the LOGIQ Fortis. The same number as listed on the rating plate.
System Type Product name of the LOGIQ Fortis.

Facility Name of the hospital or facility where the LOGIQ Fortis is installed.

For more information, see:

*+  "Home" on page 7-16
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7-4-5 Home (cont’d)

Software Status

Use Software Status to view general information about the software installed on the LOGIQ Fortis.

The information on Software Status is available to all service class licenses.

To access Software Status, navigate to Utility (second page) > Service > Home.

Figure 7-9 Software Status

This table shows all the elements available on Software Status with descriptions.

Table 7-3 Software Status

Element

Description

System Date

Current date in the format <day>, <month> <date> <year>.

System Time

Local time based on the last time the desktop was refreshed in the format
<hh:mm:ss>.

Application Installation Date

Date the application software was installed. The application software includes the
LOGIQ Fortis product-specific software.

Base Image Installation Date

Date the base image software was installed. The base image software includes the
Windows operating system and other supporting software.

Base Image Version

Version number (part number) of the base image software.

Application Software Version

Version number of the application software.

Application Status

Status of the application. Valid values are:
* Running
+ Stopped

For more information, see:

*+  "Home" on page 7-16

» "Software Reload" on page 7-78
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7-4-5

Home (cont’d)

System Status

Use System Status to view status information on the LOGIQ Fortis. Specifically, do the following:

View the hardware configuration file

View temperatures for FRUs and a graphical representation of the monitored temperatures
View statuses of the batteries

View voltages for FRUs.

View issues with the boot process

View alert logs

View logs that occurred before and after an error

View USB devices connected to the LOGIQ Fortis

View the amount of time the LOGIQ Fortis has been running

View the amount of time since the LOGIQ Fortis has last been rebooted

The information on System Status is available to Class C and Class M licenses.

To access System Status, navigate to Utility (second page) > Service > Home.

Figure 7-10 System Status
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7-4-5 Home (cont’d)

This table shows all the elements available on System Status with descriptions.

Table 7-4 System Status

Element

Description

Hardware Configuration

Displays the contents of the hardware configuration file.

Displays the temperature monitoring of the LOGIQ Fortis as normal, warning, or
error using the standard colors and icons. Includes temperature out-of-spec events

Temperature including an overall count of event warnings and errors for the last 30 days or the
last status checkpoint whichever is sooner. Temperature displays temperature a
graph for the configured monitoring points.

Battery Status Displays the battery monitoring of the LOGIQ Fortis.

Displays the voltage monitoring of the LOGIQ Fortis as normal, warning or error

Voltage using the standard colors and icons. Includes voltage out-of-spec events including

an overall count of the event warnings and errors for the last 30 days or last status
checkpoint whichever is sooner.

Bootup Issues

Based on the latest occurrence, displays all abnormal boots of the LOGIQ Fortis for
either the past 30 days or the latest check point.

Alert Logs

Based on the latest occurrence, displays all alerts generated by the LOGIQ Fortis
for either the past 30 days or the latest check point.

Log Analyzer

Displays a list of errors and associated log files for troubleshooting.

USB Devices

Displays the USB connected devices and their status.

System On Time

Displays the time the LOGIQ Fortis was turned on.

Time Since Last Reboot

Displays the time the LOGIQ Fortis was last rebooted.

For more information, see:

* "Hardware Configuration"

on page 7-22

+ "Temperature" on page 7-23
+ "Battery Status" on page 7-26

+ "Voltage" on page 7-28
*  "Bootup Issues" on page

7-30

+ "Alert Logs" on page 7-32
» "USB Devices" on page 7-33

*+  "Home" on page 7-16
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7-4-5

Home (cont’d)

Hardware Configuration

Hardware Configuration displays the contents of the hardware configuration file which includes all the
vital product data (VPD).

To access Hardware Configuration, navigate to Utility (second page) > Service > Home, and then

under System Status, select Hardware Configuration.

Figure 7-11 Hardware Configuration

This table shows all the elements available on Hardware Configuration with descriptions.

Table 7-5 Hardware Configuration
Element Description
Component Hardware component.
Item Parameter with the vital product data (VPD).
Value Actual value of the Item.

For more information, see:

+ "System Status" on page 7-20
+ "Home" on page 7-16
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7-4-5 Home (cont’d)
Temperature

Use Temperature to troubleshoot problems with monitored FRUs. Specifically, use these pages:

+ FRU Status

* Graphs

To access Temperature, navigate to Utility (second page) > Service > Home, and then under
System Status, select Temperature.

For more information, see:

* "FRU Status" on page 7-24

* "Graphs" on page 7-25

+ "System Status" on page 7-20
*+ "Home" on page 7-16
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7-4-5 Home (cont’d)
FRU Status
FRU Status displays a summary of the FRUs being monitored and the details for each FRU.

To access this page, under System Status, select Temperature and then select FRU Status.

Figure 7-12 FRU Status
} Temperature Monitoring

being monitored

This table shows all the elements available on FRU Status with descriptions.

Table 7-6 FRU Status

Element Description

FRU Status Summary Number of the FRUs being monitored.

FRU Status Details

Name Name of the FRU.

Status of the FRU. Valid values are:
« Normal — Indicates that the FRU is operating within the allowable range.

Status « Warning — Indicates that the FRU is operating close to the limit of the allowable range.
« Error — Indicates that the FRU is operating outside the allowable range.

Lower Limit Warning Number of low temperature warnings.

Upper Limit Warning Number of high temperature warnings.

Lower Limit Errors Number of low temperature errors.

Upper Limit Errors Number of high temperature errors.

For more information, see:

+ "Temperature" on page 7-23
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7-4-5 Home (cont’d)
Graphs

Graphs displays trend graphs for selected elements which have been selected as key indicators of
overall temperature status inside the card rack.

To access this page, under System Status, select Temperature and then select Graphs.

Figure 7-13 Graphs

l Temperature Monitoring

Trend A C TURE Temperature Trend

For more information, see:

+ "Temperature" on page 7-23
+ "Home" on page 7-16
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7-4-5 Home (cont’d)

Battery Status

Battery Status displays details for each battery.

To access Battery Status, navigate to Utility (second page) > Service > Home, and then under

System Status, select Battery Status.

Figure 7-14 Battery Status
This table shows all the elements available on Battery Status with descriptions.
Table 7-7 Battery Status
Element Description

Type of the batteries. Valid values are:
* No battery — Indicates that no batteries are present.

Battery Type . .
« EPS only — Indicates that the extended power shutdown batteries are used.
» Power Assistant — Indicates that the power assistant batteries are used.
Status of the batteries. Valid values are:

Battery Status * Normal — Indicates that batteries are charging or fully charged.
» Error — Indicates a problem with the batteries.
Status of the batteries concerning charging. Valid values are:

Charging Status » Charging — Indicates that the batteries are charging.
+ Discharging — Indicates that the batteries are discharging.
Deterioration state of the batteries. Valid values are:

Deteriorated * Yes — Indicates that there is a problem with one or both of the batteries.
* No - Indicates that the batteries are operating normally.

Right PA Battery .

Charge Percentage Percentage of the right battery charge.
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Table 7-7 Battery Status

Element

Description

Left PA Battery
Charge Percentage

Percentage of the left battery charge.
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7-4-5

Home (cont’d)

Voltage

Use Voltage to troubleshoot problems with monitored FRUs of the LOGIQ Fortis. Specifically, use these
pages:
+ FRU Status

To access Voltage, navigate to Utility (second page) > Service > Home, and then under System
Status, select Voltage.

For more information, see:

* "FRU Status" on page 7-28
+ "System Status" on page 7-20
*+  "Home" on page 7-16

NOTE: AC voltage monitoring is not available on LOGIQ Fortis.
FRU Status
FRU Status displays a summary of the voltages for the FRUs being monitored and the details for each
FRU.
To access this page, under System Status, select Voltage and then select FRU Status.

Figure 7-15 FRU Status
% \Joltage Monitoring Einas
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7-4-5 Home (cont’d)

This table shows all the elements available on FRU Status with descriptions.

Table 7-8 FRU Status

Element Description
Name Name of the FRU.
Status of the voltage for the FRU. Valid values are:
* Normal — Indicates that the voltage is within the allowable range.
Status

+ Error — Indicates that the voltage is outside the allowable range.

» Warning — Indicates that the voltage is close to the limit of the allowable range.

Lower Limit Warnings

Number of low limit voltage warnings.

Upper Limit Warnings

Number of high limit voltage warnings.

Lower Limit Errors

Number of low limit voltage errors.

Upper Limit Errors

Number of high limit voltage errors.

For more information, see:

*  "Voltage" on page 7-28
+ "Home" on page 7-16
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7-4-5 Home (cont’d)
Bootup Issues

Bootup Issues displays a summary of bootup issues detected by the LOGIQ Fortis that prevented
normal scanning, shutdowns, or abnormal statuses.

To access this page, under System Status, select Bootup Issues.

Figure 7-16 Bootup Issues

@ Bootup lssues

4T3 18 0RSETR14B0000 D800

Figure 7-17 Bootup Issues with Missing Devices

W Bootup Issues
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7-4-5

Home (cont’d)

This table shows all the elements available on Bootup Issues with descriptions.

Table 7-9 Bootup Issues

Element Description
D Identifier for the LOGIQ Fortis software boot. For example, 10 for the tenth boot and
SO on.
Timestamp Date and time that the associated issue for the boot occurred.
Number of times EcholLoader was restarted during the associated boot.
Cycle Count * 0 — Normal. EchoLoader started without attempting a restart.

* 1 or more — Indicates the number if times EcholLoader attempted to restart.

Missing Devices

Displays the devices that were missing during the boot.

Incompatible Board

Displays whether an incompatible board exists.

Battery State ID

Type of battery detected. For example, EPS or PA. Invalid displays if no battery was
detected.

Previous Boot Crash Dump

Displays whether a crash dump has occurred. Valid values are:
* 1 —Indicates a crash dump has occurred in the previous boot.
* 0 — Normal. No crash dump has occurred.

Displays whether a warm boot has occurred. Valid values are:

Warm Boot * 1 - The LOGIQ Fortis was rebooted.
* 0—The LOGIQ Fortis was started after a shutdown.
AC Fail AC Fail is not available on LOGIQ Fortis.

Abnormal Context

Displays whether the software has booted to a stable state (Interface manager
successfully initiated). Valid values are:

» 1-The LOGIQ Fortis has not booted to a stable state. Only abnormal logs display.
» 0 — Normal. The LOGIQ Fortis initialized to a stable state.

Exit Requested

Displays the type of exit that has been requested. For example, 4 displays the
operating system was restarted.

Echoloader Exit Code

Displays the exit code generated by EchoLoader. 0 indicates that Echoloader exited
without any issues.

Echoloader Exit String

Displays the type of exit requested by EcholLoader. For example, restart the
operating system or exit the application software.

For more information, see:

+ "System Status" on page
*+  "Home" on page 7-16

7-20
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7-4-5 Home (cont’d)
Alert Logs

Alert Logs displays the details for each alert. Alerts are status logs typically reported as a result of an
error. Alerts are sent to the back office to be managed and reported to service.

To access this page, under System Status, select Alert Logs.

Figure 7-18 Alert Logs

This table shows all the elements available on Alert Logs with descriptions.

Table 7-10  Alert Logs

Element Description
Alert ID Identifier for the alert log that has been sent to the back office.
Sub System Hardware component.
Rule Code for the alert. Alerts are filtered in the back office using rule codes.
Description Description of the alert log.
Value Current value read for the associated hardware component.
Lower Limit Value for the lower limit for the associated hardware component.
Upper Limit Value for the upper limit for the associated hardware component.

Severity of the alert. These are the valid values:

. * 1 — Error. Out of specification
Severity

* 2 —Warning
* 3 —Normal
First Alert Time Time the alert first occurred.
Last Alert Time Time the alert last occurred.
Last Alert Local Time Time (local) the alert last occurred.
Last Alert Sent Time Time the alert was last sent to the back office.
Count Number of times that the alert has occurred.

For more information, see:

+ "System Status" on page 7-20
+ "Home" on page 7-16
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7-4-5 Home (cont’d)
USB Devices
USB Devices displays the details for each USB device.

To access this page, under System Status, select USB Devices.

Figure 7-19 USB Devices

This table shows all the elements available on USB Devices with descriptions.

Table 7-11  USB Devices

Element Description
Name Name of the USB device.
Serial Number Serial number of the USB device.
Speed Speed of the USB device. For example, USB 3.0.
HW Version Hardware version of the USB device.
SW Version Software version of the USB device.
Status Status of the USB device.

For more information, see:

+ "System Status" on page 7-20
+ "Home" on page 7-16
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7-4-5

Home (cont’d)

Disk Drive Space

Use Disk Drive Space to view the hard drive partitions including total size and available free space in
GB. Includes the overall health of the drive in one of these colors:

* Red - Available free space is less than 10% of the total size.
+ Orange — Available free space is more than 10% and less than 20% of the total size.

» Green — Available free space is more than 20% of the total size.
Each partition displays these encryption statuses:

+ Conversion status

* Percentage encrypted

*  Encryption method

* Protection status

* Lock status

The information on Disk Drive Space is available to Class C and Class M licenses.

To access Disk Drive Space, navigate to Utility (second page) > Service > Home.

Figure 7-20 Disk Drive Space
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7-4-5 Home (cont’d)

Figure 7-21 E: Drive Details

Encryption Status

Conversion status Fully Decrypted

Percentage encrypted 0.0%
Encryption method None
Protection status Protection Off

Lock status Unlocked
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7-4-5 Home (cont’d)
This table shows all the elements available on Disk Drive Space with descriptions.

Table 7-12  Disk Drive Space

Element Description

C: partition shows the graphical representation of the following:
C: Drive » Used space in GB
* Available free space in GB

D: partition shows the graphical representation of the following:
* Service

* Logs

* Temp

» Export

+ Service configuration

* Misc

* Available free space in GB

D: Drive

E: partition shows the graphical representation of the following:
* Print spooler

* Clipboard

» DICOM spooler

* Misc

» Available free space in GB

E: Drive

V: partition shows the graphical representation of the following:
V: Drive » Misc
« Available free space in GB

Z: partition shows the graphical representation of the following:
« Package repository

» Misc

« Available free space in GB

Z: Drive

For more information, see:

+ "Home" on page 7-16
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7-4-5 Home (cont’d)
Smart Disk Details
Smart Disk Details displays general information for the following drives:

» Solid State Drive (SSD) — Displays SMART disk.
The information on Smart Disk Details is available to Class C and Class M.

To access Smart Disk Details, navigate to Utility (second page) > Service > Home > Disk Drive
Space and then select Smart Disk Details.

Figure 7-22 Solid State Drive (SSD) Details
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7-4-5 Home (cont’d)
This table shows all the elements available on Smart Disk Details with descriptions.
Table 7-13  Smart Disk Details
Element Description
Serial No Serial number for the disk drive (SSD or HD).
Firmware Version Version number for the firmware installed on the disk drive (SSD or HD).
Drive Letter Drive letters associated with the disk drive.
Time Collected Time the details for the disk were collected in YYYY-MM-DDThh:mm:ssZ format.
Index Number associated with the disk drive attribute.
Name Name of the disk drive attribute.
Value Value for the disk drive attribute.
Threshold Threshold for the value of the disk drive attribute.
Worst Lowest value recorded for the disk drive attribute.
Raw Value determined by the drive manufacturer.
Type associated with the disk drive attribute. These are the valid values:
Type + OldAge
* Prefail
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7-4-5 Home (cont’d)
Network Configuration

Use Network Configuration to view network (wired and wireless) information (the full ipconfig details)
for the network configured with the LOGIQ Fortis.

The information on Network Configuration is available to Class C and Class M licenses.

To access Network Configuration, navigate to Utility (second page) > Service > Home.

Figure 7-23 Network Configuration
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7-4-5 Home (cont’d)

This table shows all the elements available on Network Configuration with descriptions.

Table 7-14 Network Configuration

Element Description
Host Name Name of the local host for the LOGIQ Fortis.
More Details Displays the ipconfig details.

Wired Connection

IpV4 Address

Local IP address for the wired network connection.

IpV6 Address

Local IP address for the wired network connection.

Subnet Mask

Local subnet mask for the wired network.

Default Gateway

Default gateway for the wired network.

MAC Address

Address for the MAC for the wired network.

Speed (Mbps)

Speed of the wireless connection.

Wireless Connection

IP Address

IP address for the wireless network connection.

Subnet Mask

Subnet mask for the wireless connection.

Default Gateway

Default gateway for the wireless connection.

MAC Address

Address for the MAC for the wireless connection.

Speed (Mbps)

Speed of the wireless connection.

Status

Current status of the wireless connection.

For more information, see:

*+  "Home" on page 7-16
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7-4-5 Home (cont’d)

Connected Probes

Connected Probes shows probes connected to the LOGIQ Fortis. The order on the user interface is
top down matching the left-to-right order on the LOGIQ Fortis.

The information on Connected Probes is available to all service class licenses.

To access Connected Probes, navigate to Utility (second page) > Service > Home.

Figure 7-25 Connected Probes

This table shows all the elements available on Connected Probes with descriptions.

Table 7-15 Connected Probes

Element Description

) When available, temperature of the active probe.
Active Probe Temperature

(Celsius) Not all probes report temperature. The most common probe to report temperature is
the TEE probe.

Probe Name Name of the probe connected to the LOGIQ Fortis.

Probe ID Identifier of the probe connected to the LOGIQ Fortis.

Serial number of the probe connected to the LOGIQ Fortis. If the serial number of

Serial Number the probe is not available, then N/A displays.

Statuses of the probe connected to the LOGIQ Fortis. Valid values are:
Status « Active

« Non Active

For more information, see:

*+ "Home" on page 7-16
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7-4-6

Diags

Use Diags to troubleshoot functionality with hardware components. With an active Service PRO
license, probe diagnostics will be available. Specifically, use these pages:

* Run Diags — Run diagnostics on hardware components.
+ Diag History — View a history of the diagnostics you have run and the results.

NOTE: Reboot the LOGIQ Fortis after performing any diagnostics before returning the LOGIQ Fortis to
customer use.
For more information, see:
* "Run Diags" on page 7-42
+ "Diag History" on page 7-45
» "Diagnostics" on page 7-90
Run Diags
With Disruptive mode set to On, use Run Diags to run diagnostics on hardware components with the
LOGIQ Fortis. For information on disruptive mode, see "Disruptive Mode" on page 7-65.
The information on Run Diags is available to Class C and Class M licenses.
To access Run Diags, navigate to Utility (second page) > Service > Diags > Run Diags.
Figure 7-26 Run Diags
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7-4-6

Diags (cont’d)

This table shows all the elements available on Run Diags with descriptions.

Table 7-16 Run Diags

Element

Description

Service Menu

Available service diagnostics in a diagnostics tree.

Engineering Menu

Available engineering diagnostics in a diagnostics tree.

Clear All

Resets the selections within the diagnostics tree.

Selected Diagnostics

Diagnostics that have been selected.

Diagnostic Detail

Test Name

Name of the diagnostic.

Last Execution Result

Result of the diagnostic run.

Expected Execution Time

Time expected to run the diagnostic.

Maximum Execution Time

Maximum amount of time allowed to run the diagnostic.

Instruction

Special instructions needed in order to perform the diagnostic.

Diagnostic Controls

Execution Mode

Way the diagnostic behaves when a failure occurs. Valid values are:
+ Continue on Failure

« Finish Loop and Stop on Failure

« Stop on Failure

Loop Count Number of times to run the selected diagnostic.
Start Starts the selected diagnostic.

Stop Stops the selected diagnostic.

Reset Clears the current diagnostic information.

Total Progress

Current Progress

Progress the current diagnostic.

Total Progress

Progress for all of the selected diagnostics.

Diagnostic Results Summary

Diag Name Name of the diagnostic.
Date/Time Date and time of the diagnostic run.
Diag Run Time Amount of time taken to run the diagnostic.

Overall Status

Current status of the diagnostic.

Pass/Fail

Whether the selected diagnostic passed or failed.
« Green — Diagnostic passed
* Red - Diagnostic failed
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7-4-6 Diags (cont’d)
To run a diagnostic:

1.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set
Disruptive mode to On.

2.) Navigate to Utility (second page) > Service > Diags > Run Diags.

3.) From the Service Menu tab, select the diagnostic (For example, DPI_L). The Selected
Diagnostics and Diagnostic Detail areas populate with information specific to the selected
diagnostic.

4.) In Execution Mode, select the desired mode.
5.) In Loop Count, select the number of times to run the diagnostic.
6.) Click Start.

7.) View progress in the Total Progress area.
8.) View the results (Passed or Failed) in the Diagnostic Results Summary area.

9.) To view details about the diagnostics run, see "Diag History" on page 7-45.
For more information, see:

+ "Diags" on page 7-42

» "Diag History" on page 7-45
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7-4-6 Diags (cont’d)
Diag History

Use Diag History to view a history of the diagnostics run on the LOGIQ Fortis and the results.
The information on Diag History is available to Class C and Class M licenses.

To access Diag History, navigate to Utility (second page) > Service > Diags > Diag History.

Figure 7-27 Diag History

This table shows all the elements available on Diag History with descriptions.

Table 7-17 Diag History

Element Description

Checkpoints

Select All Selects all of the available checkpoints in the list.
Controls

All Filters results to show all of the diagnostics.
Failed Filters results to show failed diagnostics.

Get History Select to display a history of the run diagnostics.
Runs

List of diagnostics run on the LOGIQ Fortis.

Diagnostic Results History

Details about the diagnostics run.

Chapter 7 Diagnostics/Troubleshooting 7-45



GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

7-4-6 Diags (cont’d)

To view a history of diagnostics:

1.) Navigate to Utility (second page) > Service > Diags > Diag History.
2.) Select the options that you want to view.

3.) Click Get History.

4.) View the results of your query.

5.) To view specific details, click Details

Last Start Time:

Diog Run Time

For more information, see:

+ "Diags" on page 7-42
* "Run Diags" on page 7-42
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7-4-6 Diags (cont’d)
Operator Test Panel
In LOGIQ Fortis uses Operator Test Panel to test the following controls:

- LEDs

* A/N Keyboard

»  Buttons/Joysticks

* Encorders

The information on Operator Test Panel is available to Class C and Class M.

To access Operator Test Panel, navigate to Utility (second page) > Service > Diags >
Operator Test Panel.

Figure 7-28 Operator Test Panel

Operator Panel Tests Lawes Opasator Panal Tasts
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7-4-7

DICOM

Use DICOM to troubleshoot DICOM components and connectivity. Specifically, use these pages:

 DICOM Service Status
» DICOM Spooler
For more information, see:

+ "DICOM Service Status" on page 7-48

+ "DICOM Spooler" on page 7-50

DICOM Service Status

DICOM Service Status displays information on the DICOM components and connectivity. Use DICOM

to test the connectivity of all the available DICOM devices or individual DICOM devices. In addition, you
can:

* View DICOM details

* View DICOM connectivity status

+ Stop a service

* Ping a single service

* Ping all services

DICOM connectivity status displays as green or red.

* Green means that the DICOM ping passed
* Red means that the DICOM ping failed
The information on DICOM Service Status is available to Class C and Class M licenses.

To access DICOM Service Status, navigate to Utility (second page) > Service > DICOM > DICOM
Service Status.

Figure 7-29 DICOM Service Status
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7-4-7 DICOM (cont’d)
This table shows all the elements available on DICOM Service Status with descriptions.

Table 7-18 DICOM Service Status

Element Description
DICOM Details
AE Title of Console Application entity title of the LOGIQ Fortis.
Port No of Console Port number of the LOGIQ Fortis.

DICOM Connectivity Status

Service Name Name of the DICOM services configured for the LOGIQ Fortis.

Status of the DICOM service. Valid values are:

*« OK
* Not Ok
Status )
* Not Ping
* Ping in progress
* Queued
Error Details Details for any errors associated DICOM services.
Type Type of error.
Device Name Name of the device.
AE Title Application entity title for the device.
IP Address IP address for the device.
Port Port for the device.
Ping Device Select to confirm that a device is connected or not.

For more information, see:

+ "DICOM" on page 7-48
+ "DICOM Spooler" on page 7-50
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7-4-7 DICOM (cont’d)
DICOM Spooler
DICOM Spooler provides a summary of the current and recent outgoing jobs.
The information on DICOM Spooler is available to Class C and Class M licenses.

To access DICOM Spooler, navigate to Utility (second page) > Service > DICOM > DICOM Spooler.

Figure 7-30 DICOM Spooler

7-50 Section 7-4 - Service Desktop



Direction 5874372, Rev. 3

GE CONFIDENTIAL

LOGIQ Fortis Proprietary Service Manual

7-4-7

DICOM (cont’d)

This table shows all the elements available on DICOM Spooler with descriptions.

Table 7-19

DICOM Spooler

Element

Description

Job Status

Displays the number of jobs for each type by status. For example, Pending.

Spooler Health

DICOM Spooler

Space allotted to DICOM jobs on the E: drive.

Free Space

Available space on the E: drive.

Total Size of the E: Drive

Total space on the E: drive.

Spooler Summary

Job ID

Number for the job.

Job Status

Current status of the job. These are the valid values:
* Pending

« Active

* Hold

* Done

» Success

« Failed

Job Type

Type of job. These are the valid values:

« Storage — Images

« Structured Reports

« Key Image Notes

« STC — Storage Commitment

* MPPS - Modality Performed Procedure Step

Destination

Name of service receiving the objects.

Age

Amount if time the job has been in the spooler.

Spooler Entry time

Time the job entered the spooler.

Transfer time

Time the job was transferred from the spooler.

Job Size

Size of the job.

Error details

If applicable, details for the error.

For more information, see:

+ "DICOM" on page 7-48
+ "DICOM Service Status" on page 7-48
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7-4-8

Utilities

Utilities configurations vary depending upon the service class.

For more information, see:

"Backup and Clean LogDb" on page 7-53
"Change Password" on page 7-54
"Checkpoints" on page 7-56

"Clean Userdefs" on page 7-58

"Data Transfer" on page 7-60

"Delete Files" on page 7-63

"Disk Defragment" on page 7-64
"Disruptive Mode" on page 7-65

"Gather Logs" on page 7-67

"Network Capture" on page 7-68

"Reset Patient Database" on page 7-71
"Resolve Agent Quarantine" on page 7-73
"Secure Delete" on page 7-74

"SSA License" on page 7-76

"Software Reload" on page 7-78

"Third Party Software Licenses" on page 7-80
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7-4-8  Utilities (cont’d)
Backup and Clean LogDb

Backup and Clean LogDb allows you to

Figure 7-31 Backup and Clean LogDb

®
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7-4-8  Utilities (cont’d)
Change Password

Change Password allows you to change the password for a specified user type.

A CAUTION RISK OF LOSING DATA.

IF THE PASSWORD IS LOST, GE WILL NOT BE ABLE TO RECOVER OR RESET IT.
LOSS OF A PASSWORD MAY RESULT IN THE LOSS OF PATIENT DATA.

The information on Change Password is available to all service class licenses. Change Password is
not available through a remote connection.

To access Change Password, select Utility (second page) > Service > Utilities > Change
Password.

Figure 7-32 Change Password

Q@ Change P

This table shows all the elements available on Change Password with descriptions.

Table 7-20 Change Password

Element Description

Type of user for the password reset.
User Type * GEService — Windows user for GE Service.
« SVCService — Windows user loaded with the base image load software.

New password according to the password requirements (14-25 characters including

New Password
one upper cap, one lower cap, one number, and one symbol).

Confirm Password Password you entered in New Password.
Update Password Select to update the password.
Reset Select to reset the information.
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7-4-8  Utilities (cont’d)

NOTE:

A CAUTION

To change the password:

Before changing the GEService password (the default is SvcForward123$), make sure the
LOGIQ Fortis is connected to the network and the agent is configured. The GEService
password is used to perform portions of remote service. If the password is changed and the
LOGIQ Fortis information is not updated, it may slow down remote service. Both file transfer
and SSH depend on the GEService password.

To change the service desktop user password:

1.) Navigate to Utility (second page) > Service > Utilities, and then select Change Password.
2.) From User Type, select one of the following:

- GEService — This is the Windows user for GE Service. Both file transfer and SSH depend on
this user and password combination. When using SSH in FFA, the user and password will
always be requested. Entering the incorrect password multiple times will lock you out. When
changing this password, the LOGIQ Fortis should be online (check the online icon at the
bottom of the screen) so the back office updates. If the password is changed when offline, the
back office will not be updated and you will have to change the password again with the
LOGIQ Fortis online. There is no notification when this password has been changed.
Changes to this password do not affect logs sent to the GE Service data lake.

- SVCService — This is the Windows user loaded with the base image load software. You will
never be prompted for this password. When it is set to default (no password selected), a
randomly generated password will be supplied by the LOGIQ Fortis. If this password is
changed with Change Password, the base image software will automatically store the new
password in the LOGIQ Fortis and it will be fixed to the value entered. The SVCService
password will not be requested of any user. It is only used by the LOGIQ Fortis software.

RISK OF LOSING DATA.

GE WILL NOT BE ABLE TO RECOVER OR RESET CHANGED PASSWORDS.
SECURELY RECORD THE NEW PASSWORD.

3.) In New Password type a new password according to the password requirements (14-25 characters
including one upper cap, one lower cap, one number, and one symbol).

4.) In Confirm Password, type the new password.
5.) Click Update Password. The following message displays if the LOGIQ Fortis is offline.

Password changed successfully, but failed to update new password at back
office. This password is used by GE Remote service to perform portions of remote

service. This may slow down remote service because GE will need to get the
password from you.

6.) When a SVCService user password has been changed, reboot the LOGIQ Fortis to reflect the
password change.

For more information, see:

« "Utilities" on page 7-52
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7-4-8  Utilities (cont’d)
Checkpoints

Checkpoints allows for the creation of checkpoints and displays the history of those checkpoints.
Checkpoints are used to indicate when the LOGIQ Fortis has been serviced, status has been reset, and
information related to the service performed has been added.

The information on Checkpoints is available to Class C (Service Advanced and Service Expert) and
Class M licenses.

To access Checkpoints, select Utility (second page) > Service > Utilities > Checkpoints.

Figure 7-33 Checkpoints

7-56 Section 7-4 - Service Desktop



GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

7-4-8  Utilities (cont’d)
This table shows all the elements available on Checkpoints with descriptions.

Table 7-21  Checkpoints

Element Description

Checkpoints History

Checkpoint Displays the name of the checkpoint.

Service Personnel Displays the ID for the logged in user.

Action Displays the service action.

Comment Displays comment text entered when the checkpoint was created.
Service Checkpoint Displays whether the checkpoint is a service checkpoint or not.

Create Checkpoint

Selects the service action. Value values are
+ Scheduled Maintenance

Action * Unscheduled Maintenance

* Upgrade

* FMI

ID for the logged in user. Value values are:
» SSO ID — When a Class M key is plugged in, the SSO ID for the logged in user.
* Remote user ID - If there is a remote connection, the remote user ID.

« User ID — If the SSO ID and remote user ID are not available, the user ID for the logged
in user.

Service Personnel

* Unknown — The logged in user ID is not available.

Comment Enter comments for creating a checkpoint.
Service Checkpoint Select whether to mark a service checkpoint or not.
Save Saves the information.

To create a check point:

1.) Navigate to Utility (second page) > Service > Utilities > Checkpoints.
2.) Under Create Checkpoints, from Action, select the action.

3.) In Comment, enter notes for the checkpoint.

4.) If this is a checkpoint for service, select Service Checkpoint.

5.) Click Save.

For more information:

+ "Utilities" on page 7-52
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7-4-8

Utilities (cont’d)

Clean Userdefs

Clean Userdefs provides a way to delete user-defined data when user presets may be inhibiting proper
operation. User-defined data returns to the user-defined settings to the factory default values. Clean
Userdefs provides information to backup the current settings if you want to use them later. Disruptive
mode must be On to clean user-defined data. If Disruptive mode is Off, a warning message displays
asking to turn on Disruptive mode.

Before cleaning user-defined data, the LOGIQ Fortis application software automatically shuts down.
Once the operation is complete, the LOGIQ Fortis reboots.

Clean Userdefs provides a way to selectively delete the following user-defined data:

* Connectivity — Deletes this file: % TEST_ROOT%\resources\userdefs\connectivity.res

» Imaging — Deletes this folder: % TEST_ROOT%\resources\userdefs\ImagingPresets\

* Measurement — Delete this folder: % TEST ROOT%\resources\userdefs\EchoMeasure\

*  Annotation/Bodymark — Deletes the folder: % TEST_ROOT%\resources\userdefs\EchoAnnotation\
* Scan Assistant — Deletes the folder: % TEST _ROOT%\resources\userdefs\EchoExamProtocol
The information on Clean Userdefs is available to Class C (Service Expert) and Class M licenses.

To access Clean Userdefs, select Utility (second page) > Service > Utilities > Clean Userdefs.

Figure 7-34 Clean Userdefs
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7-4-8

Utilities (cont’d)

This table shows all the elements available on Clean Userdefs with descriptions.

Table 7-22 Clean Userdefs

Element

Description

All

When Disruptive mode is ON, deletes all of the user-defined data and returns the
LOGIQ Fortis to factory default settings.

Selective Delete

When Disruptive mode is ON, deletes the selected user-defined data.

When Selective Delete is selected, deletes this file:

Connectivity D:\scanner\target\resources\userdefs\connectivity.res
Imaain When Selective Delete is selected, deletes this folder:
9ing D:\scanner\target\resources\userdefs\ImagingPresets\
When Selective Delete is selected, delete this folder:
Measurement

D:\scanner\target\resources\userdefs\EchoMeasure\

Annotation/Body Patterns

When Selective Delete is selected, deletes this folder:
D:\scanner\target\resources\userdefs\EchoAnnotation\

Scan Assistant

When Selective Delete is selected, deletes this folder:
D:\scanner\target\resources\userdefs\EchoExamProtocol

Clean Userdefs

Restarts the application software with a fresh database.

To clean user-defined data:

1.) If you want to use the current settings later, back them up now.
2.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set

Disruptive mode to On.

3.) Navigate to Utility (second page) > Service > Utilities > Clean Userdefs.
4.) Select the data you want to set to the default settings.

5.) Click Clean Userdefs.
For more information, see:

« "Utilities" on page 7-52
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7-4-8  Utilities (cont’d)
Data Transfer
Data Transfer provides a way to do the following:

+ View information about past transfers of (APM) information.

» Set up automatic/scheduled transfer of allowed data files from the LOGIQ Fortis to the server.
» Manually transfer data files allowed data files from the LOGIQ Fortis to the server.

The information on Data Transfer is available to all service class licenses.

To access Data Transfer, select Utility (second page) > Service > Utilities > Data Transfer.

Figure 7-35 Data Transfer

Type of Upload Upload Permission Last Upload Status Last Upload Attempt Last Successful Attempt
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7-4-8  Utilities (cont’d)

Figure 7-36 Date Transfer

Type of Uplosd Uplosd Bermasaa Last Upload $tatus Last Uplesd Attempt Last Sudcesatl Altempt

This table shows all the elements available on Data Transfer with descriptions.

Table 7-23 Data Transfer

Element Description

Type of log file. For example, Incremental Logs or Full Logs. Monitoring Logs,
System Logs, and Windows Logs are incrementally transferred when automatic
transfer is enabled. To enable automatic transfer, navigate to System Admin and,
under Service, check Enable Automatic Request for Service.

Type of Upload

Upload Permission Whether the permission to upload the log file is allowed or not.
Last Upload Status Whether the last log file upload was successful or not.

Last Upload Attempt Date and time the last log file upload was attempted.

Last Successful Upload Date and time the last log file was successfully uploaded.

When selected, type of log file to transfer. Making these selections will limit the data

Type of Upload flow to the data lake.
When selected, enables the related day selections. For example, All Days,
Scheduler
Monday, and Tuesday.
Save Settings Saves the information.
Send All Manually send the selected log files to the server.
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7-4-8  Utilities (cont’d)
To configure automatic data transfers:

1.) Navigate to ADMIN > System Admin.

2.) On System Admin, configure these settings:
- Transfer Machine Logs to GE — Default is checked
- Transfer Operator Information to GE
- Transfer Images (captured without patient information) to GE — Default is checked.
3.) Click Save.
4.) Navigate to Utility (second page) > Service > Utilities > Data Transfer.
5.) On Data Transfer, select Scheduler, and then select the days to perform the data transfer.
6.) Click Save Settings.
7.) To manually perform a data transfer, click Send All.
For more information:

« "Utilities" on page 7-52
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7-4-8  Utilities (cont’d)
Delete Files

Delete Files displays all the files and folders present in the D:\Service folder and allows for their
deletion. Deleting unneeded files improves performance and reduces the need to defragment the disk
drive.

The information on Delete Files is available to all service class licenses.

To access Delete Files, select Utility (second page) > Service > Utilities > Delete Files.

Figure 7-37 Delete Files

8 Delete Files

W D:/Service

~ & W image

This table shows all the elements available on Delete Files with descriptions.

Table 7-24 Delete Files

Element Description

Delete Files Displays the files that are available for deletion.

Delete Deletes the selected files.

To delete files:

1.) Navigate to select Utility (second page) > Service > Utilities > Delete Files.
2.) Under Delete Files, select the available folders and files that you want to delete.
3.) Click Delete.

4.) In the resulting dialog box, click Delete and then click OK.

For more information, see:

« "Utilities" on page 7-52
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7-4-8

Utilities (cont’d)

Disk Defragment

Disk Defragment provides a way to launch the Windows Disk Defragmenter tool to use to defragment
the disks. Disk fragmentation can reduce the amount of disk space available, and slow computing
speed. Use the disk defragmenter to restore optimum disk space and speed performance. If LOGIQ
Fortis performance would be significantly reduced when the disk is being defragmented, a warning
message displays. It is not possible to analyze the SSH drives.

The information on Disk Defragment is available to Class C (Service Advanced and Service Expert)
and Class M licenses. Disk Defragment is not available through a remote connection.

To access Disk Defragment, select Utility (second page) > Service > Utilities > Disk Defragment.

Figure 7-38 Disk Defragment

Please use the disk defragment window to start disk drive optimization (Defragl.
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dafragmented.

To analyze, optimize, or schedule optimization for a disk:

1.) Navigate to Utility (second page) > Service > Utilities > Disk Defragment.
2.) Click Launch Disk Defragmenter.

3.) In the Optimize Drives dialog box, select the drive.

My Optimize Drives = g

You can optirmize your drives to help your computer run more efficiently, or analyze them te find out if they need to be
eptimized, Only drives on or connected te your computer are shown,

Status

Drive Media type Las Currant status ~
Salid state drive
s User (D:) Hard disk drive - rnented)
= ARCHIVE (E:) Hard disk drive

= System (1)

fragmented)

s SARATH (F:) Remaovable drive n not svailable
= DVR (V) Hard disk drive fragmented]
== Reposit (Z:) Sofid state drive ys since last run)
Dasnsinns . i i 2 v
Optimize
Scheduled optimization
On Change gettings

Drives are being optimized automatically.
Frequency: Weeldy

Close

4.) To analyze the selected drive, click Analyze.
5.) To optimize the selected drive, click Optimize.

6.) To set up a schedule, click Change settings and select the schedule.
For more information, see:

» "Utilities" on page 7-52

Section 7-4 - Service Desktop



GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

7-4-8  Utilities (cont’d)
Disruptive Mode

Disruptive Mode provides a way to enable and disable Disruptive mode. When enabled, Disruptive
mode allows a remote user to access the LOGIQ Fortis which can disrupt normal operation of the
LOGIQ Fortis. Disruptive mode can be remotely turned on when the logged-in user has Authorize
Remote Service Access privilege. If the logged-in user does not have remote service privilege, displays
this error message: “You do not have the required permission to perform this operation.”

When initiating Disruptive mode from a remote location, a message displays on the LOGIQ Fortis asking
whether the user will allow Disruptive mode and notifying them that normal operation might be disturbed.

» If Yes is selected, then Disruptive mode is turned on.
+ If Nois selected, then Disruptive mode is not turned on and an error message displays saying that
permission to change the mode was denied.

When Disruptive mode is On, the GE icon in the status bar changes to red and displays this message:
“Due to Service testing restart needed.”

When Disruptive mode is changed to Off, the GE icon turns white and displays this message: “Due to
Service testing restart needed.” In addition, VCO and SSH stop if running.

The information on Disruptive Mode is available to Class C (Service Advanced and Service Expert)
and Class M licenses.
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7-4-8  Utilities (cont’d)

To access Disruptive Mode, select Utility (second page) > Service > Utilities > Disruptive Mode
Utility.

Figure 7-39 Disruptive Mode

Date of Last Modification Tue, Jun 12 :

This table shows all the elements available on Disruptive Mode Utility with descriptions.

Table 7-25 Disruptive Mode Utility

Element Description

Indicates whether the LOGIQ Fortis is in Disruptive mode or not. Valid values are:
Disruptive Mode Status o Enabled — Disruptive mode is on.
o Disabled — Disruptive mode is off.

Date of Last Modification Date the LOGIQ Fortis was last enabled or disabled.

Select this check box and then select Enable to place the LOGIQ Fortis into
Start SSH Disruptive mode and start the Secure Shell (SSH) server. The SSH server can also
be started from the SSH utility.

Select this check box and then select Enable to place the LOGIQ Fortis into
Stop SSH Disruptive mode and stop the Secure Shell (SSH) server. The SSH server can also
be stopped from the SSH utility.

Select this check box and then select Enable to place the LOGIQ Fortis into
Start VNC Disruptive mode and start the Virtual Network Computing (VNC) server. The VNC
server can also be started from the Virtual Console Observation utility.

Select this check box and then select Enable to place the LOGIQ Fortis into
Stop VNC Disruptive mode and stop the Virtual Network Computing (VNC) server. The VNC
server can also be stopped from the Virtual Console Observation utility.

Enable Select to enable Disruptive mode.

Disable Select to disable Disruptive mode.

For more information:

« "Utilities" on page 7-52
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7-4-8  Utilities (cont’d)
Gather Logs

Gather Logs provides a way to collect system logs and place the log files in the D:\Service directory for
retrieval by the online center. These log files do not include protected data such as crash dumps and
keyboard shadow logs. The customer can collect logs (including protected data) using Alt+D when
Protected Data is checked. Log files are compressed into a .zip file and the file path and name display.
If the application software is not running, use the Gather Logs shortcut on the Windows desktop.

The information on Gather Logs is available to all service class licenses.

To access Gather Logs, select Utility (second page) > Service > Utilities > Gather Logs.

Figure 7-40 Gather Logs

This will gather up logs and presats. 1t will thin ploce them i the service directory for retrieval by the On Line Centor.

This vl mat inchuda pratected data such ax crash dumps and kirpboard shadous logs. f you need this information ask the customer to collect the Ings using
Alt-0 with the ‘inchide pratected data’ bas checked,

This table shows all the elements available on Gather Logs with descriptions.

Table 7-26  Gather Logs

Element Description
1 Day Logs When selected, gathers log files for one day.
1 Week Logs When selected, gathers log files for one week.
All Logs When selected, gathers all available log files.
Gather Logs Select to gather the log files for the selected time period.

To gather log files:

1.) Navigate to Utility (second page) > Service > Utilities > Gather Logs.
2.) Select one of the following:
- 1 Day Logs
- 1 Week Logs
- AllLogs
3.) Click Gather Logs. In the resulting dialog box, record the location of the log files and click OK.

4.) When the gather log operation is complete, click the notification icon in the banner to view the
location of the log files.

For more information, see:

+ "Utilities" on page 7-52
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7-4-8  Utilities (cont’d)
Network Capture

Network Capture displays network traffic between the LOGIQ Fortis and configured devices. A network
capture outputs two log files: one for main logging with no protected information and another including
protected information. These log files are useful when debugging connectivity issues. Because these

log files can be large, they are only kept for one week.

The information on Network Capture is available to all service class licenses.

To access Network Capture, select Utility (second page) > Service > Utilities > Network Capture.

Figure 7-41 Network Capture
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7-4-8  Utilities (cont’d)

This table shows all the elements available on Network Capture with descriptions.

Table 7-27 Network Capture

Element

Description

Network Capture Parameters

Maximum Size

Allowed size of the generated log file. Valid value are:
+ 256MB

+ 512MB

+ 1024MB

Devices

DICOM-configured devices for which you want to capture information. If no
additional devices are configured, only All will be available.

Start Network Capture

Select to start the process. This causes the network capture to start, enables the
Stop button, and updates the Network Capture Status pane and changes the
Status to Running.

Stop Network Capture

Select to stop the process.

Network Capture Status

Displays information about the status of the network capture. The language setting
for this information is set in Windows and not through the Service desktop or
LOGIQ Fortis application software.

Displays the current status of the network capture. Valid values are:
* Not Running
* Running
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7-4-8  Utilities (cont’d)

To perform a network capture:

1.) Navigate to Utility (second page) > Service > Utilities > Network Capture.

Metwork Capture

2.) From Network Capture, do the following:
- Under Maximum Size, select the allowed size of the generated log file.

- Under Devices, select the DICOM-configured device for which you want to capture
information. If no additional devices are configured, only All will be available.

3.) Select Start Network Capture to start the process. This causes the network capture to start,

enables the Stop button, and updates the Network Capture Status pane and changes the Status
to Running.

4.) Click the Stop button to end data collection. Stopping is a two-step process:
- Stops the data collection and immediately closes the .etl file.

- Collects additional diagnostic data that may help diagnose network issues. When the file is
closed, you see “There is no trace session currently in progress”. When the remaining data is
collected and the .cab file is closed, you are notified in the banner.

Metwork Copture

For more information, see:

« "Utilities" on page 7-52
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7-4-8  Utilities (cont’d)
Reset Patient Database

Reset Patient Database resets the LOGIQ Fortis patient database. This operation automatically shuts
down the application before cleaning the patient database. Once the operation is complete, the LOGIQ
Fortis reboots with an empty database. Disruptive mode must be On to reset the patient database. If
Disruptive mode is Off, a warning message displays asking to turn on Disruptive mode.

Reset Patient Database deletes the contents of the following folders:

+ E:\ScannernGEMS_IMG

+ E:\ScannernGEMS_REP

The information on Reset Patient Database is available to Class C (Service Expert) and Class M
licenses.

To access Reset Patient Database, select Utility (second page) > Service > Utilities > Reset Patient
Database.

Figure 7-42 Reset Patient Database

& Reset Patient Database

Bl Instruction

This tool will reset the system patient database to an
empty one. Before resetting the database, the scanner
software will shutdown automatically. Once the process
is complete, the system will reboot.

NOTE: Backup the patient database and any images
if needed. Use the scanner application’s backup and
restore feature under Utility->System tab.
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7-4-8  Utilities (cont’d)
This table shows all the elements available on Reset Patient Database with descriptions.
Table 7-28 Reset Patient Database
Element Description
Instruction Information about the database reset.
Reset Patient Database When Disruptive mode is ON, resets the LOGIQ Fortis patient database.
To reset the patient database:
1.) Back up the patient database.
2.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set
Disruptive mode to On.
3.) Navigate to Utility (second page) > Service > Utilities > Reset Patient Database.
4.) Click Reset Patient Database.
5.) Confirm the patient database has been emptied.
For more information, see:
« "Utilities" on page 7-52
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7-4-8  Utilities (cont’d)

Resolve Agent Quarantine

LOGIQ Fortis Resolve Agent Quarantine is available on the Service Desktop. Resolve Agent
Quarantine allows you to move the LOGIQ Fortis out of quarantine after an agent update.

Figure 7-43 Resolve Agent Quarantine - Submit

@ Resolve Agent Quarantine

Old Serial b

Old Model Number CS_ULS_LOGIQ_E10_ROLS ﬂ

+ Command successfully send to back office. It may take around 5 minutes to resolve the

quarantine state. If agent quarantine state is not resolved after that time, please contact GE
Service.

This functionality resolves the agent from quarantine state only during agent upgrades. If agent
goes to quarantine due to any other reason, this utility will not fix the quarantine issue.

Figure 7-44 Resolve Agent Quarantine - No Quarantine

@ Agent is not in quarantined state.

This functionality resolves the agent from quarantine state only during agent upgrades. If agent
goes to quarantine due to any other reason, this utility will not fix the quarantine issue.

To resolve a quarantine in Agent Configuration:

1.) From Utility (second page) > Service > Utilities, select Resolve Agent Quarantine.
2.) View the information in Old Serial Number and Old Model Number.
3.) If the information is correct, select Submit.
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7-4-8

NOTE:

Utilities (cont’d)

Secure Delete

Secure Delete will be available on the Service desktop. As part of Privacy and Security, this utility
allows you to delete files on the D:/ and E:/ drives returning the LOGIQ Fortis to a factory clean state,
including the deletion of log files, unless presets are restored.

Secure Delete does not provide a report or log file that can be used as report.

The Secure Delete deletion process encrypts the data on the E:/ drive and then deletes the recovery
keys. This renders all data on the E:/ drive unrecoverable. The D:/ and E:/ drives are then reformatted.
An empty database is then loaded onto the E:/ drive, and if any are selected, userdefs (presets) are
reloaded onto the D:/ drive.

Use the Delete Files utility to improve performance. This utility deletes image files from the
Service folder but does not render the data unrecoverable.

The information on Secure Delete is available to all service classes. Secure Delete is not available
through a remote connection.

To perform a secure deletion of files on the D:/ and E:/ drives:

1.) Insert an activated SSA key.

2.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set
Disruptive mode to On.

3.) From Utilities, select Secure Delete. The Secure Delete utility displays.

NOTE: This operation will format the contents of D and E drives and patient data will be lost. Backup the patient database and any images if needed. Use the
scanner application’s backup and restore feature under Utility->System tab.

4.) Select Secure Delete, and then select OK.
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7-4-8  Utilities (cont’d)

5.) Inthe Secure Delete selection dialog box, select one of the following:

- Factory Default: This selection deletes all information on the D:/ and E:/ drives and reformats
these drives to the factory default settings.

- Perform Partial Secure Delete: This selection enables the Partial Delete Options and
allows you to select from the check boxes. Partial Delete Options allows you to keep
information per customer request.

SECURE DELETE

SECURE DELETE

WARNING: YOU WILL NOT BE ABLE TO RECOVER DATA
ON THIS SYSTEM AFTER SECURE DELETE.

THIS WILL TAKE ABOUT 2 MINUTES.
SYSTEM WILL BE RESTARTED. DO NOT SHUTDOWN SYSTEM.
" FACTORY DEFAULT [Delete all data permanently)
" PERFORM PARTIAL SECURE DELETE [Please check optioris)

5 N [N

[ 1 agree to delete data on this system.

RESTART SYSTEM

6.) If you selected Perform Partial Secure Delete, under Partial Delete Options, select from the
following:

- Keep system settings — Select to retain general system configuration, measurement,
analysis, video, and backup and restore settings made under Utility > System.

- Keep imaging presets — Select to retain exam and imaging parameter settings made under
Utility > Imaging.

- Keep application presets — Select to retain application- and user-specific settings made
under Utility > Application.

- Keep service presets — Select to retain remote connectivity settings made under Utility >
Connectivity.

7.) Select the | agree to delete data on this system check box.

8.) Select Start Secure Delete. After performing secure delete, the LOGIQ Fortis automatically
restarts.

NOTE: To terminate the Secure Delete dialog box and immediately restart the LOGIQ Fortis, use the
Restart System button.
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7-4-8  Utilities (cont’d)
SSA License
SSA License provides a way to do the following:
*  When inserted, view the details of an SSA key.
* View the status of the service class options.
* Restore an SSA license when the SSA key is not validating or when a remote log in shows as a
Class A user.
The information on SSA License is available to all service class licenses.
To access SSA License, select Utility (second page) > Service > Utilities > SSA License.
Figure 7-45 SSA License
This table shows all the elements available on SSA License with descriptions.
Table 7-29 SSA License
Element Description
Class M Key Details
Status of the SSA key. Valid values are:
Class M Key Status » Not Plugged In
* Plugged In
Drive Letter Drive where the SSA key is plugged into the LOGIQ Fortis.
Expire Date Date the SSA key is set to expire.
SSO ID Identifier for the user assigned to the SSA key.
Key Counter Value Number of times the SSA key has been used.
Max Key Counter Value Number of remaining times the SSA key can be used.
Service Option Keys
Name Name of the service class option.
Status of the access to the associated service class option. Valid values are:
Status * True
 False
Restore SSA Restores the SSA license to the SSA key.
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To view the Class M license information:

1.) Insert the SSA key.
2.) Navigate to Utility (second page) > Service > Utilities > SSA License.

3.) Under Class M key Details, view the values. For example, the SSO ID for the user assigned to the
SSA key.

If Not Available displays for all of these values, the SSA key is not validating.
To restore an SSA key that is not validating:

1.) Remove the SSA key from the LOGIQ Fortis.

2.) If open, close the Service desktop.

3.) Restart the LOGIQ Fortis.

4.) Once the LOGIQ Fortis has restarted, plug in the SSA key.

5.) Navigate to Utility (second page) > Service > Utilities > SSA License.
6.) Click Restore SSA.

7.) Check to see if the SSA key validates.

For more information, see:

+ "Utilities" on page 7-52
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7-4-8

Utilities (cont’d)

Software Reload

Software Reload displays versions of the base image, application software, base patch, service
platform, and documentation packages currently installed on the LOGIQ Fortis. Software Reload
reimages the C:\ drive and installs the base image.

Software Reload indicates whether the disks have been encrypted. If the disk is encrypted AND locked,
when you open Software Reload, this message displays instead of the Software Reload button.

4@ The disks are locked. Go to Utility->Admin->Disk Encryption page and  ~

unlock the disks before proceeding Software Reload

The message above will not prompt if Encryption is Off, On with disks unlocked automatically, or On
with the key stored on USB/password is entered manually (Disks not locked.)

With Disruptive mode set to On, reload these software versions from repository partition on the hard
drive. The software reload is automatic without any loss of presets, patient data, or connectivity settings.

The information on Software Reload is available to Class C (Service Expert) and Class M licenses.

To access Software Reload, select Utility (second page) > Service > Utilities > Software Reload.

Figure 7-46 Software Reload
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7-4-8  Utilities (cont’d)

& CAUTION

This table shows all the elements available on Software Reload with descriptions.

Table 7-30 Software Reload

Element Description
Base Image Version Displays the version number of the base image software.
Base Patch Version Displays the version number of the base patch.
Application Software Version Displays the version number of the application software.
Service Platform Version Displays the version number of the service platform.
Documentation Version Displays the version number for the documentation.
Software Reload Reloads the versions listed.

To reload software:

1.) If the drives are encrypted, obtain the recovery key.

2.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set
Disruptive mode to On.

3.) Navigate to Utility (second page) > Service > Utilities > Software Reload.

4.) If the disk is encrypted AND locked, follow the instructions on this message and then return to
Software Reload.

/@ The disks are locked. Go to Utility->Admin->Disk Encryption page and *

unlock the disks before proceeding Software Reload

5.) View the current version numbers.
6.) Click Software Reload.

RELOADING SOFTWARE WITHOUT A RECOVERY KEY WILL RESULT IN THE LOSS OF
PATIENT DATA.

7.) If you have a recovery key, select | have a recovery key and then click Continue.

Sftwire Reload

8.) If you have a recovery key, select | Agree and then click Continue Reload.

Softwore Relood

U o ot have the recovery key, you will lose 3 the Patient Data. If you want to continue, then seiect 1 Agre’

© o | X s

9.) Ifthe SVCService and/or GEService passwords have been changed, these passwords will need to
be updated on Change Password after software is reloaded.

For more information, see:

+ "Utilities" on page 7-52
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Third Party Software Licenses

Third Party Software Licenses displays the third-party software licenses used as part of the service
platform.

The information on Third Party Software Licenses is available to all service class licenses.

To access Third Party Software Licenses, select Utility (second page) > Service > Utilities > Third
Party Software Licenses.

Figure 7-47 Third Party Software Licenses

N Third Party Software Licenses

accepts(1.3.3)

License Information

For more information, see:

+ "Utilities" on page 7-52
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7-4-9 Options

Use Options to:

* View software options.
* View software option details.

» Add (or delete) a valid option key, add a duplicate option key, not add an invalid option key, and ask
for confirmation before deleting an option key.

* View software option key details. Key details are a list of options that are enabled by a particular
key. Under Available Keys, highlight the option string, select Details and then view the options on
the left side of the screen. Press Show All to view all of the activated options.

The information on Options is available to all service class licenses.

To access Options, navigate to Utility (second page) > Service > Options.

Figure 7-48 Options

This table shows all the elements available on Options with descriptions.

Table 7-31  Options

Element Description

Software Options

Option Software options on the LOGIQ Fortis.

Status Status of the options on the LOGIQ Fortis.

Software Option Details

Product Name of the product.

Number for the hardware. The hardware number is the hash of the serial number

Hardware Number that is used to generate the option key.

Serial Number Serial number of the LOGIQ Fortis.

Software Option Keys

Available Keys List of the option keys installed on the LOGIQ Fortis.
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7-4-10 Agent Configuration
Use Agent Configuration to:
» Edit and configure the following:
- Enterprise host name in the agent
- Enterprise port number in the agent
- URL for software downloads
- Proxy server in the agent
- Proxy port in the agent
- CRM number in the agent
- Display name in the agent
»  Set the serial number in the agent
» Enter the username and password for the proxy
* Reset the edited unsaved value
* Update contact details
The information on Agent Configuration is available to all service class licenses.
To access Agent Configuration, navigate to Utility (second page) > Service > Agent Configuration.
Figure 7-49 Agent Configuration
This table shows all the elements available on Agent Configuration with descriptions.
Table 7-32  Agent Configuration
Element Description
Agent Configuration
Phone number for the person at the customer site a GE remote service engineer would
Contact Details contact. The phone number is entered during installation and reviewed at every service
call to make sure the information is correct.
Status for the agent. Valid values are:
Agent Status * Running
* Not Running
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Table 7-32  Agent Configuration (Continued)

Element

Description

Agent Registered

Registration status of the agent. Valid values are:

* Yes — The agent is registered in the back office.

» No — The agent is not registered in the back office.

» Not Available — The agent is not configured or running.

Agent Quarantine

Quarantine status of the agent. Valid values are:

* Yes — The agent has more than one device registered with the same CRM Number in
the back office. This scanner cannot send data back to GE or be remotely accessed.

* No —The agent has one device registered with the listed CRM Number in the back office.
» Not Available — The agent is not configured or running.

Agent CRM Verified

Verification status of the Customer Relationship Management (CRM) number for the
agent. Valid values are:

* Yes — The CRM number for the agent is verified in the back office.
» No — The CRM number for the agent is not verified in the back office.
» Not Available — The agent is not configured or running.

Agent Model Number

GE part number for the LOGIQ Fortis. The same number as listed on the rating plate.

Serial Number

Serial number of the agent (read-only). If the agent is not registered with a serial number,
this field is populated with the serial number of the LOGIQ Fortis. The serial number of the
agent is tied to the serial number of the LOGIQ Fortis.

Customer Relationship Management (CRM) number. System identifier assigned to the

CRM No customer unit by the service region. CRM is pre-populated by adding LFortis to the CRM
number. The CRM number of the LOGIQ Fortis is editable.
Display Name Displayed name of the agent.

Agent Connected

Connection status of the agent. Valid values are:

* Yes — The agent is connected to the back office.

» No — The agent is not connected to the back office.

» Not Available — The agent is not configured or running.

Last Connected Time

When Agent Connected is Yes, the last time the LOGIQ Fortis successfully connected to
the agent. When Agent Connected is No, this field does not display.

Advanced Configuration

Server

Name of the enterprise server. Should be set to Production. Do not use the IP address of
the enterprise server using the “other” selection as Windows 10 has removed the ability to
bypass a certificate error that occurs when using the IP address. This error can block
connectivity.

Enterprise Host

Number of the enterprise host. Should be set to insite.gehealthcare.com.

Enterprise Port

Number of the enterprise port. Should be set to 443.

Software Download URL

Address where software will be downloaded from to the LOGIQ Fortis.

Proxy Configuration

Enable Proxy

Enables the proxy server.

Proxy Server

When Enable Proxy is selected, name of the proxy server IP provided by the customer.

Proxy Port

When Enable Proxy is selected, number of the proxy server port provided by the customer.

Credentials

Enable Proxy Credentials

Enables the proxy credentials.

Username

When Enable Proxy Credentials is selected, name of the user provided by the customer.
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Table 7-32  Agent Configuration (Continued)
Element Description
When Enable Proxy Credentials is selected, password for the user provided by the

Password
customer.

Saves the changes made on the Agent Configuration page.

Submit Changes Once Submit Changes has been selected, exit the Agent Configuration page. Wait
between 4 and 5 minutes and then reopen the Agent Configuration page. Agent Status
should display Running.

Reset Form Clears the values on the Agent Configuration page.
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7-4-11

NOTE:

Software Maintenance

In LOGIQ Fortis uses Software Maintenance to manage software updates including check for pending
updates and initiate the download for installation. Additionally, use these pages to reset declined
software packages and view information about installed software.

Use Software Maintenance after a full load/C only load from media as the LOGIQ Fortis will
lose any downloaded updates after these software loads.

Specifically, use these pages:

» Software Updates — Query and view available software updates.

* Reset Declined Packages — Reset software updates declined through the Software Download
and Install dialog box.

+ Software Information — View information that is currently installed on the LOGIQ Fortis.
For more information, see:

+ "Software Updates" on page 7-86
+ "Reset Declined Packages" on page 7-87
+ "Software Information" on page 7-88
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7-4-11

Software Maintenance (cont’d)

Software Updates
Software Updates provides a way to do the following:

*  Query for available software updates

» View available software updates

+ Select and download from the available software updates

The information on Software Updates is available to all service classes.

To access Software Updates, navigate to Utility (second page) > Service > Software Maintenance
> Software Updates.

Figure 7-50 Software Updates

This table shows all the elements available on Software Updates with descriptions.

Table 7-33  Software Updates

Element Description
Product Name Model number for the LOGIQ Fortis.
Product Version Version for the LOGIQ Fortis.
Update ID Identifier for the software update.
Update Name Name for the software update.
Package ID Identifier for the package.
Package Name Name for the package.

Type for the software update. Valid values include:
Update Type » OS Security
* General Update

Requirement for installation of the related software update. Valid values include:

Option required for install . .
» Service installation

Part Number Part number for the software update.

Version Version for the software update.

Released Date Date the software update was released.

Update Description Description for the software update.

Query for Updates Select to populate the page with the available software updates.
Select Update Select to initiate the download of the associated software update.
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7-4-11  Software Maintenance (cont’d)

Reset Declined Packages

Reset Declined Packages provides a way to reset software updates that have been previously
declined through software download.

The information on Reset Declined Packages is available to all service classes. Reset Declined
Packages is not available through a remote connection.

To access Reset Declined Packages, navigate to Utility (second page) > Service > Software
Maintenance > Reset Declined Packages.

Figure 7-51 Reset Declined Packages

This table shows all the elements available on Reset Declined Packages with descriptions.

Table 7-34 Reset Declined Packages

Element Description
Select Check box for the associated software update that has been declined.
Update ID Identifier for the software update.
Update Name Name for the software update.
Package ID Identifier for the package.

Package Name Name for the package.

Type for the software update. Valid values include:
Update Type « OS Security
« General Update

Part Number Part number for the software update.

Version Version for the software update.

Released Date

Date the software update was released.

Update Description

Description for the software update.

Declined Timestamp

Timestamp for when the software update was declined.

Declined User

Name for the user who declined the software update.

Reset

Clears the declined software update so that it is again available through a query on
Software Updates.
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7-4-11  Software Maintenance (cont’d)

Software Information

Software Information displays general information about the software currently installed on the
LOGIQ Fortis.

The information on Software Information is available to all service classes. Software Information is
not available through a remote connection.

To access Software Updates, navigate to Utility (second page) > Service > Software Maintenance
> Software Information.

Figure 7-52 Software Information
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7-4-11

Software Maintenance (cont’d)

This table shows all the elements available on Software Information with descriptions.

Table 7-35

Software Information

Element

Description

Installed Packages

Package Type Type for the software update.
Part Number Part number for the software update.
Version Version for the software update.

Installed Date

Date the software update was installed.

Installed Hotfixes

Hot Fix ID Identifier for the hot fix.
Installed On Date the hot fix was installed.
Description Description for the hot fix.

Windows Defender Status

Status information for Windows Defender.
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Section 7-5
Diagnostics

Contents in this section

7-5-1 Purpose of thissection . . ... . . . . 7-90
7-5-2 Available diagnostics. . . ... ... 7-91
7-5-3 Service Diagnostics List . ... ... 7-92
7-5-1 Purpose of this section
This section describes the available diagnostics.
NOTE: Reboot the LOGIQ Fortis after performing any diagnostics and before returning it to customer
use.
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7-5-2

Available diagnostics
To enter service diagnostic mode, use Utility (second page) > Service > Diags > Run Diags.

See "Service Diagnostics List" on page 7-92 for more information.

Figure 7-53 Run Diags Display

- S S s B

NOTE:

L LDSIQIGAL82/5 DA0GmAcy

To enter into engineering diagnostic mode, press ALT+F2.

Do not use engineering diagnostic mode unless requested by engineering. Some of the tests
require special tools that are not available in the field.

Figure 7-54 Alt+F2 Display

Dpen Log @
Cpen Pep.:

View Log / Report
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7-5-3 Service Diagnostics List
Diag. Description Test
A_DACQ_Access_Test
DACQ DACQ FPGA test A_DACQ_Memory_Test
A_DMAConfigurationTest
A_DSP_DDR3_Test
DSP DSP IC test A_DSP_EMIF_Test
A _DSP_SRIO_Test
) . ) A_ADM_I2C_Test
High voltage (for TX) test including Power
HV Sequencer check, and Emergency HV A_HV_Stop_Test
stop check
A_TX_Power_Control_Test
A_MLP_MEMORY_Test
MLP TX Pulser IC test
DA192 A_MLP_SPI_Test
A_PCle_ClearRegisters_Test
A_PCle_ReadRegisters_Test
PCle PCle signal communication test :S}PCIe_RecelveImagePath_Noanma_T
A_PCle_ReceivelmagePath_Rdma_Test
A_PCle_Communication_Test
A_AnalogReceivePathHi_Test
A_AnalogReceivePathLow_Test
RX AFE RX test
A_AnalogReceivePathMed_Test
A_NoiseFloorTest
SPI SPI test DSP AFE SPI Test
12C Probes Test 12C communicaiton test between Probe 12C Probes Test
DPI-L and System
LVDS SAP Test NA NA
EPAT Probe Channel check test E-PAT Test
Probes 12 12C communication test between Probe 12C Probes Test
and System
TEE NA NA
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Diag.

Description

Test

BEPS

PC Doctor

PC Doctor test

AVI Playback

CDR

DVD Read Only

DVD-R

Essential Test No Network

Essential Test

HD Test Long

HD Test Short

Keyboard

LAN Network interface

LAN Network interface reliability test

Memory

Monitor

Mouse

Sound

RTC clock

USB Ports Test

Video cards

WLAN

Wireless LAN Option test

Wireless Network interface

Wireless Network interface reliability test

Temp.Test

DA192

DA192 Temperature monitoring test

DA192 Temperature Test

GPU

GPU Temperature monitoring test

GPU Temperature Test

COMe

CPU module Temperature monitoring test

SOM Temperature Test

VPD

DA192/DP(L)/BEPS

Vital Product Data communication test

VPD I12C Test

Option

4D basic test without
Probe

4D Motor controller (DC4D) Option, basic
test without Probe

Presence Test

Version Test

4D with Probe

4D Motor controller (DC4D) Option test
with 4D Probe

Static 3D Test

4D Test

Battery

Battery Option (Power Assistant or Scan-
on-Battery) test

A_Battery_Status_Test

Cw

CW doppler Option (GCW) test

A_CWTest_g1_Polaris

A_CWTest_g8 Polaris

A_CWTest_g16_Polaris

A_CWTest_g24_Polaris

A_CWTest_g96_Polaris

A_CWDopplerBeamformerTest_Polaris

A_CWChannelSelectionSwitchControlTest

A_CWSummingGainControlTest_Polaris
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Diag.

Description

Test

Option

Vnav

Volume navigation(Baybird2) test,
including Sensor test and Transmi

Sensor 1

Sensor 2

Sensor 3

tter test Sensor 4

Transmitter

System
7-5-3-1 DA192 diagnostics
Name: DACQ
Table 7-36 DACQ Diagnostics
Description Test Instruction If the test fails... NOTE
A_DACQ_Access_Test 1. Disconnect probes to all four -
ports.
A_DACQ Memory_Test |, rom Service > Diags > Run | CONfirm if DA192 and BEPS i
DACQ FPGA test Diags, select DA192 > DACQ. are inserted to BackPlane
3. Select the Execution Mode and properly. If still Fail, replace
A_DMAConfigurationTest : DA192. -
Loop Count.
4. Select Start.
Name: DSP
Table 7-37 DSP Diagnostics
Description Test Instruction If the test fails... NOTE
A_DSP_DDRS3_Test 1. Disconnect probes to all four -
ports.
A_DSP_EMIF_Test 2. From Service > Diags > Run Confirm if DA192 and BEPS B
DSP IC test Diags, select DA192 > DSP. are inserted tp Baf:kPlane
3. Select the Execution Mode and properly. If stil Fail, replace
A_DSP_SRIO_Test ) DA192. -
Loop Count.
4. Select Start.
Name: HV
Table 7-38 HV Diagnostics
Description Test Instruction If the test fails... NOTE

High voltage (for TX) test
including Power Sequencer
check, and Emergency HV
stop check

A_ADM_[2C_Test

A_HV_Stop_Test

A_TX_ Power_Control_Test

1. Disconnect probes to all four
ports.

2. From Service > Diags > Run
Diags, select DA192 > HV.

3. Select the Execution Mode and
Loop Count.

4. Select Start.

Confirm if DA192 and BEPS

are inserted to BackPlane
properly. If still Fail, replace
DA192.
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Name: MLP
Table 7-39 MLP Diagnostics
Description Test Instruction If the test fails... NOTE
1. Disconnect probes to all four -
ports.
2. From Service > Diags > Run Confirm if DA192 and BEPS
MLP TX Pulser IC test Diags, select DA192 > MLP. are inserted fo BackPlane
K properly. If still Fail, replace -
3. Select the Execution Mode and
DA192.
Loop Count.
4. Select Start.
Name: PCle
Table 7-40 PCle Diagnostics
Description Test Instruction If the test fails... NOTE

PCle signal communication
test

A_PCle_ClearRegisters_Te
st

A_PCle_ReadRegisters_Te
st

A_PCle_ReceivelmagePath
_NonRdma_Test

A_PCle_ReceivelmagePath
_Rdma_Test

A_PCle_Communication_Te
st

1. Disconnect probes to all four
ports.

2. From Service > Diags > Run
Diags, select DA192 > PCle.

3. Select the Execution Mode and
Loop Count.

4. Select Start.

Confirm if DA192 and BEPS
are inserted to BackPlane
properly.

If still Fail, replace DA192. If
still Fail, replace BEPS.

Name: RX
NOTE: Perform RX test only at first. RX test may be Fail when all DA192 tests are performed at one
time. If you do all DA192 test at one time, perform RX test after re-booting system
(Workaround).
Table 7-41 RX Diagnostics
Description Test Instruction If the test fails... NOTE
A_AnalogReceivePathHi_Te Perform RX test
st . only at first. RX test
A AnalogRecevePathLow 1. glsconnect probes to all four may be Fail when
— — |ports. o all DA192 tests are
Test 2. From Service > Diags > Run Conflrm if 3A1SI332 aEgIBEPS performed at one
AFE RX test Diags, select DA192 > RX. are inserted to BackPlane 1 Yie 1 o all

A_AnalogReceivePathMed_
Test

A_NoiseFloorTest

3. Select the Execution Mode and
Loop Count.

4. Select Start.

properly. If still Fail, replace
DA192.

DA192 test at one
time, perform RX
test after re-
booting system
(Workaround).
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Name: SPI

Table 7-42  SPI Diagnostics

Description Test Instruction If the test fails... NOTE
1. Disconnect probes to all four
ports.
2. From Service > Diags > Run Confirm if DA192 and BEPS
SPI test DSP AFE SPI Test Diags, select DA192 > SPI. are inserted to BackPlane .

R properly. If still Fail, replace
3. Select the Execution Mode and DA192.

Loop Count.
4. Select Start.

7-5-3-2 DPI-L diagnostics
Name: I12C Probe Test

Table 7-43  12C Probe Test Diagnostics

Description Test Instruction If the test fails... NOTE

Confirm if Probe is connected

1. Disconnect probes to all four to DPI-L board properly.

ports. Confirm if Probe-Connector-

2. From Service > Diags > Run  |Pin is clean.

12C Probes Test I2C communicaiton test Diags, select DPI > 12C Probe If still Fail, try to use another )
between Probe and System | Test. Probe.

3. Select the Execution Mode and |If still Fail, replace DPI-L

Loop Count. board.

4. Select Start. If still Fail, replace BEPS
board.

Name: LVDS SAP Test
NOTE: DO NOT perform this test. Always Fail without Engineering loopback-JIG.

Table 7-44 LVDS SAP Test Diagnostics

Description Test Instruction If the test fails... NOTE

DO NOT perform
this test. Always
NA NA NA NA Fail without
Engineering-
loopback-JIG.
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7-5-3-3 Probes diagnostics
Name: E-PAT Test

NOTE: E-PAT does not support Pencil probes and 6Tc probe. E-PAT may not work properly with 6S-

D, L3-12-D, M5Sc-D, ML6-15D.

Table 7-45 E-PAT Diagnostics

Description Test Instruction If the test fails...

NOTE

This test is pass or fail.
Passing means that the test is

1. Disconnect probes to all four
complete. Not that the probe has

EPAT does not
support Pencil

ports.
2. From Service > Diags > Run passed.. o S:gg:s and 6Tc

Probe Channel check test |E-PAT Test Diags, select Probes >e-PAT. | Iftest fa";’ g/!s pmbabl'y due to f”d EPAT work
3. Select the Execution Mode and unsupporte |mpropery connecte may. not wor
Loop Count probe or a malfunctioning probe. properly with 6S-D,

' To keep track of probe performance, |[L3-12-D, M5Sc-D,
4. Select Start. graph the results for comparison over |ML6-15D
time.
Name: 12C Probe Test
Table 7-46  12C Probe Test Diagnostics
Description Test Instruction If the test fails... NOTE

1. Disconnect probes to all four Confirm if Probe is connected to DPI-L
ports. . . board properly.

2 — E":rzmszfazlgfozgiglszz IFi:'J:be Confirm if Probe-Connector-Pin is

i
C communication test 12C Probes Test gs, clean. B
between Probe and System Test L
. If still Fail, try to use another Probe.

3. Select the Execution Mode and If still Fail | DPI-L board
Loop Count. still Fail, replace -L board.

If still Fail, replace BEPS board.

4. Select Start.

Name: TEE Probe Test
NOTE: DO NOT perform this test. Always Fail without Engineering loopback-JIG.

Table 7-47 TEE Probe Test Diagnostics

Description Test Instruction If the test fails...

NOTE

NA NA NA NA

DO NOT perform this
test. Always Fail
without Engineering-
loopback-JIG.
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7-5-3-4 BEPS diagnostics
Name: PC Doctor Test
Description Test If the test fails... NOTE
AVI Playback Not used - -

PC Doctor test

CDR

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > CDRKk.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the DVD-R drive.

DVD Read Only

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > DVD Read
Only.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the DVD-R drive.

DVD-R

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > DVD-R.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the DVD-R drive.

Essential Test No
Network

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > Essential Test
No Network.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the BEPS.

Essential Test

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > Essential Test
3. Select the Execution Mode and Loop
Count.

4. Select Start.

Due to the network, check the network
connection and setup.

This test expects the network to be
connected and active.

And the network connection is up and
active, replace the

BEPS.

HD Test Long

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > HD Test Long.
3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the SSD.
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Description

Test

If the test fails...

NOTE

PC Doctor Test

HD Test Short

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > HD Test Short
3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the SSD.

Keyboard

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > Keyboard.
3. Select the Execution Mode and Loop
Count.

4. Select Start.

If there are any errors, keys may be
damaged and you may have to replace
or repair the keyboard.

LAN Network
interface

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > LAN Network
Interface.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Check the ICM and internal LAN cable.
Check the BEPS.

Overall test result may
indicate FAIL, please
confirm Diag detail
result on
ServiceDesktop, then
wired-LAN or wireless-
LAN test result can be
confirmed.

LAN Network
interface reliability
test

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > LAN Network
interface reliability test.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Check the ICM and internal LAN cable.
Check the BEPS.

Overall test result may
indicate FAIL, please
confirm Diag detail
result on
ServiceDesktop, then
wired-LAN or wireless-
LAN test result can be
confirmed.

Memory

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > Memory.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the SOM

DO NOT perform this
test. Test result may
not be displayed
depends on the SW-
version.

Monitor

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > Monitor.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the monitor

Mouse

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > Mouse.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the trackball.

Sound

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor >Sound.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

If no sound is produced in these tests,
choose the More Info button in the Audio
Test dialog box for information about
possible causes and solutions.

Chapter 7 Diagnostics/Troubleshooting




GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

Description Test If the test fails... NOTE

1. Disconnect probes to all four ports.
2. From Service > Diags > Run Diags, Replace the battery on the BEPS board.
RTC clock select BEPS > PC Doctor >Sound. If the test still fails, replace the BEPS )
3. Select the Execution Mode and Loop |board.

Count. If still fail, replace the SOM.

4. Select Start.

1. Disconnect probes to all four ports.
2. From Service > Diags > Run Diags,
select BEPS > PC Doctor >USB Ports
PC Doctor Test |USB Ports Test Test. Check the USB device. -
3. Select the Execution Mode and Loop
Count.

4. Select Start.

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags, Replace VCS

) select BEPS > PC Doctor >Video cards. o
Video cards i If still fail, replace BEPS. -
3. Select the Execution Mode and Loop o

If still fail, replace SOM.

Count.
4. Select Start.

Name: WLAN

Table 7-48 WLAN Diagnostics

Description Test Instruction If the test fails... NOTE

Wireless Network interface | 1. Disconnect probes to all four -

Confirm Wireless network
ports.

. . setting.
. , 2D'.Fr°m sf"";‘;; g'a!xl_;ﬁ““ If still fail, replace Wifi module.
Wireless LAN Option test | \yjrless Network interface | 2129S: select > :

3. Select the Execution Mode and if stillfail, replace SOM. B
reliability test . xecuti e
Loop Count. If still fail, replace BEPS.

4. Select Start. If still fail, replace BackPlane.
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7-5-3-5 Temp. Test diagnostics
Name: DA192
Table 7-49 DA192 Diagnostics
Description Test Instruction If the test fails... NOTE
1. Disconnect probes to all four ports.
2. From Service > Diags > Run Diags,
lect T .Test>DA192 T t
DA192 Temperature |DA192 Temperature .T.isef emp. 1es emperature Replace DA192. )
itoring test Test ill fai
meniioring fes es 3. Select the Execution Mode and Loop If still fail, replace BEPS.
Count.
4. Select Start.
Name: GPU
Table 7-50 GPU Diagnostics
Description Test Instruction If the test fails... NOTE
1. Disconnect probes to all four ports.
2. From Service > Diags > Run Diags,
select Temp. Test > GPU Temperature
GPU Temperature P P Replace GPU.
monitoring test GPU Temperature Test | Test If still fail, replace BEPS )
3. Select the Execution Mode and Loop stll fall, replace
Count.
4. Select Start.
Name: COMe
Table 7-51 COMe Diagnostics
Description Test Instruction If the test fails... NOTE
1. Disconnect probes to all four ports.
2. From Service > Diags > Run Diags,
lect T .Test>SOM T t
CPU module select Temp. Tes emperature Replace SOM.
Temperature SOM Temperature Test |Test e -
N . If still fail, replace BEPS
monitoring test 3. Select the Execution Mode and Loop
Count.
4. Select Start.
7-5-3-6 VPD diagnostics
Name: DA192/DPI-L/BEPS
Table 7-52 DA192/DPI-L/BEPS Diagnostics
Description Test Instruction If the test fails... NOTE
1. Disconnect probes to all four ports.
2. From Service > Diags > Run Diags, . .
) Specify Failed board by LOG
Vital Product Data /o 156 gt select VPD> VPD [2C Test file or VPD editor. -
communication test 3. Select the Execution Mode and Loop
Replace defect board.
Count.
4. Select Start.
7-101
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7-5-3-7 Option diagnostics
Name: 4D basic test without Probe
Table 7-53 4D basic test without Probe Diagnostics
Description Test Instruction If the test fails... NOTE
Presence Test 1. Disconnect probes to all four ports. -
2. From Service > Diags > Run Diags, Check to see if the option is
4D Motor controller select Option > 4D basic test without installed.
(DC4D) Option, basic ' Probe. If the option is installed,
test without Probe Version Test 3. Select the Execution Mode and Loop  |replace DC4D. )
Count. If still Fail, replace BEPS.
4. Select Start.
Name: 4D basic test with Probe
Table 7-54 4D basic test with Probe Diagnostics
Description Test Instruction If the test fails... NOTE
Static 3D Test 1. Disconnect probes to all four ports. Check to see if the option is -
4D M i 2. From Service > Diags > Run Diags, installed.
(DC4I(D)t)oécct)'2tr:0teii select Option > 4D basic test with Probe. |If the option is installed, try to
i
with 4D Prrc))be 4D Test 3. Select the Execution Mode and Loop  |use another 4D probe. -
Count. If still Fail, replace DC4D.
4. Select Start. If still Fail, replace DPI-L.
Name: Battery
Table 7-55 Battery Diagnostics
Description Test Instruction If the test fails... NOTE

Battery Option (Power
Assistant or Scan-on-
Battery) test

A_Battery_Status_Test

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select Option > Battery.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Confirm if Battery Cable (of
each Battery Pack, both of
Power-cable and Signal-
cable) is connected to BBG2
board.

Confirm if BBG2 Power cable
and signal cable are
connected to BEPS properly.
If installed Option is Power-
Assistant(2 packs), confirm the
assembled-Battery location is
same as Installation-manual.

if still fail, replace BBG2.

if still fail, replace all Battery
Packs.

If still fail, replace Harness
between BBG2 and BEPS.

7-102
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Name: CW

Table 7-56 CW Diagnostics

Description Test Instruction If the test fails... NOTE
A_CWTest_g1_Polaris -
A_CWTest_g8_Polaris -
A_CWTest_g16_Polaris -
A_CWTest_g24_Polaris 1. Disconnect probes to all four ports. _

2. From Service > Diags > Run Diags,
CW doppler Option ~ |A_CWTest_g96_Polaris |select Option > CW. Replace GCW. -
(GCW) test A_CWDopplerBeamform|3- Select the Execution Mode and Loop  |If still fail, replace DA192.
erTest_Polaris Count. i
—14. Select Start.
A_CWChannelSelection .
SwitchControlTest
A_CWSummingGainCo _
ntrolTest_Polaris
Name: Volume Navigation
Table 7-57 Volume Navigation Diagnostics
Description Test Instruction If the test fails... NOTE
Move sensor 1 (transducer) to
a different port. If the
S 1 transducer fails, replace the )
ensor transducer.
If the problem still persists,
replace the bayBIRD.
Move sensor 2 (transducer) to
a different port. If the
S 9 transducer fails, replace the )
ensor transducer.
If the problem still persists,
) replace the bayBIRD.
1. Disconnect probes to all four ports.
Volume navigation 2. From Service > Diags > Run Diags, Move sensor 3 (transducer) to
(Baybird2) test, select Option > Volume Navigation. a different port. If the
including Sensor test | gengor 3 3. Select the Execution Mode and Loop | ransducer fails, replace the -
and Transmitter test Count. transducer.
4. Select Start If the problem still persists,
’ ’ replace the bayBIRD.
Move sensor 4 (transducer) to
a different port. If the
S 4 transducer fails, replace the )
ensor transducer.
If the problem still persists,
replace the bayBIRD.
. If the problem still persists, _
Transmitter replace the bayBIRD.
If the problem still persists, _
System replace the bayBIRD.
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Section 7-6
Back End Troubleshooting

Contents in this section

7-6-1 Back end isolation from the front end (Simulatormode). .. ...................... 7-104
7-6-2 GPU proCessing ITOrS . . . . oo e 7-104

7-6-1 Back end isolation from the front end (Simulator mode)
To isolate the front end from the back end and boot up in Simulator mode, you must:
+ Power down the LOGIQ Fortis, and open the card rack.
» Disconnect the BEPS board from the back plane.
» If present, Disconnect the BBG2 Power/Signal cable for Battery Option.
In Simulator mode, the scan screen may display a white image screen or no scan at all, but will allow
other application functions to run normally.
7-6-2 GPU processing errors
If transmitting errors between DA192 and GPU occur, a message appears as a system error, indicating
that the system cannot keep up with the streaming data. If minor errors occur, the system can recover
on its own and the system error will request the user to re-select the probe to continue scanning.
The signal path between the DA192 and GPU is digital and can be tested using the DA192 Digital
diagnostics. The PCle transfer test in the DA192 (Digital) tests communication and errors between the
DA192 Digital interface and the GPU.
It may be hard to isolate problems with the GPU versus the DA192. These PCLe Communication
diagnostics can help determine the origin of a problem:
+ PCle ImagePath NonRdma tests the communication between the DA192 Digital interface and the
BEPS CPU
+ PCle ImagePath Rdma tests the communication between DA192 Digital interface and the GPU
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7-6-3 GPU overheating

If the GPU is collecting lint or dirt inside, it will cause overheating messages and the system will typically
shut down. Follow the instructions below to clean the GPU.

A CAUTION Risk of damage to the GPU. Please be careful when opening and cleaning the GPU.

To clean the GPU:

1.) Remove GPU from BEPS Assy. Refer to 8-8-6 "BEPS Assy Replacement" on page 8-144 and 8-8-9 "GPU
replacement" on page 8-156.

2.) Remove the seven T5 Torx screws from the top cover on the GPU.
NOTE: The screws are very small. Take care to not lose any of the screws.

A CAUTION Risk of damage to the fan blades on the GPU. Take extra caution as the fan blades can be easily
broken.

3.) Carefully remove visible lint from the fan blades and heat sink assembly. If necessary, use a
static-free vacuum cleaner.

4.) Replace the cover on the GPU and reinstall the seven TS Torx screws.
5.) Reinstall all parts to the system in reverse procedure.
6.) Start the Ultrasound system and check the temperature of the GPU.
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T-T-10  WIreleSS . . oot 7-112
7-71 Image problems
Table 7-58 Image Problems
Symptom Cause Solution
Incorrect settinas Check Utility > Connectivity > Miscellaneous and, under Print
gs: and Store options, select Send Images via Wireless.
. . When connected to the network through a wireless LAN
No images sent on wireless. Wireless is not connection and Send Images via Wireless is selected, images
available on all will be sent to the DICOM device over the wireless LAN. If not
systems. selected, spooled images will be sent when the Ultrasound
system is connected to the wired network.
Images from one patient ended up on |Edit a.nd Copy tool Have customer contact GE Service.
prior patient exam. used incorrectly.
Frozen duall 'mage W'.th.ECG graph . Frozen dual image with ECG graph stored as clip when
stored as clip when printing and sending | Unknown. rinting and sending to PACS
to PACS. printing 9 '
Most likely Direct Store
is selected on the Disable the DICOM Store Device on the print key.
Getting double images of everything on | Dataflow and/or the or
DICOM Store Device. DICOM Store Deviceis | )
selected on the print Disable the DICOM Store in the dataflow.
key.
Color images are transferring with No Incorrect color settings. | Change Color Support to Mixed.
color or color is showing as white. Disable Use Button Settings.
Dual screen images are very small on Incorrect settin Under Utility > System > System Display > Use Wide Screen
DICOM Store Device monitor. 9 For..., unselect Dual screen.
Most likely the
Images are populating out of order on hanging protocpl qn Under Utility > Connectivity > Miscellaneous; change Image
. the DICOM Device is L
DICOM Store Device. . : Order Scheme to Acquisition.
not sorting by image
instance ID.
Image number on DICOM Store device Incorrect settin Under Utility > Connectivity > Miscellaneous; change Image
are not 1,2,3. 9 Order Scheme to Off.
: Under Utility > Connectivity > Misc. select Add Titlebar
No Title bar and/or Image Parameters . . . .
on cine clio imaaes Incorrect setting. information to multiframe loops and/or Add Scan Parameter
P ges. Information to multiframe loops.
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7-7-2

7-7-3

Network problems

Table 7-59 Network Problems

Symptom

Cause

Solution

Cannot connect to PACS through the
network.

Network properties are
not correct.

Network card failure.

Open a command prompt.

“Ping 127.0.0.1" and verify no lost packets. If there is an error,
try to reimage.

“Ping“ IP address for the LOGIQ Fortis (given by hospital or
the listed default in manual) and verify no lost packets. If there
is an error, replace the BEPS.

“Ping” gateway if given one and verify no lost packets. If there
is an error, verify that network cable plugged in, and the
network lights on the front are blinking. Double check subunit
and gateway are correctly entered. This point and beyond are
hospital issues.

“Ping” another machine on the network and verify no lost
packets. If there is an error, try pinging from another computer
on the same network.

Ping problems

Table 7-60 Ping Problems

Symptom

Cause

Solution

No ping through the network.

Media type not set to
Auto Select.

Check the speed of your connection. Media type should be set
for Auto Select. Remember that every time the LOGIQ Fortis
is re-ghosted that setting goes back to the default value.

Hardware not
connected properly.

Check cables. You need a crossover cable if you are
connected directly to the device. Use a straight cable
whenever you go through a hub. The use of a hub is highly
recommended.

Try connecting the network cable directly to the Ethernet port
in the BEPS. If the connection works, troubleshoot the cabling
to the external device.

Incorrect address.

Check proper addressing. The LOGIQ Fortis should be under
the same subnet or have a gateway address to be able to
connect to another subnet.

Network is down.

Verify that the network is active and running.

With your laptop check to see if you can ping the LOGIQ Fortis
and the device (Printer or PACs).
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Table 7-60

Ping Problems (Continued)

Symptom

Cause

Solution

No verify for the DICOM server.

Server does not
support the DICOM
service.

Check if the device supports Verify.

Port or AE title settings
are not correct.

Check port and AE title info.

Server is not running.

Check if the device is up and running. It may be up but in an
error status. Reboot the device if possible. You also may need
to reboot the LOGIQ Fortis.

Use Network Capture.
See "Network Capture" on page 7-68.

Clean User Defs before reloading software in case there is a
corrupt Connectivity.res file. Perform an Alt+D to capture logs

Ping fails for a device.

Unknown before performing a Clean User Defs so that, if the presets are
corrupt, the logs can be sent to Engineering for review.
See "Clean Userdefs" on page 7-58 for more information.
Reload software.
See "Software Reload" on page 7-78 for more information.
Bad network Verify network connection, check “computer” icon on the
connection. Windows Desktop.

Bad network wall port.

Try plugging the network cable into a different network wall
port.

Bad cable.

Try a new network cable.

Incorrect IP address.

Confirm IP Address is correct on the Device page.

Remote DICOM device
does not accept pings.

Contact the PACS Administrator.

Pings successful for a device but fails
for a service.

Incorrect settings.

Confirm AE Title and Port Number are correct on the Device
page.

Systemis not set up on
the host table at the
remote DICOM device.

Contact the PACS Administrator and make sure the Service
Class User (SCU) and Service Class Provider (SCP) between
the LOGIQ Fortis and the remote DICOM device is correct.

Remote DICOM device
does not support the
ping.

Contact the PACS Administrator.

Pings successful and verified for a
DICOM worklist service, but a query
returns no results.

Incorrect/incompatible
date or time settings on
the system.

Check date and time (AM & PM) setting on the LOGIQ Fortis.

May need to set the LOGIQ Fortis so that it is one or two
minutes later than the DICOM device.

Modality setting is not
correct.

Make sure Modality is correct under Search Criteria on the
Service page.

Scheduled Procedure
Step Start Date is not
correct.

Make sure Scheduled Procedure Step Start Date is correct
under Search Criteria on the Service page.

System is not set up on
the host table at the
remote DICOM device.

Contact the PACS Administrator and make sure the Service
Class User (SCU) and Service Class Provider (SCP) between
the LOGIQ Fortis and the remote DICOM device is correct.

No patients match the
search criteria.

Contact the PACS administrator and make sure the
Ultrasound system is registered. This scenario usually results
in an error displayed on the Ultrasound system.
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7-7-4

7-7-5

Storage problems

Table 7-61

Storage Problems

Symptom

Cause

Solution

System will not store images.

Dataflow is set to No
Archive under
Properties.

Change from No Archive to Local Archive.

Reboot the scanner. If the problem persists, contact GE
Service.

As a workaround to save images, set up a print key to send to
DICOM Store Device only or use Save As to save images to
external media.

Query and retrieve does not work when
alternating between a wired and
wireless network connection.

Going back and forth
between a wired and
wireless connection
can result in improper
network settings.

Check the network settings.

LOGIQ Fortis is not receiving exams.

LOGIQ Fortis does not
have the correct device
set up.

Set up the remote DICOM device on the Device page.

Setting problems

Table 7-62  Setting Problems

Symptom

Cause

Solution

Unchecking of DHCP does not stick on
reboot.

Default Gateway was
not entered.

When selecting Static IP connectivity, always enter Default
Gateway. If you do not enter a value, the static IP settings will
be erased on reboot.

It takes time to show patient list for
DICOM Read and Import.

Unknown

When there are multiple patient files on a USB device, the
LOGIQ Fortis may take a longer than expected amount of time
to display the patient list when reading and importing DICOM
files.

Print key is not set to
Single.

Under Utility> Applications set the print key to Single.

Incorrect button
setting.

Under Connectivity > Button make sure Format under Still
Images is set to Ultrasound Image.

Measuring pixels on DICOM Store
Device.

Incorrect compression
setting.

Under Connectivity, check compression for DICOM Store
Device. Typically, compression is not preferred because it
reduces the quality.

Incorrect setting.

Dual images are stored as secondary capture on all but the
LOGIQ Fortis and do not send Regional calibration data.
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7-7-6 Transfer times and failures
Table 7-63  Transfer Times and Failures
Symptom Cause Solution
Slow response from
the DICOM server. Check device configuration. Increase the time out properties.
Large data sets.
s Check device configuration. Increase the number of parallel
Server limitations. . .
ports if possible.
Clean the spooler (F4). If the jobs in the spooler cannot be
deleted, you need to do it in Windows. These jobs may be
corrupted or may be using a lot of space in the disk and
causing problems with the sending of DICOM images. Insert
Probl ith th the SSA key, turn the LOGIQ Fortis on and log in into
roblem with the maintenance and exit to Windows (the application should not
spooler. be running). Then go to Windows Explorer and look for the file
E:\Spooler\jobqueue.xml. Delete the file. See "DICOM
Spooler" on page 7-50.
Delete the files from E:/Spooler and then the Recycle Bin.
Reboot the LOGIQ Fortis.
Check the Connectivity configuration on the
System pings and verifies but there is a LOGIQ Fortis.
transfer failure from the LOGIQ Fortis to « Ifitis a printer, check that the printer supports the film type
the DICOM server. and format. Some printers do not support different image
sizes (or different formats, such as the Patient entry screen).
Probl ith th If this is the case, the spooler may show the job in a “Done”
Cro emg _W't the status but the images never get printed. Try sending
on.nect|v'|ty secondary capture.
configuration. . . . .
« If it is a storage device, check whether the image type is
supported (color, gray, Multiframe).
« If it is a Worklist broker, use a Dataflow in which your
Worklist is the primary input. Otherwise, it will not let you
retrieve patients. Also, check your Worklist search criteria
configuration.
Use Network Capture. See "Network Capture" on page 7-68.
Clean user-defined data before reloading software in case
there is a corrupt Connectivity.res file. Do an Alt+D to capture
Unknown logs before cleaning user-defined data so that if the presets
prove corrupt the logs can be sent for review. See "Clean
Userdefs" on page 7-58.
Reload the software. See "Software Reload" on page 7-78.
Problem with file size . .
and compression. Check Compression under Still Images on the Button page.
Large files need to be compressed to improve transfer time.
Size of the exam.
Long transfer times. )
Check Network Speed on the TCP/IP page. Auto Detect is
Network speed and . g h
. generally a preferred selection. NOTE: Using a wireless
settings on the ; ) -
connection to transfer images can take 4-5 times longer than
Ultrasound system. . .
a wired connection.
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7-7-7

7-7-8

Spooler problems

Table 7-64 Spooler Problems

Symptom Cause

Solution

Destination unable to
view the particular
photometric
interpretation.

Jobs exist on the spooler but do not
display at destination (sometimes only
on Cine or Secondary Capture).

Check what compression and photometric interpretation the
destination device supports and adjust (if possible) on the
destination service to the settings, which results in successful
viewing.

Note that compression JPEG will give photometric
interpretation YBR_FULL_422, RLE will give YBR_FULL and
uncompressed will give RGB. The exception to this is if you
enable B/W only, then you will get photometric interpretation
MONOCHROMES2 for all compressions.

Images say Done in Spooler but are not

populated on DICOM Store Device. Incorrect settings.

Confirm My Computer > AE Title on the Device page is
correct. The DICOM Store Device may use the AE Title of the
ultrasound machine to determine where the images are placed
in the DICOM store device.

Slow transfer rates

Table 7-65 Slow Transfer Rates

Symptom Cause

Solution

Images being re-sent
automatically and low
transfer rates.

Slow transfer between the LOGIQ
Fortis and DICOM server.

Adjust the retry settings to make jobs retry on bad networks.
There is no need to set retries for mobile (off-line) use.

See 6-4-1 "Slow response rate between the LOGIQ Fortis and
a DICOM (PACS) server" on page 6-13.

Increase compression

« Uncheck Use Button Settings
» Set the Max Framerate to 25%
« Set Clip Quality to 85%

« Set Color Support to Mixed
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7-7-9

7-7-10

InSite connection

Table 7-66 InSite Connection

Symptom

Cause

Solution

Cannot connect to InSite because of
missing DNS address.

Some customer sites
cannot connect to the
GE back office using
the URLs provided by
default in the Agent
Configuration page. A
DNS address is
needed but the LAN
connectivity set up
pages do not offer the
entry field. Only the
WLAN set up pages
allow that entry. The
agent configuration on
the service desktop
does not work using IP
addresses when
selecting Enterprise

server as “other”.

See 7-4-10 "Agent Configuration" on page 7-82.

This needs to be repeated if the software has been reloaded
to regain InSite connectivity.

Wireless

Table 7-67 Wireless

Symptom

Cause

Solution

Cannot set up wireless connection.

CISCO PEAP
authentication
methods for wireless
connectivity are not
available.

If the hospital wireless network supports PEAP authentication,
use the Microsoft PEAP authentication methods for wireless
connectivity.
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Section 7-8
Electromagnetic Interference (EMI) Troubleshooting

7-8-1

7-8-2

NOTE:

7-8-3

7-8-4

7-8-5

Contents in this section

7-8-1 Prevention/abatement . ........ . . ... 7-113
7-8-2 Different poweroutlet . . .. ... ... 7-113
7-8-3 Different system . . ... . 7-113
7-8-4 Different location. . . .. ... e 7-113
7-8-5 Disconnect external cables. . . ... ... . . ... 7-113

Prevention/abatement

For electromagnetic interference (EMI) rules and details, see 2-2-3 "EMI limitations" on page 2-6.

Different power outlet

Connect the LOGIQ Fortis to another power outlet and check to see if the noise changes or disappears.

Image artifacts can occur if, at any time within the facility, the ground from the main facility's incoming
power source to the LOGIQ Fortis is only a conduit.

See 2-3-4 "Minimal floor plan suggestions"” on page 2-11.

Different system

Try another LOGIQ Fortis at the same location and look for the same noise. If the noise is present on
the new system too, the noise is most likely from an external source/equipment.

Different location

Move the LOGIQ Fortis to another location and check to see if the noise changes or disappears. This
may help to locate an external noise source.

Try to move the LOGIQ Fortis to:

* another location inside the room
« another room
» another floor

Disconnect external cables

Disconnect all external cables (network, all unused probes, ECG leads, etc.) and check to see if the
noise disappears.
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Section 7-9
Image Troubleshooting

7-9-1

7-9-2

7-9-3

Contents in this section

7-9-1 Image artifacts. . . . ... ... 7-114
7-9-2 Image management . ... ... 7-114
7-9-3 Image quality. . . ... ... 7-114

Image artifacts

When the image artifact is observed or Analog RX diag is Failed, that may be caused by insufficient
connection of Stacking-connector (between DPI-L and DA192).

It is recommended to confirm the Stacking-connection. If connection is insufficient, Gold-Plating area
may be observed.

In that case, try to push each board by strong force to hidden Gold-Plating area.

Figure 7-55 Image Artifacts

Image management

When a VCI Omniview clip is recalled from the clipboard for the first time after reselecting an
Application, trackball does not show Omniview controls. Reselect the Omniview line selection from the
touch panel.

Cannot delete Images from Active Images Screen after a Save As operation. If a clip is saved from the
active images screen via Save As it cannot be deleted until system is rebooted.

Image quality

B-Mode 1Q change when activating M-Mode on recalled cine Activating M-Mode on recalled images
introduces undesirable image quality and is not recommended.

Acquire M-Mode Acquisition while scanning.
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Section 7-10
Smart Device Apps Troubleshooting

7-10-1

7-10-2

7-10-3

7-10-4

Smart Device apps are used on Android devices (both phone and tablet) through a Bluetooth connection
to the LOGIQ Fortis. For more information, see 5-4-8 "Smart Device applications" on page 5-18.

Smart Device apps pairing confirmation delay

The Smart Device apps may require 10-30 seconds to pair. Turn the Bluetooth setting off and then on
again can minimize this delay time.

Smart Device apps library downloads

After downloading LOGIQ Remote and LOGIQ Photo immediately enter the barcode reader or pairing
screen. This initiates download of critical libraries to the device. Only turn off wireless after this has been
completed or the apps will fail to function.

LOGIQ Photo crashes if camera permission denied

If a user decides to deny permission to the camera on first launch of one of the Smart device apps the
app crashes when attempting to use it.

If a user decides to deny permission to the Camera on first launch of one of the LOGIQ Apps the app
crashes when attempting to use it

Upside down image from LOGIQ Photo

On certain devices (including the Lenovo Taba 4 10"), the images are sent to the LOGIQ Fortis upside
down.

Lock the device screen rotation and take pictures upside down.
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Section 7-11
Boot Issue Troubleshooting

7-11-1 No boot (Minimum configuration to boot)
Try to determine how far the system tries to boot:

»  With the main breaker on, do you get a white back light on the on/off button?

If not, check AC outlet. If AC outlet is connected correctly, then check internal-connection of BEPS
inside, including ACDC module connection. Also, recommend to try to disconnect Battery Cables.

» If you press the power on button, does it change color to blue? Power on button tells the BEPS to
turn ON and drives PSON_N low (active) to power up ACDC-module. ACDC-module turns on 12V.

If the BEPS is not booting, BEPS module and/or CPU-module may need to be replaced.

* Is Windows loading? If it seems to hang while loading, try reloading the software.

* Is Windows loading but the application software does not start, try reloading the application
software.

» Is the application ready to scan? If not, check logs to see if there are any hardware compatibility
issues that would prevent a normal scan.

Try minimum configuration to boot:

*  Minimum configuration 1 - WARNING DO NOT LEAVE SYSTEM ON as fans will not be running.

+  The minimum configuration to boot the LOGIQ Fortis requires the BEPS (with CPU module), Lower/
Upper OPIO for Power On, and the main display.

These boards may be removed/unplugged:

«  DA192

« DPI-L

*  GBP (Backplane)

» All options (DC4D, VCS, GCW, VSIO, V-Nav, etc.)
The following are connected to the BEPS:

+ LCD J8 (on BEPS) to provide P12V Power to Monitor
* J1 (on BEPS) to provide Live5V power to Lower OP IO, and to connect PSON signal

+ J3/J4(on BEPS) for HDMI signals (NOTE: keep all connection, Lower OP IO <-> Upper OPIO,
Upper OPIO<->Monitor)

If the LOGIQ Fortis is not powering up by pressing the On/Off button, try to power up pushing the U66
button on the BEPS board.
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Section 7-12
Noise Troubleshooting

7-121
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Noise

Ultrasound machines are susceptible to Electromagnetic Interference (EMI) from radio frequencies,
magnetic fields, and transients in the air or wiring. They also generate EMI. Possible EMI sources
should be identified before the unit is installed. Electrical and electronic equipment may produce EMI
unintentionally as the result of a defect. Some of these sources include:

* medical lasers

* scanners

* cauterizing guns
* computers

*  monitors

+ fans

+ gelwarmers

* microwave ovens
» light dimmers

* portable phones

The presence of a broadcast station or broadcast van may also cause interference.

When talking to the customer, try to gather as much information as possible about the conditions when

the noise appears.

Table 7-68 Noise Conditions

The noise is present

Determine

If the test fails, see...

All the time

n/a

7-12-2 "Noise picked up from the air" on page 7-118 and
7-12-3 "Noise received through the external cables" on page
7-118.

After some time of use

The amount of time
between initial use and
when the noise begins.

7-12-2 "Noise picked up from the air" on page 7-118.

Certaln times of the day or night

The time of day or night
along with the duration.

7-12-2 "Noise picked up from the air" on page 7-118 and
7-12-3 "Noise received through the external cables" on page
7-118.

At all locations in the hospital

n/a

7-12-2 "Noise picked up from the air" on page 7-118.

Only in one room or area

The room or area

7-12-2 "Noise picked up from the air" on page 7-118 and
7-12-3 "Noise received through the external cables" on page
7-118.
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Table 7-68

Noise Conditions (Continued)

The noise is present

Determine

If the test fails, see...

From time to time with no special
pattern of time is observed

n/a

7-12-2 "Noise picked up from the air" on page 7-118 and
7-12-3 "Noise received through the external cables" on page
7-118.

7-12-2 Noise picked up from the air
Table 7-69 Noise Conditions Picked Up from the Air
Symptom Cause Solution
Noise is coherent -“penlight noise”
?aoé?g?; (tjr?ew:c;ir;;hiz felzg:/"l'eglfntg"the .The electromagnetic | Test whether the noise is picked up by a probe cable.
channels interference (EMI) from
i radio frequencies,
Noise is a problem on a single probe. |magnetic fields, and Test with another probe.
— - transients in the air. - : } !
Noise is a problem on a single probe Move the LOGIQ Fortis to another location to see if the noise
port. persists.
7-12-3 Noise received through the external cables
Electromagnetic Interference (EMI) from radio frequencies, magnetic fields, and transients in the wiring.
The noise can enter the LOGIQ Fortis through the mains power cable, probe cable(s) or any other
external connected cable(s).
Disconnect cables that are not needed for the basic use of the LOGIQ Fortis:
* Network cable
+ Cables to any external peripherals
+ ECG cables and other cables connected to the Patient 1/0O
Verify whether the noise changed or disappeared when the cables were removed.
Often, this type of noise is due to grounding problems in the mains power system or when the LOGIQ
Fortis is sharing a power line with other equipment.
7-12-4 Doppler noise

Doppler noise symptoms can be horizontal stripes or spikes.

Table 7-70

Noise Conditions for Doppler

Symptom

Cause

Solution

Horizontal stripes

Typically an analog
problem caused by the
DA192 or DPI-L

Determine if one of these boards is the cause:
« Transmit & Receive board (DA192)
* Probe interface board (DPI-L)

Spikes

Typically a digital
problem caused by
either the DA192 or
DPI-L

Determine if one of these boards is the cause:
« Transmit & Receive board (DA192)
* Probe interface board (DPI-L)
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7-12-5 Intermittent noise

Intermittent noise can be caused by other equipment.

Table 7-71  Noise Conditions for Intermittent

Symptom Solution
Intermittent noise Check equipment that is turned on and off near the scanner.
Intermittent noise present around the clock Check the clock.
. . L Check equipment that is turned on and off near the scanner at
Intermittent noise present at certain times .
certain times.
7-12-6 Noise on a board
Table 7-72 Noise on a Board
Symptom Solution

Isolate the board to see if you can determine the specific board
where the noise originates.

For example, unplug the receive area of the board and see if
the noise persists.

There is noise on a board
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7-12-7 B-Flow noise issue

At B-Flow with C1-6 probe, B-Flow noise induced by AC power supply (TDK-ACDC) was observed on
LOGIQ Fortis. See the B-Flow issue image.

Figure 7-56 Vertical noise issue image

To prevent this issue, BEPS2 assy has Power supply bracket cover included absorber sheet. This
BEPS2 assy is being used for all forward production for LOGIQ Fortis. But some of the FRU parts
(BEPS2 Assy - 8813300-10) in stock have not included this sheet. If BEPS2 assy needs to be replaced
in the field, make sure to check that power supply bracket cover is included absorber sheet to the new
BEPS2 assy. If it is not included, it needs to transfer the power supply bracket cover of BEPS2 in
console to new FRU part (BEPS2 assy). perform the following procedure to prevent the issue.

The absorber sheet on power supply bracket cover and BEPS2 Assy with absorber sheet images:

E

| T

Power Supply Bracket cover with BEPS2 Assy with absorber sheet (The image
absorber sheet in BEPS2 assy)
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7-12-71 To transfer the Power supply bracket cover to new FRU part
About BEPS assy replacement procedure, See “BEPS Assy Replacement” on page 8-144.

Table 7-73 BEPS removal

Step Corresponding Graphic

1. | Remove the BEPS Assy.
Place it on an ESD safe place.

NOTE: Use Card puller (indicate orange circle) to
pull out BEPS assy.

2. Remove BEP TOP PLATE from current BEPS
Assy2 and new BEPS Assy (14 screws).
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Table 7-73 BEPS removal

Step

Corresponding Graphic

*For current BEPS assy

Unscrew 4 screws (red circle) from Power supply
bracket cover (with Absorber sheet), then take it
from current BEPS assy.

*For New BEPS2 assy (FRU part)

Unscrew 4 screws (red circle) from Power supply
bracket cover. Also, Take Power supply bracket
cover (without Absorber sheet) from New BEPS
Assy.

*For New BEPS2 assy(FRU part)

Install Power supply bracket cover of Step 3 to New
FRU part (Step4), fasten 4 screws (red circle).
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ECG display disappears after backup/restore

With ECG, after system auto-restart, turn system off and then back on. Otherwise ECG and TGC may
not function until next full power cycle.

Unable to measure in both stiffness and velocity in Breast and Thyroid

WIth Shearwave, when entering Measurement in Breast or Thyroid, only the stiffness measurements
show up on the touch panel if display units is set to kPa, even though both stiffness and velocity are
enabled in the Utility pages.
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7-13-3 Breast Assistant, Powered by Koios DS
Use Table 7-74 to troubleshooting Breast Assistant, Powered by Koios DS installations.

Table 7-74 Troubleshooting the Breast Assistant, Powered by Koios DS Option

Symptom

Solution

Analysis takes longer than 5 seconds.

Check the spooler and clear any failures.
Check the connection to the server and attempt to ping the device on Utility >
Connectivity > Device to verify the service.

On Utility > Connectivity > Koios, the
Activate button does not display (may be
encountered during demos).

If Breast Assistant, Powered by Koios DS was previously activated, and only
the Deactivate button displays, on Utility > Connectivity > Koios, select
Deactivate, and then follow the steps in Table 3-8 on page 3-41 under “Set up
and test the Koios connection” to activate again.

Do not know the IP address to enter on
Utility > Connectivity > Koios.

You cannot activate Breast Assistant, Powered by Koios DS without a valid IP
address. Breast Assistant, Powered by Koios DS should have been installed on
the customer network. Obtain a valid address by contacting the customer IT
department to confirm the installation occurred.

Contact Koios DS Support to confirm this installation occurred.

On Utility > Connectivity, cannot find the
Koios tab.

Make sure the option string has been entered on the LOGIQ Fortis and the
option is enabled.

Check that the LOGIQ Fortis has the correct software version that includes
Breast Assistant, Powered by Koios DS installed.

On Utility > Connectivity > Device,
clicking the Verify button fails.

Verify that the IP Address field matches the address/hostname of the Koios DS
server on file and update the field if necessary.

If the information is correct, the Koios DS server information may have changed
or an error may have occurred. Contact Koios DS Support and provide the
scanner AE Title, Port, and IP Address.

On Utility > Connectivity > Service,
clicking the Verify button fails.

Verify that the AE Title and Port Number fields match the values of the Koios
Server on file and update the fields if necessary.

If the fields are correct, from the Device tab, try to ping the server. If the ping is
successful, the Koios Server info may have changed or an error may have
occurred. Contact Koios DS Support and provide the scanner AE Title, Port,
and IP Address.

For Koios DS Support contact:

» Koios DS Support / Servicing Email: logig@koiosmedical.com
» Koios DS Vendor Support Phone Number: +1(732)529-5755 Ext. 2
7-124 Section 7-13 - Options Troubleshooting



GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

7-13-4 Device Management (Device Mgmt)

Use Table 7-75 to troubleshoot Device Management (Device Mgmt).

Table 7-75 Troubleshooting the Device Management Option

Symptom Solution
Do not have or lost the “DEVICE Under Utilities > Connectivity > DEVICE MANAGEMENT, under Server URL,
MANAGEMENT” server URL address. enter the default URL: https://iot.gehelathcare.com.
Confirm with the site IT department the following conditions:
. Internet access is required
. Ethernet connection required 10/100 Mbps or an 10/100/1000 Mbps
. LOGIQ Fortis uses port 443 on a secure HTTPS connection

If the site uses Proxy servers:
Under Utilities > Connectivity > DEVICE MANAGEMENT, confirm proxy

LOGIQ Fortis cannot connect to the settings (Server/ port/ Username and password).

“DEVICE MANAGEMENT” cloud.

Contact the site IT administrator to ensure these settings are correct.

Also check for possible issues with the site firewall preventing the device from
reaching the cloud server.

Additionally, to connect with Cloud through proxy, the proxy port that was setup
in the Utility page opens.

Reset the registration key by:

1. Delete any information in Registration Key.

2. Enter the default registration key in Registration Key.

The registration key is prepopulated by the software on the device, reloading
software will restore the original value but you will need to re-register.

Missing the registration key for the
“DEVICE MANAGEMENT” cloud.

In Account Email, select Update and enter the correct email address.

Incorrect email address entered. . . L .
This is the user e-mail account that was used when signing up online.

Restore email account information (Account Email):
1. Navigate to Utility > Connectivity > Device Mgmt to access Device
Management. Do not select Remove Registration. If you do, you will need to

Missing email address (Account Email) contact the support team to re-establish registration to the server.

. . . 2. Select Deactivate.
associated with the Device Management . .
account after a full load of software 3. In Account Email, enter the email address for the account.
' 4. If applicable, enter Proxy Server, Proxy Port, Proxy User Name, and
Proxy Password.
5. Select Activate.
6. Select Save.

If Device Management was active prior to the software load, confirm that the
cloud still verifies your activation.

Navigate to Utility > Connectivity > Device Mgmt and confirm that status
shows “Active”. It is normal if the e-mail address is not visible. If so, proceed to
select “Verify” and confirm that you get a smiley face. Keep in mind that you
need to be connected to the network for the Device manager to verify
successfully.

If the system is not successfully connecting to the cloud, contact the Device
management team for support at email: dc.support@ge.com indicating the
serial number of the unit, description of the problem and e-mail of the admin
user registered in the account.

After a full software load, cannot connect to
the “DEVICE MANAGEMENT” cloud.

As a user, do not have account to the

“DEVICE MANAGEMENT” cloud. Go to https://AVURI.gehealthcare.com/signup for sign up instructions.
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Table 7-75 Troubleshooting the Device Management Option

Symptom Solution

After a manual backup (Utility > System >
Backup/Restore > Manual Backup), a new
user is not able to see any backups or the If the system shows it is connected to Device Management, perform these

history on the web app. steps to associate a time zone with your profile. Once the steps are complete,
you will be able to view the backups and the history on the web app.

After preset information is uploaded from 1. Navigate to http://AVURI.gehealthcare.com.

the master system (Utility > System > 2. Sign in to access your profile.

Backup/Restore > Upload for Fleet), anew | 3. Confirm the time zone.

user is not able to see any backups or the
history on the web app.

Other issues needing help with “DEVICE Contact the support team:
MANAGEMENT” feature. Support email: dc.support@ge.com

7-126 Section 7-13 - Options Troubleshooting




GE CONFIDENTIAL

Direction 5874372, Rev. 3

LOGIQ Fortis Proprietary Service Manual

7-13-4 Device Management (Device Mgmt) (cont’d)

NOTE:

Use Table 7-76 to troubleshoot Device Management (Device Mgmt) through the error codes. These
error codes will appear in the loTAgentService.log log file. This log file can be found under D:\log.

Error codes may change over time.

Table 7-76  Errors for the Device Management Option
Error Details Solution
Activate

Agent service config file is corrupted.

Please contact your GE service personnel.

Agent side config
file(loTAgentConfig.json) is
corrupted.

Contact service for enabling re-
registration.

Activation failed. Missing input Parameter.
(Error code: 000104)

Invalid Account Email has been
entered.

Enter valid Account Email.

Activation failed. Please contact your GE
service personnel. (Error code: 401)

Invalid Registration Key has been
entered.

Enter valid Registration Key.

Activation failed.

Invalid Server URL has been entered.

Enter valid Server URL.

Activation failed.

Invalid Proxy server or Proxy port has
been entered.

Enter valid Proxy server and Proxy
port.

Activation failed. Please contact your GE
service personnel. (Error code: 403)

After successful registration again
perform register.

Contact service for enabling re-
registration.

Invalid fleet account email format.
Activation failed.

Invalid or empty Account Email format
field.

Enter valid Account Email.

Invalid proxy port. Activation failed.

Enter string value in Proxy port field.

Enter valid Proxy port.

Agent service config file is corrupted.

Please contact your GE service personnel.

Empty Registration Key field.

Enter valid Registration Key.

Agent service config file is corrupted.

Please contact your GE service personnel.

Empty Server URL field.

Enter valid Server URL.

Invalid server certificate.

Please contact your GE service personnel.

Invalid server certificate

Install valid certificate using Device
Connect Service Certificate.

Activation failed. Timeout occurred.

Console side did not receive any
response from Agent\ThingWorx side
in predefined activation time delay.

Ensure network connection and retry.

Activation failed. Please contact your GE
service personnel. (Error code: 400)

Bad request

Contact AVURI Device Connect
Support at dc.support@ge.com.

Activation failed. Please contact your GE
service personnel. (Error code: 500)

Internal server error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Activation failed. Please contact your GE
service personnel. (Error code: 503)

Service unavailable

Retry

Activation failed. Please contact your GE
service personnel. (Error code: 404)

Digital twin not found

Contact AVURI Device Connect
Support at dc.support@ge.com to
initiate device re-Register.

Activation failed. Please contact your GE
service personnel. (Error code: 000011)

Unknown error

Contact AVURI Device Connect
Support at dc.support@ge.com.
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Table 7-76  Errors for the Device Management Option (Continued)

Error

Details

Solution

Activation failed. Please contact your GE
service personnel. (Error code: 000010)

Internal error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Activation failed. Please contact your GE
service personnel. (Error code:000115)

Default application not found for
Digital Twin

Contact AVURI Device Connect
Support at dc.support@ge.com.

Activation failed. Please contact your GE
service personnel. (Error code: 000100)

Missing appID or appName

Device error. Contact AVURI Device
Connect Support at
dc.support@ge.com.

Activation failed. Please contact your GE
service personnel. (Error code: 000105)

Application does not exist

Contact AVURI Device Connect
Support at dc.support@ge.com,
escalate to L3 or L4 for support.

Activation failed. Please contact your GE
service personnel. (Error code: 000116)

The application has not been
associated with your digital twin. No
application device exists.

Retry desired action. Contact AVURI
Device Connect Support at
dc.support@ge.com if problem
persists.

Activation failed. Missing input Parameter.
(Error code: 000100)

Missing Input user or application not
provided.

Ensure valid user email is used in
Device Mgmt and then retry.

Activa